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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.
License types
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.
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Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Unless
otherwise stated, each Instance of a product must be separately
licensed and ordered. For example, if the end user customer or
Avaya Channel Partner would like to install two Instances of the
same type of products, then two products of that type must be
ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE H.264 CODEC OR H.265 CODEC, THE AVAYA CHANNEL

PARTNER ACKNOWLEDGES AND AGREES THE AVAYA
CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL
RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) CODEC
IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE
FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES
IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Regulatory Statements
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
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All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose
This document provides information about the Avaya Workforce Optimization Select user interface
and explains how to use the features of the Avaya Workforce Optimization Select application.

This document also describes the operations that you can perform through the Live Monitoring,
Interactions, Evaluate, Coach, Learn, Analyze, and Reports modules in the Avaya Workforce
Optimization Select application.

This document is intended for people who want to use the features of Avaya Workforce
Optimization Select application.

New in this release
Avaya Workforce Optimization Select release 5.2.3 supports the following new features and
enhancements:

New feature or
enhancement

Feature or
enhancement
name

Module name Description

New Feature Evaluation
Overview report
template

Reports Using Evaluation Overview Report, you can
get a snapshot view on total number of
evaluations, sum total of scores of all
evaluations and percentage of evaluations for
various Queues, Organization Units, Sites,
Groups Employees, Reviewers, and Forms.

New Feature Evaluation Section
Summary report
template

Reports Using Evaluation Section Summary Report,
you can get a snapshot view of total number
of evaluations, section level scores of all
evaluations and percentage of evaluations for
various Queues, Organization Units, Sites,
Groups, and Employees.

Table continues…
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New feature or
enhancement

Feature or
enhancement
name

Module name Description

New Feature Speech Speech Using the Speech module you can take
advantage of the following features:

• Phrase Sets: Create your library of words
and phrases to track agent’s performance
as a supervisor.

• Search: Define your search criteria based
on your business requirement.

• Business Criteria: Save the search as a
business criteria to reuse or share the
search criteria with one or more users..

• Results: View and manage speech results.

Avaya Workforce Optimization Select
transcribes recorded interactions and
identifies words and phrases defined as part
of the search criteria, and highlights the
words and phrases in the transcript.

Introduction
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Chapter 2: Navigation

Avaya Workforce Optimization Select overview
Avaya Workforce Optimization Select is a web-based suite of tightly integrated tools designed to
enhance and improve all aspects of your contact center operations and performance. The solution
is easy to implement, maintain, and manage in a variety of contact center deployment models
from centralized contact centers to distributed branches and work-at-home agents.
It offers contact centers the ultimate workforce optimization functionality and flexibility. The
comprehensive solution also provides scalable applications that synchronize and unify the entire
workforce, regardless of the VoIP architecture.

Logging in to Avaya Workforce Optimization Select
About this task
Users can access Avaya Workforce Optimization Select through a web browser and sign in using
their login credentials.

Before you begin
Get the following information from your system administrator:

• The URL of the Avaya Workforce Optimization Select web application
• The user name and password to access the application

Procedure
1. In the Address bar of the browser, enter the URL for your instance of Avaya Workforce

Optimization Select.

For example: https://<host>
where, <host> is the host name or IP address of the server on which Avaya Workforce
Optimization Select is installed.

2. On the Avaya Workforce Optimization Select login page, type the Username and
Password, and click Sign In.

The system displays the Avaya Workforce Optimization Select application Home page.
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Logging out of Avaya Workforce Optimization Select
Procedure

1. In the top-right corner of the Home page, click the  icon.

2. Click Log Out.

On successful log out, the system displays the Avaya Workforce Optimization Select Sign
In screen.

Avaya Workforce Optimization Select Home page
When you log in to Avaya Workforce Optimization Select, the Home page displays navigation links
for quick access to the modules in the application.

Note:

The administrator configures module level access privileges for each user. You can see only those
modules for which the application administrator provides you access.

The interface has the following sections:

• The title bar: To navigate to the My Profile settings.

• The main menu: To navigate to the different modules in the application.

• The side bar: To navigate to the submenu within each module.

• The navigation bar: To navigate to the submenu options within each module.

Menus overview
Name Description
Home Provides quick access to all modules in the application and back to the

Home page from any page.
Notifications Displays alerts and notifications that you have subscribed to. The alerts

and notifications are system generated by the trigger of threshold values
configured by the system administrator.

Dashboard Displays real time widgets of important functions in the application.
Currently, you can see the live interactions of a logged-in user with the
recording controls available for the respective interactions. Depending on
your user privileges, you can use these indicators to start, pause,
resume, stop, or cancel a recording.

Table continues…
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Name Description
Interactions Enables supervisors to playback recorded and imported interactions. You

can capture periodic screen shots of the employee desktop, and play
back the recorded interaction for quality management and monitoring.

Live Monitoring Enables supervisors and quality managers to monitor live interactions
between employee and customers. Live monitoring helps to assess
employee performance in real-time, and provide instant online feedback
and assistance to employees.

Evaluate Enables supervisors and quality managers to review and evaluate
employee performance for both voice and non-voice transactions. You
can create evaluation plans, build evaluation forms, calibrate evaluations,
and manage the appeals raised by the employees against the
evaluations.

Coach Enables supervisors and managers to create personalized training plans
and feedback to help improve employee performance. You can define a
list of skills and improvement areas, assign coaching sessions for specific
groups or employees, and track improvements on team and individual
performance over time.

Learn Enables supervisors and managers to train employees in the contact
center with course ware and quizzes to improve their efficiency and
enhance productivity. You can create task-specific quizzes and upload
training videos, slide presentations, multimedia, and other courseware
and assign them to selected employees for training.

Analyze Enables users with the appropriate permissions to create scorecards and
metric views to measure and analyze the performance of employees,
departments, roles, and sites in an organization.

Reports Enables supervisors and quality managers to generate on-demand and
scheduled reports for detailed information on interaction analytics, voice
configurations, employee performance, and quality trends.

Speech Enables users with the appropriate permissions to perform precision
search by defining words and phrases as part of the search criteria. The
speech engine transcribe recorded interactions, identifies words and
phrases defined as part of the search criteria, and highlights the words
and phrases in the transcript.

Administration Provides administrators access to the organization, employee and group
configuration, call recording settings, queue management, account
configuration, and general settings.

Menus overview
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Chapter 3: Managing Dashboard

Dashboard overview
Using Dashboard, you can see real-time widgets of important functions in Avaya Workforce
Optimization Select. Currently, you can add six placeholders for widgets on your Dashboard that
include the following categories:

• Favorites
• Reports
• Scorecards

Apart from these categories, you can also embed external links into Dashboard.

You can also see the live interactions of a logged-in user with the recording controls available for
the respective interactions. From the Dashboard recording widget, you can get direct access to
the recording controls. Depending on your user privileges, you can use these indicators to do the
following:

• Start recording a live interaction.

• Pause or resume a recording.

• Stop a recording.

• Cancel a recording.

You can access the screen:

• From the Dashboard tab on the Avaya Workforce Optimization Select Home page.

•
From the  icon in the header next to the username and notification icons.

You can opt to have Dashboard as your default Home page depending on the permissions
assigned to you by the administrator. Based on the need of the organization, an administrator can
also make Dashboard the default landing page for a user.

Related links
Dashboard field descriptions on page 23
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Creating Dashboard
Before you begin
Get the create and edit permissions to create a customized dashboard from the administrator.

Procedure
1. On the Avaya Workforce Optimization Select Home page, click Dashboard or the

Dashboard icon  in the top-right corner.

2. Click Create Dashboard.

3. On the Create Dashboard page, do the following:

• In the Title field, type the name of Dashboard that you want to create.

• Select a structure to create a layout of your choice, and click Save.

The system displays a Dashboard layout to add widgets.

Next steps
Add widgets to Dashboard.

Related links
Dashboard field descriptions on page 23

Adding widgets to Dashboard
About this task
Apart from the recording controls widget, you can add maximum six widgets to your dashboard.
The maximum selections allowed from each of the respective categories are as follows:

• Six reports
• Six iFrames
• Four scorecards
• One favorite

For example, the combinations can be:
• Six reports or six iFrames
• Four reports, one iFrame, and one favorite
• Two scorecards, one iFrames, and three reports

Before you begin
Create Dashboard.

Note:

Creating Dashboard
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You can add only those scorecards and reports that are selected for adding to dashboard in the
respective modules.

Procedure
1. Click the  icon.

The system displays the dashboard in edit mode.

2.
Click the  icon.

3. On the Add Widget page, click the category that you want to add to your dashboard.

You can add only six widgets to your dashboard.

For example:

If you click Reports, the dashboard displays the Reports section with the following
message: Please select the Report.

4. Click on the icons in the top-right corner of the selected widget to manage the widget.

The icons to manage a widget vary from one widget to another.

Next steps
Edit Dashboard.

Related links
Dashboard field descriptions on page 23

Editing Dashboard
About this task
Use this procedure to make changes to an existing Dashboard.

Before you begin
Get the create and edit permissions to edit the existing Dashboard.

Procedure
1. On the Avaya Workforce Optimization Select Home page, click Dashboard or the

Dashboard icon  in the top right corner.

The system displays the list of the existing Dashboards.

2. From the list, click the dashboard layout that you want to edit.

3. On the dashboard, click  icon.

4. Click the  icon.

Managing Dashboard
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5. On the Edit Dashboard page, do the following:

a. To change the dashboard name, type the name in the Title field.

b. To make the Dashboard layout the default view, select the Default checkbox.

c. To change the current layout selection, select another structure to create a layout ,
and click Close.

6. (Optional) To undo the changes, click the  icon.

7. (Optional) To delete the Dashboard layout, click the  icon.

Note:

To delete a dashboard you should exit the edit mode.

Related links
Dashboard field descriptions on page 23

Editing widgets from Dashboard
About this task
You can edit an existing Dashboard layout using the different icons in the top-right corner of any
widget.

Procedure
1. On the Avaya Workforce Optimization Select Home page, click Dashboard or the

Dashboard icon  in the top right corner.

The system displays the list of the existing Dashboards.

2. From the list, click the dashboard layout that you want to edit.

3. On the dashboard, click  icon.

4. To configure a widget, click the  icon.

The system displays the selected widget page. For example, if you edit the Reports widget,
the system displays the Reports page.

5. Do the following:

a. Delete the existing name and type a new name of your choice.

b. Pick the reports, scorecards, or favorite that you want to display on your Dashboard
view.

c. In the Refresh interval (mins) field, type the time duration when you want the
selected widget to refresh and click Apply.

Editing widgets from Dashboard
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The system displays the widgets in graphs. You must maximize the widget to get a
complete view in a tabular format.

6.
To save the selected Dashboard layout, click the  icon.

7.
(Optional) To view the selected widgets in a tabular format, click the  icon.

You can view the tabular output only in the read-only mode on Dashboard.

8. (Optional) To remove a widget from your Dashboard layout, click the  icon.

9. (Optional) To rearrange the placement of a selected widget, click the  icon on the title of
the Widget and drag to the new structure.

Related links
Dashboard field descriptions on page 23

Sharing Dashboard
About this task
For creating an individual Dashboard, you must have the create and edit permissions. However,
you can share your Dashboard with users who do not have the permission to create Dashboard.

Procedure
1. On the Avaya Workforce Optimization Select Home page, click Dashboard or the

Dashboard icon  in the top right corner.

The system displays the list of the existing Dashboards.

2. From the list, click the dashboard layout that you want to share.

3.
On your Dashboard, click the  icon.

4. On the Share Dashboard page, do the following:

Select users with whom you want to share your Dashboard. You can select Selected
Groups or Everyone. If selecting Selected Groups then go to step 5. If selecting
Everyone then go to step 6.

5. Select the groups and employee to share the dashboard with.

a. In Available Groups, click the group that you want to share your view with and click
the  icon.

The system displays the selected groups in the Selected Groups section.

b. In Available Employees, click the employees that you want to share your view with
and click the  icon.

Managing Dashboard
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The system displays the selected groups in the Selected Employees section.

c. Click Save.

The system delivers your Dashboard to the selected groups and users. The receiver can
save the settings and make it the default Dashboard .

6. Click Save.

The system delivers your Dashboard to all users. The receiver can save the settings and
make it the default Dashboard .

Related links
Dashboard field descriptions on page 23

Viewing Dashboard
About this task
You can view different dashboard layouts depending on the permissions assigned to you.

Procedure
1.

On the Avaya Workforce Optimization Select Home page, click Dashboard or the 
icon.

The Dashboard page displays the recording controls widget. You can use the controls to
start, pause, resume, stop, or cancel a recording.

2. Click the dashboard layout that you want to view from the list next to the Create
Dashboard field.

Avaya Workforce Optimization Select displays only those dashboards that you have
permissions to access.

Dashboard field descriptions
Categories of Dashboard widgets

Name Description
Favorites The option to view all features that are flagged as favorite. You can select

only one favorite for your dashboard at a time.
External Link The option to embed an external page into a dashboard.

Table continues…
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Name Description
Reports The option to view all reports that are added to a dashboard. To view

these reports, you must select the Add to Dashboard check box in the
respective modules. You can select six reports to display simultaneously.

Scorecards The option to list all scorecards. You cannot add more than four
scorecards to a scorecard.

Recording Controls This option displays all live interactions along with the recording controls
for each interaction.

Create or Edit Dashboard

Name Description
Title The name of the dashboard.
Default The option to choose a dashboard as the default. You can select or clear

the check box depending on your requirements.
Structure The option to select a layout for your dashboard depending on the

selected widgets. The options are:

• 6–6

• 4–8

• 12/4–4/4

• 12/6–6

• 12/6–6/12

• 3/9–(12/6–6)

Share Dashboard

Name Description
Share Dashboard The option to share the dashboard. The options are:

• Me

• Selected Groups

• Everyone
Available Groups The custom groups available for an organization.
Selected Groups The groups selected from the available groups to share the dashboard

with.
Available Employees The names of employees who are part of the selected group.

This field lists only those employees who belong to the groups in the
Assigned Groups section.

Selected Employees The employees with whom you share the dashboard. You can select a
group and exclude any employee from that group.

Managing Dashboard

October 2019 Using Avaya Workforce Optimization Select 24
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Icon Name Description
Add Widget To add a widget.

Delete Dashboard To delete a dashboard.

Share Dashboard To share a dashboard. The options are:

• Me

• Selected Groups

• Everyone
Manage Dashboard To manage a dashboard.

Save Dashboard Changes To save a dashboard after making the required
changes. This icon is displayed when you click on
the Manage Dashboard icon.

Maximize To maximize a dashboard.

Minimize To minimize a dashboard.

Undo Changes To reset any changes you made in a dashboard.

Refresh Widget To refresh the view of a widget in a dashboard.

Rearrange Widget To move widgets from one place to another and
change the layout.

Edit Dashboard Layout To make changes in a widget.

Maximize To maximize a widget in a dashboard.

Minimize To minimize a widget in a dashboard.

Remove To remove a widget from a dashboard.

Managing recording controls from Dashboard
About this task
For on-demand recordings, use the recording controls in the Controls column in the Dashboard
recording controls widget to do the following:

• Start recording a live interaction.
• Pause or resume a recording.
• Stop a recording.
• Cancel a recording.

Managing recording controls from Dashboard
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Before you begin
Get permissions from the administrator to record an interaction. If you are not configured for
recording, then the system displays the following message: You are not configured for
recording. If you do not have the permissions to manage the recording controls but you are
configured for recording, then you can view only recorded interactions.
If you have the permissions, the Controls column in the Dashboard recording controls widget
displays the following:

•
: In an enabled state.

•
: In a disabled state.

•
: In a disabled state.

Procedure
1.

On the Avaya Workforce Optimization Select Home page, click Dashboard or the 
icon.

The Dashboard page displays the recording controls widget. You can use the controls to
start, pause, resume, stop, or cancel a recording.

2.
In the Controls column, click .

The system displays the Start Recording page.

3. In Reason Codes, click the reason for starting the recording, if you do not want the default
reason and enter your comments in the Comments field.

The Comments field is an optional field.

4. Click Submit.

The Recording Status column displays the status as Recording. The Controls column
displays the following controls:

•

•

•

5.
In the Controls column, click .

The system displays the Pause Recording page.

6. In Reason Codes, click the reason for pausing the recording and enter your comments in
the Comments field.

The Comments field is an optional field.

Managing Dashboard
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7. Click Submit.

The Recording Status column displays the status as Paused. The Controls column
displays the following controls:

•

•

•

Note:

If auto-resume interval is set for the pause control, the interaction recording automatically
resumes after the specified time.

8.
In the Controls column, click .

The system displays the Resume Recording page.

9. In Reason Codes, click the reason for resuming the recording and enter your comments in
the Comments field.

10. Click Submit.

The Recording Status column displays the status as Recording. The Controls column
displays the following controls:

•

•

•

Note:

If auto-resume interval is set for the pause control, the interaction recording automatically
resumes after the specified time.

11.
In the Controls column, click .

The system displays the Stop Recording page.

12. In Reason Codes, click the reason for stopping the recording, and enter your comments in
the Comments field.

13. Click Submit.

Managing recording controls from Dashboard
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The Recording Status displays the status as Stopped. The Controls column displays the
following:

•

•

•

You can stop and start recording an interaction several times in segment recording. Only
those segments which you recorded is available for future reference.

14. In the Controls column, click .

The system displays the Cancel Recording page.

15. In Reason Codes, click the reason for canceling the recording, and enter your comments
in the Comments field.

16. Click Submit.

The Recording Status displays the status as Cancelled. The Controls column does not
display any recording control.

Note:

If you cancel a recording, you cannot recover the recording or start the recording.

Dashboard recording controls field description
Name Description
Controls The recording controls to record, pause or resume,

cancel, and stop a recording.

You can also see the status of the recording.
Recording status The status of the recording.

When the user clicks on any of the recording icons,
the success message refers to the request
processing and need not necessarily reflect a
change in the recording icon immediately.

ANI The phone number of the incoming call.
Extension The extension number of the employee on which

the interaction is being handled.

Table continues…
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Name Description
Channel The type of channel on which the interaction is

delivered. The options are:

• Voice

• Chat

• Email

• SMS
Start Time The start time of the interaction in a date and 24–

hour format: mm:dd:yyyy hh:mm:ss

The start time of the interaction in a 24–hour format:
hh:mm:ss.

Duration The duration of the recording in a 24–hour format:
hh:mm:ss

Interaction Type The type of call direction. The options are:

• Inbound

• Outbound
Queue The queue that the interaction is associated with.
Reason Codes The reason for starting a recording, pausing,

resuming, stopping, and canceling a recording.

This field is mandatory when you click on any of the
recording controls. In this scenario, the Comments
and Tags fields are available as non-mandatory
options. If you expand an interaction without clicking
on any of the recording controls, keep the default
Pick one option to disable it. The Comments and
Tags fields remain non-mandatory options.

Comments The text message included as comments to an
interaction or recording. This option is non-
mandatory.

Tags The option to classify interactions or recordings.
You can also use this option to restrict specific
actions on an interaction or recording. This option is
non-mandatory.

Controls Name Description
Start recording Indicates that a recording has not started.

Use this control to start a recording.
Paused disabled Indicates that the recording has not started.

Table continues…
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Controls Name Description
Cancel disabled Indicates that the recording has not started.

Recording Indicates that a recording is in progress.

Pause/Resume Indicates that a recording is in progress.
Use this control to pause a recording.

Cancel Indicates that a recording is in progress.
Use this control to cancel a recording.

Recording paused Indicates that the recording is paused.

Resume recording Indicates that the recording is paused. Use
this control to resume a recording.

Stop Indicates that a recording is in progress.
Use this control to stop a recording.

Stop disabled Indicates that a recording is in progress.

Selecting Dashboard as the landing page
About this task
You can select Dashboard as the default landing page depending on the permissions assigned to
you.

Procedure
1.

In the top right corner of the homepage, click the  icon.

2. Click My Profile.

The system displays the basic information linked to your Avaya Workforce Optimization
Select account.

3. In the Landing Page field, click Dashboard > Set .

WFM Reports overview
As a part of Teleopti WFM integration with Avaya Workforce Optimization Select, the WFM
schedule reports are available as a widget in Dashboard. The WFM dashboard displays the

Managing Dashboard
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logged in user schedule and the team schedule for supervisors and managers in the Schedule
widget.

Viewing Teleopti WFM Dashboard
Before you begin
Create a Dashboard specific to WFM and add a widget for My Schedule.

Procedure
1. On the Avaya Workforce Optimization Select Home page, click Dashboard or the

Dashboard icon  in the top-right corner.

2. Click the dashboard that you created for Teleopti WFM.

The system displays the My Schedule widget with the data imported from Teleopti WFM.

3. On the My Schedule widget, do one of the following:

• To view your schedule, click Schedule.

• To view the schedule of your team, click Team Schedule. This privilege is permission
driven.

Viewing Teleopti WFM Dashboard
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Chapter 4: Monitoring interactions in real
time

Live Monitoring overview
With the Live Monitoring module, supervisors and managers can silently monitor real-time
interactions of employees to assess and measure performance. Supervisors and managers can
identify problem areas and take immediate steps to ensure customer satisfaction.

The Live Monitoring module provides the following benefits:

• Listen to agent and customer interactions in progress and view real-time agent information
and interaction status.

• Respond to and mitigate caller objectives or complaints by providing instant feedback.

• Create different views that define individual search criteria to quickly access the required live
interactions for listening.

• Customize various columns to quickly identify important interaction details,such as extension,
queue, tenure, call duration, current state, current state duration, and ANI number.

• Allow supervisors to perform QA while monitoring to measure agent performance on aspects
like average handling time and adherence to scripts provided by management. Supervisors
can also flag an interaction for further evaluation.

• Email an interaction as a link to anyone.

• Record live interactions

• Pause or resume a recording

• Cancel and stop a recording

Using the Live Monitoring module, authorized users can:

• Manage views

• Monitor live interactions

Monitor Live Interactions
Supervisors and authorized users can view and monitor the live interactions of team members and
employees they have access to and provide timely feedback and coaching.
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From the Monitor page, you can:
• Assist new agents by providing immediate feedback when required.
• Track employees whose average handle time, hold count, or hold duration is high.
• View color coded interactions that are defined based on the interaction duration.
• Configure to listen to interactions of specific agents at regular intervals. The interaction will

automatically play in the order of selection.
• Customize the page to add columns that display interaction details such as extension, queue,

tenure, and duration.
• Filter your search on specific columns by using conditions and operators.
• Use the pagination option to specify how many records you wish to view per page.

Play Live Interactions
While playing a live interaction, you can perform the following actions:

• Record an interaction using the recording controls.
• Add comments and tags to an interaction.
• Provide feedback to employees about an interaction.

Supervisors or managers can subscribe to get relevant alerts about an employee whose average
handle time (AHT) or hold count is high. In such cases, the supervisor can listen to the live
interactions of those employees to respond and mitigate caller objectives or complaints.

Note:
If a voice or a non voice interaction configured for screen capture recording is paused, then

during live monitoring, Avaya Workforce Optimization Select displays the  image to
indicate that no screens are captured during the paused state.

Manage views
Using views, you can filter data by specific criteria.

Depending on the business requirement, you can create different views with filters using logic
conditions. For example, to search for live interactions that have been put on hold a number of
times, you can define filters based on Greater Than or Between. The view displays the
interactions that match the search criteria.

Note:

When you log in to the application the first time, the system displays the AWFOS view, which is
the default view. You can create a new view to search and play the desired interactions.

After you create a view, you can use it anytime later.

Manage views
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You can do the following while creating views:

• Create multiple filters.

• Use the default view that comes with a preconfigured set of parameters.

• Define the search criteria with a comprehensive list of parameters.

• Use operators to add multiple filters to use multiple parameters for a view.

• Use the option to display additional columns in the live interactions list.

• Share Views that you create with other users.

Adding a view
About this task
To search for live interactions, you can use the AWFOS Default view, a saved view or a view that
has been shared by other users. If you want a new set of filter criteria, you can create a new view.

Note:

The AWFOS Default view consists of predefined filters configured by your system administrator.
You cannot modify the filters on this view.

Procedure
1. Click Live Monitoring > Monitor.
2. On the Monitor page, click Add.

3. On the Create View page, type a name and description.

Next steps
Set up filters for a view.

Setting up filters for a view
About this task
Using filters in view, you can add:

• Multiple search parameters within a single filter criteria.
• Multiple values separated by commas to match a single parameter .

Procedure
1. In Filter add fields, operators and values for

a. In Field, select the field on which to apply the filter.

b. In Operator, select the operator which to apply.

c. In Value, enter the value that the records must match.

Monitoring interactions in real time
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2. To add additional filters, click Add Field.

3. In Display Fields, select the fields to be displayed.

4. In Share, select the groups and employee to share the view.

5. To save the view, click the Save & Close button.

Configuring display fields for a view
About this task
When you select a view, you can view the interaction details in the list. All the information on the
interaction is not displayed. If you do not see the specific fields you are looking for, you can
configure additional fields to display in the list.

Procedure
To move fields to the Selected Fields list:

1. Select one or more fields from the Available Fields list.

a. To search a field, type the first few characters of the field name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

To remove fields from the Selected Fields list:

2. Select one or more fields from the Selected Fields list.

a. To search a field, type the first few characters of the field name in Search.

b. To remove a single selection from the list, use the Remove Selected button.

c. To remove multiple selections from lists, use the Remove All button.

3. (Optional) To rearrange the order of the selected fields, click the arrows next to the
Selected Fields screen.

The order selected in the views determine the sequence of the columns in the output.

Next steps
Share a view.

Sharing a view
About this task
Use this procedure to share a view that you created so that other users can reuse the shared view
to search for interactions.
You can keep the saved view as private or share the view with specific employees, or everyone.
The selected users can see the shared view in their saved views.

Manage views
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Procedure
1. From Share, select one of the following to share the view with other users:

• Me
• Selected Groups
• Everyone

2. To share the view with selected groups, select Selected Groups.

The Edit View page displays the Group and the Employee search and select options.

3. Select one or more groups from the Available Groups list.

a. To search a group, type the first few characters of the group name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

4. To remove groups from the Selected Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

5. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in
Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

6. To remove employees from the Selected Employees list; select one or more employees
and use the Remove Selected and Remove All buttons.

7. Click Save and Close.

Create View field descriptions
View

Name Description
Name The name of the view.

This field is mandatory.
Default The option to display the selected view as the default. You can set a view

as default if you want to see a certain set of interactions each time you
login.

Description The description that helps to understand the reason for creating a view.

Table continues…
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Name Description
Refresh Interval The time in seconds to define the interval to refresh live interactions.

For example, if you configure 20 seconds, the page will reload every 20
seconds to refresh the live interactions on that page.

Filter The filter criteria used to search the interactions.
Display Fields The columns displayed in the search results.

You can move or remove the fields in the Available Fields screen to the
Selected Fields screen while adding a view. The arrows next to the
Selected Fields allows the user to rearrange the order of the selected
fields.

Share The option to share the view with selected users, with everyone, or save
it as private.

Filter

Name Description
Field The parameters used to filter the search results. The options are:

• Role

• Department

• Employee Status

• Groups

• Is Masked

• Is Muted

• Contact Instances

• No of holds

• No of Transfers

• Organization Unit

• Queue

• Recordings

• Screen Title

• Show Only Live Agents

• Site

• Reporting to

• Tenure (In Weeks)

Table continues…
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Name Description
Operator The operator used to specify the search criteria. The options are:

• Equals To

• Not Equal To

• Contains

• Does not Contain

• Starts With

• Does not Start With

• Ends With

• Does not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Between
Value The value specified in the search query that is used to match the records.

You can view the list of interactions that match the value in this list.

Fields

Name Description
Role To search for interactions based on the designation of the employee in

the organization.
Calling Party To search for interactions by the extension number or email ID of the

calling party. You can use any alphanumeric characters or symbols to
search an interaction.

Called Party To search for interactions by the extension number or email ID of the
called party. You can use any alphanumeric characters or symbols to
search an interaction.

Interaction Duration To search for duration of the interactions in the hh:mm:ss format.
Department To search for an interaction by the name of the department that the

employee belongs to.
Employee Status To search for an interaction by the status of the employee attending to the

interaction. The options are:

• Active

• Inactive
Groups To search for interactions of employees belonging to the specified group.

Table continues…
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Name Description
Interaction Type To search for the channel of interaction. The options are:

• Voice

• Email

• Chat

• SMS
Is Masked To search for a live interaction that is masked.
Is Muted To search for a live interaction that is muted.
Contact Instances To search for the line for which the user is configured for recording.

For example; If the line instances are Line 1, Line 2, and Line 3 and the
call landed on Line 2, the system displays the line instance as 2.

No of Holds To search for interactions based on the number of times that the
employee put the interaction on hold.

No of Transfers To search for interactions based on the number of times that the
employee transferred the interaction.

Organization Unit To search for interactions based on the name of the organizational unit.
Use the available operators to define your search criteria.

Queue To search for interactions by the queue that the interaction is associated
with.

Recordings To search for interactions that are live and also for agents that are not on
a call. This option is permission based.

If you do not choose this filter, you can view only the agents handling live
interactions.

Screen Captures To search for interactions that contain screen captures.
Screen Title To search for interactions by the title of the window that the agent is

accessing while handling an interaction.
Site To search for interactions of employees belonging to the specified site.
Reporting To To search for interactions based on the name of the supervisor.

For example, to search for interactions monitored by a specific
supervisor, use the Contains operator and specify the supervisor name.
The search results display the interactions by all employees assigned
under the selected supervisor.

Tenure (In Weeks) To search for interactions based on the tenure of the employee in weeks.

Table continues…
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Name Description
Show Only Live Agents To search for agents who are handling calls. This is a default option and

is available to supervisors only.

To see all employees who are handling and not handling calls, the
supervisor must create views by selecting the No option.

The options are:

• Yes

• No

The default option is Yes.

Operators

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with the specified value.
Ends With To search for interactions that ends with the specified value.
Does not End With To search for interactions that does not end with the specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Between To search for interactions that lie between the specified value.

Display Fields

Name Description
Role The designation of the employee in the organization.
Department The name of the department that the employee belongs to.
Employee Status The status of the employee attending to the interaction. The options are:

• Active

• Inactive

Table continues…
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Name Description
Groups The name of the group that the employee belongs to.
Is Masked The live interaction that is masked.
Is Muted The live interaction that is muted.
Line Instances The line to which the user extension is associated in a scenario where a

user is connected to multiple lines.
No of holds The number of times that the employee put the interaction on hold.
No of Transfers The number of times that the employee transferred the interaction.
Organization Unit The name of the organization unit that the employee belongs to.
Queue-Queue Type The queue that the interaction is associated with.
Recordings
Screen Title The title of the window that the employee accesses to handle an

interaction.
Site The name of the site that the employee belongs to.
Reporting to The name of the supervisor or manager to whom the employee reports.

Share

Name Description
Me The option to set the view as private where other users will not be able to

view or use the view.
Selected Groups The option to share the view with specific people or groups.
Everyone The option to share the view with all users of the application.

By sharing the view with a group or with everyone, the system renders
results based on the access with whom the view is shared.

Note:

Users can only view search results and cannot edit the search results.

Button Name Description
Save as Report The option to save a view as an adhoc report. You can view this report in

the Reports tab.

Monitoring live interactions
About this task
On the Monitor page, you can view and monitor one or more voice or non voice interactions of
employees or team members in real time.

Monitoring live interactions
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When you select a view, the search results display live interactions based on the filter criteria
defined for the view.
If the current view does not provide the appropriate search results, modify the search criteria in the
selected view, or create a new view.

Procedure
1. Click Live Monitoring > Monitor.

The Monitor page displays the live interactions in the default view.

2. On the View list, click the required view.

The Monitor page displays all the live interactions for the search criteria defined under the
selected view.

3. View the basic details of the live interactions displayed in the columns.

4. To display or hide columns, click the  icon at the top of the list, and select or clear the
corresponding check boxes.

5. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

6. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

7. (Optional) To clear the filters from all the columns, click the  icon.

8. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

9. (Optional) To reset the sorting, click the  icon.

Monitor field descriptions
Name Description
Recording Status The current status of the recording.
Employee The name of the employee who is interacting.
Agent ID The ID of the agent logged in into the phone.
Organization Units The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Groups The name of the group that the employee belongs to.
Department The name of the department that the employee belongs to.

Table continues…
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Name Description
Reporting To The name of the supervisor or manager to whom the employee reports.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
Interaction Duration The duration of the interaction in the hh:mm:ss format.
Direction The direction of the interaction. The options are:

• Inbound

• Outbound
Interaction Type The channel of interaction. The options are:

• Voice

• Email

• Chat

• SMS
Current State The current interaction state whether the employee is talking or has put

the call on hold.

By default, the supervisor can view only those employees who are
handling calls. To view all the employees who are handling or not
handling calls, the supervisor must create a view by clicking the No option
for the Show Only Live Agents filter.

Current State Duration The duration of the current state of interaction.
Queue-Queue Type The queue and queue type that the interaction is associated with.
Employee Status The status of the employee attending to the interaction. The options are:

• Active

• Inactive
Extension The extension number of the agent.
Recordings The field to indicate whether the interaction is enabled for recording.
Screen Title The title in the nonvoice interaction captured during monitoring of the

employee desktop on-screen activity.
Screen Captures The field to indicate whether screen capture of the employee desktop is

enabled for recording.

When it is enabled for recording, the screens get captured for the
interactions.

Called Party The extension number or email ID of the called party.

You can use any alphanumeric character or symbol in this field.
Calling Party The extension number or email ID of the calling party.

You can use any alphanumeric character or symbol in this field.
No of holds The number of holds for an interaction.
No of transfers The number of transfers for an interaction.

Table continues…
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Name Description
Is Masked The field to indicate whether an interaction is masked.
Is Muted The field to indicate whether an interaction is muted.
Contact Instances The field that displays the line which is configured for recording.

Icon Name Description
- Controls The recording control options that are available for monitoring the live

interactions.
Listen The live interactions that are available for monitoring.

Manage tags and reason codes
Tags overview
Use tags to classify interactions and enforce specific actions on interactions. You can associate a
tag with a specific action. As a result, when you tag an interaction, Avaya Workforce Optimization
Select executes the action associated with the tag. Naming a tag based on the action associated
with it is a good practice for better identification.
If you do not want to associate any action to an interaction, associate the No action required tag
to the interaction. You can use such tags to filter interactions with specific business needs. You
can also associate such tags with business criteria. When Avaya Workforce Optimization Select
fetches the interactions that meet the business criteria, these tags automatically get associated
with the interactions.
Benefits:

• Supervisors can take advantage of tagging a live or a recorded interaction to execute certain
actions or to filter interactions.

• Supervisors or managers can create multiple tags for the same action.
Avaya Workforce Optimization Select contains a default tag, which is Flag for QA. In a Data
Partition (DP) environment, the following default tags get automatically created for each DP OU:

• Flag for QA
• Do not allow download
• Do not allow download and email
• Do not allow email

Apart from these, you can also create and manage additional tags based on your requirement.

Note:

You must have the appropriate permissions to manage tags in Avaya Workforce Optimization
Select.

Monitoring interactions in real time
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Reason codes overview
Reason codes in Avaya Workforce Optimization Select is a feature that forces you to provide a
reason when you use a recording control. Whenever you start, stop, pause, resume, or cancel the
recording of an interaction, you are forced to provide a reason. Depending on the privileges
assigned to you by your administrator, you can create additional reason codes apart from the
default ones and associate them to the interaction.
Benefits:

• An auto-resume feature is available when you pause a recording to automatically resume
recording after a predefined time interval. You can select a specific time interval in seconds to
automatically resume a call.

• The reason codes that are specified as default get automatically tagged to the interaction on
clicking the recording control.

• At a DP OU level, you can associate a reason code to a single client or to multiple clients.
For agents using the dashboard, the table below lists the recording controls for the corresponding
recording states of an interaction.

Current recording state Available recording controls
Not recording Start recording
Recording Pause recording Stop recording Cancel recording
Paused Resume recording Stop recording Cancel recording
Stopped Start recording

You can click on the recording control for the default reason code to get tagged to the interaction
or select another reason code and the selected reason code automatically gets tagged. In the
latter, you do not have to click on the recording control.

Adding tags or reason codes
Procedure

1. Click Live Monitoring > Monitor.
2. To view the list of available tags or reason codes, click Manage Tags/Reason Codes.

3. To create a tag or reason code, click Add Tag/Reason Code.

4. Enter the appropriate details.

5. Click Save & Close.

Adding tags or reason codes
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Add Tags or Reason Codes field descriptions
Name Description
DP OU The partition of the organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Action The action associated with a tag or a reason code.

The options are:

• Never delete the interaction: To tag interactions that you do not want
anyone to delete.

• No action required: To tag interactions without associating any action.
Use this tag to filter interactions with specific or custom business needs.

• Do not allow download: To tag interactions that you do not want anyone
to download.

• Do not allow email: To tag interactions that you do not want anyone to
email.

• Do not allow download & email: To tag interactions that you do not want
anyone to download and email.

• Flag for QA: To tag interactions that you do not want to flag for quality
analysis.

• Start Recording: To provide reason codes to interactions that you want
to start recording.

• Stop Recording: To provide reason codes to interactions that you want
to stop recording.

• Resume Recording: To provide reason codes to interactions that you
want to resume the recording. Selecting this option allows the user to
resume the call recording in a specific time.

• Pause Recording: To provide reason codes to interactions that you
want to pause the recording. Selecting this option allows the user to
pause the call recording in a specific time.

You can set the time interval when you want to call auto-resume after a
specific interval.

• Cancel Recording: To provide reason codes to interactions that you
want to cancel.

Table continues…
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Name Description
Name The name of the default tag or reason code that you want to associate

with an interaction.

Note:

You cannot view the operation of a tag while tagging the interaction.

Tag names must be given according to the operation defined on the tag.
Default The option to choose a tag or a reason code as the default. By default,

the first tag is considered the default.
Active The option to choose the status of a tag or a reason code as active. By

default, this option is not selected.
Description The description of the tag or the reason code.
Auto-resume interval (Secs) The option to select a specific time for the recording of the interaction to

resume automatically.

This option is only available only if you select pause recording.

Icon Name Description
Add Tag or Reason Code The option to add a tag or a

reason code.
Remove Tag or Reason Code The option to remove a tag or a

reason code.

Monitor live interactions

Playing live interactions
About this task
Supervisors and managers can monitor the live interactions of employees in real-time to respond
and mitigate customer objectives or complaints.
While monitoring a live interaction, you can:

• Play a live interaction.
• Record a live interaction, pause or resume, cancel and stop a recording.
• Provide feedback for a live interaction.
• Comment or tag a live interaction.

Procedure
1. Click Live Monitoring > Monitor.

Monitor live interactions
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2. On the Monitor page, click the  icon next to the live interaction that you want to monitor.

The system displays the Interaction Details page with the interaction streaming in the Live
Monitoring panel.

Note:

The time to view a live interaction depends on the browser you are using. You might notice
some delay in Chrome browser.

3. To view the screens that are captured in full screen, click the Fit to Width (  ) icon.

To return to the original resolution and size of the screen shot, click the Full Width (  )
icon.

4. In the Profile tab, view the details of the employee who is handling the interaction.

5. To play the previous interaction in the list, click the Previous (  ) icon.

6. To play the next interaction in the list, click the Next (  ) icon.

Managing recording controls from the Controls column
About this task
Use the recording icons in the Controls column in the Live Monitoring module to do the following:

• Start recording a live interaction
• Pause or resume a recording
• Stop a recording
• Cancel a recording

Before you begin
Get permissions from the administrator to record an interaction. If you have the permissions, the
Controls column displays the following:

•
: In an enabled state.

•
: In a disabled state.

•
: In a disabled state.

Procedure
1. Click Live Monitoring > Monitor.
2.

In the Controls column, click .
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The Recording Status column displays the status as Not Recording. The Controls column
displays the following controls:

•

•

•

3.
In the Controls column, click .

The system displays the Pause Recording page.

4. In Reason Codes, click the reason for pausing the call, select the associated tag from the
list of interaction tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

5. Click Submit.

The Recording Status column displays the status as Paused. The Controls column
displays the following controls:

•

•

•

Note:

If auto-resume interval is set for the pause control, the interaction recording automatically
resumes after the specified time.

6.
In the Controls column, click .

The system displays the Resume Recording page.

7. In Reason Codes, click the reason for resuming the recording, select the associated tag
from the list of interaction tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

8. Click Submit.

The Recording Status column displays the status as Recording. The Controls column
displays the following controls:

•

Monitor live interactions
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•

•

Note:

If auto-resume interval is set for the pause control, the interaction recording automatically
resumes after the specified time.

9.
In the Controls column, click .

The system displays the Stop Recording page.

10. In Reason Codes, click the reason for stopping the recording, select the associated tag
from the list of tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

11. Click Submit.

The Recording Status displays the status as Stopped. The Controls column displays the
following:

•

•

•

You can stop and start recording an interaction several times. Only those segments which
you recorded is available for future reference.

12. In the Controls column, click .

The system displays the Cancel Recording page.

13. In Reason Codes, click the reason for canceling the recording, select the associated tag
from the list of tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

14. Click Submit.

The Recording Status displays the status as Cancelled. The Controls column does not
display any recording control.

Note:

If you cancel a recording, you cannot recover the recording or start the recording.
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Recording a live interaction from the Live Monitoring page
About this task
Use the recording controls from the Live Monitoring page to do the following:

• Start recording a live interaction.
• Pause or resume a recording.
• Stop a recording.
• Cancel a recording.

Before you begin
Get permissions from the administrator to record an interaction. If you have the permissions, the
Interaction Details page displays the following:

•
: In an enabled state.

•
: In a disabled state.

•
: In a disabled state.

Procedure
1. Click Live Monitoring > Monitor.
2. On the Monitor page, click the listen icon  next to the live interaction that you want to

monitor.

The system displays the Interaction Details page with the interaction streaming in the Live
Monitor panel.

Note:

The time to view a live interaction depends on the browser you are using. You might notice
some delay in Chrome browser.

Start recording a live interaction: 
3.

In the Controls column, click .

The Recording Status column displays the status as Not Recording. The Controls column
displays the following controls:

•

•
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•

Pausing a recording: 

Note:

If auto-resume is set for an interaction, the interaction automatically resumes after the specified
time.

4.
In the Controls column, click .

The system displays the Pause Recording page.

5. In Reason Codes, click the reason for pausing the call, select the associated tag from the
list of interaction tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

6. Click Submit.

The Recording Status column displays the status as Paused. The Controls column
displays the following controls:

•

•

•

Resuming a recording: 

Note:

If auto-resume is set for an interaction, the interaction automatically resumes after the specified
time.

7.
In the Controls column, click .

The system displays the Resume Recording page.

8. In Reason Codes, click the reason for resuming the recording, select the associated tag
from the list of interaction tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

9. Click Submit.

The Recording Status column displays the status as Recording. The Controls column
displays the following controls:

•
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•

•

Stopping a recording : 

You can stop and start recording an interaction several times. Only those segments which you
recorded is available for future reference.

10.
In the Controls column, click .

The system displays the Stop Recording page.

11. In Reason Codes, click the reason for stopping the recording, select the associated tag
from the list of interaction tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

12. Click Submit.

The Recording Status displays the status as Stopped. The Controls column displays the
following:

•

•

•

Canceling a recording: 

If you cancel a recording, you cannot do the following:

• Recover the recording

• Start the recording

13. In the Controls column, click .

The system displays the Cancel Recording page.

14. In Reason Codes, click the reason for canceling the recording, select the associated tag
from the list of interaction tags, and enter your comments in the Comments field.

The Comments and the Interaction Tags fields are not mandatory fields.

15. Click Submit.

The Recording Status displays the status as Cancelled. The Controls column does not
display any recording control.
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Providing feedback for a live interaction
About this task
As a supervisor or manager monitoring live interactions, you can provide feedback to the agent
during the live call.
You can select the recipients and delivery method of the feedback message. The message is
delivered through email or as a notification message in the inbox of recipients.

Procedure
1. Click Live Monitoring > Monitor.
2. On the Monitor page, click the  icon next to the live interaction that you want to comment

on.

3. On the Interaction Details page, click Feedback.

4. Enter the appropriate details in the fields.

5. Click Send.

The message is sent to all recipients as an email or a message in their notification inbox.

Adding comments to a live interaction
About this task
While monitoring an interaction in real time, supervisors and managers can add comments to
provide specific information about the interaction.

Procedure
1. Click Live Monitoring > Monitor.
2. On the Monitor page, click the  icon next to the live interaction that you want to comment

on.

3. On the Interaction Details, click Comments/Tags.

4. In comments, enter a comment.

You can only update or delete the comments that you add. However, if you have access to
the interaction, then you can view all the comments made by others.

5. Click Submit.
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Tagging a live interaction
About this task
Supervisors can tag an interaction to enforce the following set of predefined actions:

• Never delete the call
• No action required
• Need training
• Do not allow download
• Do not allow email
• Do not allow download & email
• Flag for QA

Procedure
1. Click Live Monitoring > Monitor.
2. On the Monitor page, click the  icon next to the live interaction that you want to comment

on.

3. Click Comments/Tags.

4. On the Tags list, click the required tag.

5. Click Set.

Comments/Tags field descriptions
Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.
Actions The option to edit or delete a comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Do not allow download The tag used to specify that the interaction cannot be downloaded.

Table continues…
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Name Description
Do not allow download and
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.

Do not allow email The tag used to specify that the interaction cannot be sent by email.
Flag for QA The tag used to specify that the interaction is flagged for quality analysis.

Live interactions field descriptions
Profile

Name Description
Controls The recording controls to record, pause or resume, cancel, and stop a

recording.
Play The option to play a live interaction.
Recording status The current status of the recording.
Employee Code The employee ID of the person who is attending to the interaction.
Employee The name of the employee who is interacting.
Extension The extension number of the employee on which the interaction is being

handled.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
Current State The current interaction state indicating whether the employee is attending

to the interaction or has put the interaction on hold.
Current State Duration The duration of the current state of the interaction.
Groups The name of the group that the employee belongs to.
Site The name of the location that the employee belongs to.
Reporting To The name of the supervisor or manager to whom the employee reports.
Queue The queue that the interaction is associated with.

Feedback

Name Description
Broadcast on The delivery mode by which the message is sent as feedback. The

options are:

• Email: To send the feedback message to the employees mentioned in
CC field and to the Agent mentioned in the To field.

• My Inbox: To send the feedback message to the notification inbox of
the selected employees.

Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
Extension The extension number of the employee on which the interaction is being

handled.

Table continues…
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Name Description
To The email id of the agent who is handling the call and which is configured

in the admin employee profile screen.
Subject The subject of the feedback message.
Message Type The type of message to be delivered to the recipients. The options are:

• Notifications: To send feedback as a notification message.

• Alert: To send feedback as an alert.

• Information: To send feedback as an information message.
Agent Name The name of the employee who is interacting.
From The email id of the supervisor who is sending the feedback.
CC The email id of employees to whom a copy of the feedback is sent.
Comments The text message sent as feedback for the live interaction.

Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.
Actions The option to edit or delete a comment.

Recording controls
Name Description
Reason Codes The option to select the reason for starting a

recording, pausing, resuming, canceling, and
stopping a recording.

This field is mandatory when you click on any of the
recording controls. In this scenario, the Comments
and Tags fields are available as non-mandatory
options. If you expand an interaction without clicking
on any of the recording controls, keep the default
Pick one option to disable it. The Comments and
Tags fields remain non-mandatory options.

Comments The field for the user to enter the comments while
starting a recording, pausing, resuming, canceling,
or stopping a recording.

Controls Name Description
Start recording Indicates that a recording has not started.

Use this control to start a recording.

Table continues…
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Controls Name Description
Paused disabled Indicates that the recording has not started.

Cancel disabled Indicates that the recording has not started.

Recording Indicates that a recording is in progress.

Pause/Resume Indicates that a recording is in progress.
Use this control to pause a recording.

Cancel Indicates that a recording is in progress.
Use this control to cancel a recording.

Recording paused Indicates that the recording is paused.

Resume recording Indicates that the recording is paused. Use
this control to resume a recording.

Stop Indicates that a recording is in progress.
Use this control to stop a recording.

Stop disabled Indicates that a recording is in progress.
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Chapter 5: Managing recorded interactions

Interactions overview
Using the Interactions module, authorized users can view and manage interactions of the
employees that they have access to. During interaction playback, the supervisor can view details
of each segment of an interaction to determine if the call was transferred or put on hold.

Note:

With appropriate permissions, employees can also view their own interactions.

The Interactions module provides the following benefits:

• Playback recorded interactions including recordings done by an external party, or in a legacy
system in the wav-G.711aLaw-mono, wav-G.711aLaw-stereo, wav-G.711uLaw-stereo, wav-
G.711uLaw-mono, wav-PCM-stereo, wav-PCM-mono, wav-G.711–uLaw-stereo, wav-G.726-
stereo, wav-G.726-mono, wav G.729–mono, mp4–H.264–stereo, mp4–H.264–mono, m4a-
AAC-stereo, and m4a-AAC-mono audio formats.

• Create different views to define search criteria and quickly access the interactions that you
want to frequently view and listen.

• Create adhoc interactions to listen to an interaction series, voice or non-voice, between a
customer and the employees of an organization. You can either create interactions by
importing from an external source or group a series of interactions to form composite
interactions. Composite interactions can be a combination of system interactions, imported
interactions or both. The supported formats for uploading adhoc interactions
are: .wav, .m4a, .mpeg-4, and .mp3.

• Add comments to a recorded interaction especially when the supervisor wants to provide
important information to the evaluator or reviewer.

• Download a recorded interaction in .wav, .mp4 for audio and screens, and m4a for mp4 audio
formats.

• Use existing tags or create one to apply to an interaction. Using tags, supervisors or
managers can restrict specific actions on interactions such as downloading or deleting of
interactions.

• Customize the Interactions page with columns to quickly identify important interaction details.
For example: The columns could be interaction start time, interaction end time, duration, who
ended the interaction whether the customer or the agent, number of holds, number of
transfers, and hold duration.
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• Get a visual depiction of the conversation graphs that provide quick identification of problem
areas such as crosstalk or elevated voices.

• View all interaction segments such as conference, transfers, and caller experience details.

Using the Interactions module, authorized users can:

• Manage views

• View recorded interactions

• Play recorded interactions

View recorded interactions
Supervisors can view and monitor recorded interactions and get a quick snapshot of how the team
members are performing.
You can view and track recorded interactions to:

• Listen and assess recorded interactions of new employees.
• Identify employees whose average handle time and hold count is high.
• View the number of interactions handled by each employee, comments added to interactions,

and interactions that are already played.
• Customize the page to add columns that display interaction details such as extension, queue,

tenure, and duration.
• Filter your search on specific columns by using conditions and operators.
• Use the pagination option to specify how many records you want to view per page.

Play recorded interactions
The Avaya Workforce Optimization Select application automatically records interactions and
captures screen shots of agent’s desktop which appear when playing back an interaction.
While listening to a recorded interaction, you can:

• Add comments to provide information to the evaluator or reviewer.
• Download a recorded interaction in WAV, MP4 (Audio only), and MP4 formats.
• Tag the interaction to enforce an action or filter interactions based on custom business

needs.
• View the conversation graph that provides quick identification of problem areas such as cross

talk or elevated voices.

Note:
• If a voice or a non voice interaction configured for screen capture recording is paused,

then during playback, Avaya Workforce Optimization Select displays the  image to
indicate that no screens are captured during the paused state.

• If a voice or non voice interaction configured for screen capture recording is terminated
when the recording is paused, then during playback, Avaya Workforce Optimization

Select displays the  image during the paused state and at the end of the screen cast.
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Manage views
Using views, you can filter data by specific criteria.

Depending on the business requirement, you can create different views with filters using logic
conditions. For example, to search for live interactions that have been put on hold a number of
times, you can define filters based on Greater Than or Between. The view displays the
interactions that match the search criteria.

Note:

When you log in to the application the first time, the system displays the AWFOS view, which is
the default view. You can create a new view to search and play the desired interactions.

After you create a view, you can use it anytime later.

You can do the following while creating views:

• Create multiple filters.

• Use the default view that comes with a preconfigured set of parameters.

• Define the search criteria with a comprehensive list of parameters.

• Use operators to add multiple filters to use multiple parameters for a view.

• Use the option to display additional columns in the live interactions list.

• Share Views that you create with other users.

Adding a view
About this task
Use the view option to search for interactions based on the filters you specify.
By default, the AWFOS Default view comes with a set of pre defined filters configured by the
system administrator. You cannot modify the filters on the AWFOS Default view. You can also save
a view as an adhoc report.

Procedure
1. Click Interactions > Playback.

Avaya Workforce Optimization Select displays the interactions in the default view.

2. Click Add to create a new view to display interactions that match your required criteria.

Avaya Workforce Optimization Select displays the Create View page where you can define
the filter criteria and save the view.

3. In Name, enter the name of a view.

4. In Description, enter the description of a view.
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Next steps
Set up filters for a view.

Setting up filters for a view
About this task
Using filters in view, you can add:

• Multiple search parameters within a single filter criteria.
• Multiple values separated by commas to match a single parameter .

Procedure
1. In Filter add fields, operators and values for

a. In Field, select the field on which to apply the filter.

b. In Operator, select the operator which to apply.

c. In Value, enter the value that the records must match.

2. To add additional filters, click Add Field.

3. In Display Fields, select the fields to be displayed.

4. In Share, select the groups and employee to share the view.

5. To save the view, click the Save & Close button.

Configuring display fields for a view
About this task
When you select a view, you can view the interaction details in the list. All the information on the
interaction is not displayed. If you do not see the specific fields you are looking for, you can
configure additional fields to display in the list.

Procedure
To move fields to the Selected Fields list:

1. Select one or more fields from the Available Fields list.

a. To search a field, type the first few characters of the field name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

To remove fields from the Selected Fields list:

2. Select one or more fields from the Selected Fields list.

a. To search a field, type the first few characters of the field name in Search.
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b. To remove a single selection from the list, use the Remove Selected button.

c. To remove multiple selections from lists, use the Remove All button.

3. (Optional) To rearrange the order of the selected fields, click the arrows next to the
Selected Fields screen.

The order selected in the views determine the sequence of the columns in the output.

Next steps
Share a view.

Sharing a view
About this task
Use this procedure to share a view that you created so that other users can reuse the shared view
to search for interactions.
You can keep the saved view as private or share the view with specific employees, or everyone.
The selected users can see the shared view in their saved views.

Procedure
1. From Share, select one of the following to share the view with other users:

• Me
• Selected Groups
• Everyone

2. To share the view with selected groups, select Selected Groups.

The Edit View page displays the Group and the Employee search and select options.

3. Select one or more groups from the Available Groups list.

a. To search a group, type the first few characters of the group name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

4. To remove groups from the Selected Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

5. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in
Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

6. To remove employees from the Selected Employees list; select one or more employees
and use the Remove Selected and Remove All buttons.
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7. Click Save and Close.

Create View field descriptions
View

Name Description
Name The name of the view.

This field is mandatory.
Default The option to display the selected view as the default. You can set a view

as default if you want to see a certain set of interactions each time you
login.

Description The description that helps to understand the reason for creating a view.
Filter The filter criteria used to search the interactions.
Display Fields The columns displayed in the search results.

You can move or remove the fields in the Available Fields screen to the
Selected Fields screen while adding a view. The arrows next to the
Selected Fields allows the user to rearrange the order of the selected
fields.

Share The option to share the view with selected users, with everyone, or save
it as private.
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Filter

Name Description
Field The parameters used to filter the search results. The options are:

• Role

• Archived

• Audio Codec

• Interaction Status

• Commented

• Department

• Employee Status

• Evaluated

• Flagged for QA

• Groups

• Hold Duration

• Hunt Group

• Interactions ID

• Interaction Comments

• Interaction Tags

• Interaction Type

• No of holds

• No of Transfers

• Organization Unit

• User Name

• Random Calls

• Site

• Source Type

• Reporting to

• Tagged

• Tenure (In Weeks)

• Transcribed

• Transfer Number

• Transfer Type

• UCID
Table continues…
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Name Description
• Variables 1–10

• VDN

• Interaction ended by

• Employee

• Transaction Date

• Duration

• Queue

• Called Party

• Calling Party

• Agent ID

• Extension

• Screen Captures
Operator The operator used to specify the search criteria. The options are:

• Equals To

• Not Equal To

• Contains

• Does not contain

• Starts With

• Does not Start With

• Ends With

• Does not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between
Value The value specified in the search query that is used to match the records.

You can view the list of interactions that match the value in this list.
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Fields

Name Description
Role To search for interactions of employees with the specified designation or

role.
Archived To search for interactions that are archived.

The options to filter interactions based on archiving from the Value field
are:

• Yes: To filter the interactions that were archived.

• No: To filter the interactions that were not archived.
Audio Codec To search for interactions that are compressed using the selected audio

codec.
Interaction Status To search for interactions based on the recording status of the interaction.

The options are:

• NoRTP: Interactions that do not have any voice streams or RTP.

• Connected: Interactions with voice streams or RTP.

• Unknown: Non voice interactions.
Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Department To search for interactions of employees who belong to the specified

department.
Employee Status To search for interactions by the status of the employee attending to the

interaction. The options are:

• Active

• Inactive
Evaluated To search for evaluated interactions.
Flagged for QA To search for interactions that are flagged for QA.

The options to filter interactions based on flagging from the Value field
are:

• Yes: To filter the interactions that were flagged for QA.

• No: To filter the interactions that were not flagged for QA.
Groups To search for interactions of employees belonging to the specified group.
Hold Duration To search for interactions based on the hold duration.
Hunt Group To search for interactions based on the grouping of extensions handled

by agents to interact.
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Name Description
Interactions ID To search for interactions based on the interaction ID.
Interaction Comments To search for interactions based on specific comments provided by

employees.
Interaction Tags To search for interactions based on the specific tags used for association.
Interaction Type To search for interactions based on the type of interaction.
User Name To search for interactions based on the user name of the employee.
No of Holds To search for interactions with the specified number of holds.
No of Transfers To search for interactions with the specified number of transfers.
Organization Unit To search for interactions based on the name of the organizational unit.

Use the available operators to define your search criteria.

For example, when you use the Excludes operator and enter the name
of the organizational unit, a specific organizational unit is removed from
the search.

Random Calls To get a view of the interactions randomly.

By default, Avaya Workforce Optimization Select displays the list of
interactions in the same sequence for all employees using a shared view.
If you select this option, Avaya Workforce Optimization Select randomly
displays the same list of interactions.

Site To search for the interactions of employees belonging to the specified
site.

Source Type To search for interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Reporting To To search for interactions based on the name of the supervisor.

For example, to search for interactions monitored by a specific
supervisor, use the Contains operator and specify the supervisor name.
The search results display the interactions by all employees assigned
under the selected supervisor.

Tagged To search for tagged interactions.

The options to filter interactions based on tags from the Value field are:

• Yes: To filter the interactions that were tagged.

• No: To filter the interactions that were not tagged.
Tenure (In Weeks) To search for interactions based on the tenure of the employee in weeks.

Table continues…
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Name Description
Transcribed To search for interactions that are transcribed by the speech engine.
Transfer Number To search for interaction based on the station or the extension number of

the party to whom the interaction is transferred.
Transfer Type To search for interactions based on how you transfer a call. The options

are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

UCID To search for interactions based on the universal call ID. This ID remains
the same even when a call is transferred to another agent or called party.

Custom Variables To search for interactions based on custom variables defined for your
business.

VDN To search for interactions based on an extension number that is used to
enable calls to connect to a vector for processing.

Interaction ended by To search for interactions based on who ended a interaction. The options
are:

• Agent

• Customer
Employee To search for interactions based on the employees that you have access

to.
Transaction Date To search for interactions based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

You can also search for interactions for a specific date range.
Duration To search for interactions by the duration specified in the hh:mm:ss

format.
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Name Description
Queue To search for interactions by the queue that the interaction is associated

with.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

Agent ID To search for interactions of employees with the specified agent or
network ID.

Extension To search for interactions by the extension number of the employee.
Screen Captures To search for interactions with screens.

Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Ends With To search for interactions that ends with a specified value.
Does not End With To search for interactions that does not end with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Display Fields

Name Description
Role The designation of the employee in the organization.
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Name Description
Archived The option to indicate if the interaction is archived.
Audio Codec The option to indicate interactions that are compressed using the

selected audio codec.
Interaction Status The option to indicate the status of an interaction. The options are:

• Active

• Inactive
Department The name of the department that the employee belongs to.
Evaluated The option to indicate if an interaction is already evaluated.
Flagged for QA The option to indicate if an interaction is selected for quality analysis.
Groups The name of the group that the employee belongs to.
Hold Duration The total duration for which the employee put the interaction on hold in

the hh:mm:ss format.
Hunt Group The option to indicate interactions based on the grouping of extensions

handled by agents to interact.
Interaction Tags The option to indicate interactions based on the specific tags used for

association.
Interaction Type The option to indicate interactions based on the type of interaction.
User Name The option to indicate interactions based on the user name of the

employee.
No of holds The number of times that the employee put the interaction on hold.
No of Transfers The number of times that the employee transferred the interaction.
Organization Unit The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Source Type The source of the interaction. The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Reporting to The supervisor to whom the employee handling the interaction reports to.
Tagged The option to indicate if an interaction is tagged.
Tenure (In Weeks) The employee’s tenure in the organization in weeks.
Transcribed The interactions that are transcribed by the speech engine.
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Name Description
Transfer Type The option that specifies how you transfer a call. The options are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

Transfer Number The option to indicate interaction based on the station or the extension
number of the party to whom the interaction is transferred.

UCID Universal Call ID is the unique tag assigned to a call. UCID provides a
way to track calls across multiple communication servers and Voice
Response Units.

This ID remains the same even when a call is transferred to another
agent or called party.

Custom Variables The option to indicate interactions based on custom variables defined for
your business.

VDN The option to indicate interactions based on an extension number that is
used to enable calls to connect to a vector for processing.

Interaction ended by The interaction that indicates who ended a interaction.

The options are:

• Agent

• Customer
Employee The name of the employee who attended to the interaction.
Interaction Date The option to indicate interactions based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

You can also search for interactions for a specific date range.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
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Name Description
Duration The option to indicate interactions by the duration specified in the

hh:mm:ss format.
Direction The direction of the interaction. The options are:

• All

• Inbound

• Outbound
Queue The option to indicate interactions by the queue that the interaction is

associated with.
Called Party The extension number or email ID of the called party.
Calling Party The extension number of email ID of the calling party.
Agent ID The specified agent or network ID.
Extension The extension number of the employee.
Screen Captures The option to indicate interactions with screens.

Share

Name Description
Me The option to set the view as private where other users will not be able to

view or use the view.
Selected Groups The option to share the view with specific people or groups.
Everyone The option to share the view with all users of the application.

By sharing the view with a group or with everyone, the system renders
results based on the access with whom the view is shared.

Note:

Users can only view search results and cannot edit the search results.

Button Name Description
Save as Report The option to save a view as an adhoc report. You can view this report in

the Reports tab.

Viewing recorded interactions
About this task
On the Playback page, you can view and play the recorded interactions of employees or team
members that you have access to.
When you select a view, the search results display interactions based on the filter criteria defined
for the view.
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If the current view does not provide the appropriate search results consider modifying the search
criteria in the selected view, or create a new view.

Procedure
1. Click Interactions > Playback.

2. On the View list, click the view you want to filter.

3. View the basic details of each interaction displayed in the columns.

4. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

5. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

6. (Optional) To clear the filters from all the columns, click the  icon.

7. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

8. (Optional) To reset the sorting, click the  icon.

Playback field descriptions
Name Description
Interaction ID The unique ID of the interaction.
Employee The name of the employee who attended to the interaction.
Reporting To The name of the supervisor or manager to whom the employee reports.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Duration The duration of the interaction in the hh:mm:ss format.
Queue The queue that the interaction is associated with.
DP OU Type The partition of the organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Organization Units The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Groups The name of the group that the employee belongs to.

Table continues…
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Name Description
Tenure The tenure of the employee in the organization, in weeks.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

No of Holds The number of times that the employee put the interaction on hold.
No of Transfers The number of times that the employee transferred the interaction.
Hold Duration The total duration for which the employee put the interaction on hold in

the hh:mm:ss format.
Screen Captures The field to indicate if the interaction has screens captures. The options

are:

• Yes

• No
Department The name of the department that the employee belongs to.
Transaction Date The date on which the interaction is recorded.
Direction The direction of the interaction. The options are:

• Inbound

• Outbound
Interaction Status The recording status of the interaction.
Interaction Type The type of the interaction. The options are:

• Voice

• Chat

• Email

• SMS

You can also view customized interaction if you have created custom
interaction types in the general settings.

Interaction ended by The party who ended the interaction. The options are:

• Agent

• Customer

Table continues…
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Name Description
Transfer type The option that specifies how you transfer a call. The options are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

Source type The source of the interaction to be evaluated. The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Agent ID The ID of the agent logged in into the phone.
Evaluated The interactions that are already evaluated.
Tagged The interactions that are tagged.
Flagged for QA The interactions that are selected for quality analysis.
UCID Universal Call ID is the unique tag assigned to a call. UCID provides a

way to track calls across multiple communication servers and Voice
Response Units.

Var 1

Var 2

Var 3

Var 4

Var 5

Var 6

Var 7

Var 8

Var 9

Var 10

The custom variables defined for an interaction based on your business.

Archived The interactions that are archived.
Role The designation of the employee who handled the interaction.

Table continues…
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Name Description
Transcribed The interactions that are transcribed by the speech engine.

Icon Name Description
Play The interaction that is available to play for monitoring and evaluation.

• Green: The customer has ended the interaction.

• Red: The employee has ended the interaction.
Interaction
Viewed

The interaction that is viewed by the supervisor or manager for
monitoring. The number on the icon indicates the number of times the
interaction has been viewed.

Evaluated The interaction that is evaluated by the supervisor or manager.

Commented/
Tagged

The interaction that is commented on by the supervisor or manager. The
number on the icon indicates the total number of comments received on
the interaction.

Manage tags and reason codes
Tags overview
Use tags to classify interactions and enforce specific actions on interactions. You can associate a
tag with a specific action. As a result, when you tag an interaction, Avaya Workforce Optimization
Select executes the action associated with the tag. Naming a tag based on the action associated
with it is a good practice for better identification.
If you do not want to associate any action to an interaction, associate the No action required tag
to the interaction. You can use such tags to filter interactions with specific business needs. You
can also associate such tags with business criteria. When Avaya Workforce Optimization Select
fetches the interactions that meet the business criteria, these tags automatically get associated
with the interactions.
Benefits:

• Supervisors can take advantage of tagging a live or a recorded interaction to execute certain
actions or to filter interactions.

• Supervisors or managers can create multiple tags for the same action.
Avaya Workforce Optimization Select contains a default tag, which is Flag for QA. In a Data
Partition (DP) environment, the following default tags get automatically created for each DP OU:

• Flag for QA
• Do not allow download
• Do not allow download and email
• Do not allow email

Apart from these, you can also create and manage additional tags based on your requirement.
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Note:

You must have the appropriate permissions to manage tags in Avaya Workforce Optimization
Select.

Reason codes overview
Reason codes in Avaya Workforce Optimization Select is a feature that forces you to provide a
reason when you use a recording control. Whenever you start, stop, pause, resume, or cancel the
recording of an interaction, you are forced to provide a reason. Depending on the privileges
assigned to you by your administrator, you can create additional reason codes apart from the
default ones and associate them to the interaction.
Benefits:

• An auto-resume feature is available when you pause a recording to automatically resume
recording after a predefined time interval. You can select a specific time interval in seconds to
automatically resume a call.

• The reason codes that are specified as default get automatically tagged to the interaction on
clicking the recording control.

• At a DP OU level, you can associate a reason code to a single client or to multiple clients.
For agents using the dashboard, the table below lists the recording controls for the corresponding
recording states of an interaction.

Current recording state Available recording controls
Not recording Start recording
Recording Pause recording Stop recording Cancel recording
Paused Resume recording Stop recording Cancel recording
Stopped Start recording

You can click on the recording control for the default reason code to get tagged to the interaction
or select another reason code and the selected reason code automatically gets tagged. In the
latter, you do not have to click on the recording control.

Adding tags or reason codes
Procedure

1. Click Interactions > Playback.

2. To view the list of available tags or reason codes, click Manage Tags/Reason Codes.

3. To create a tag or reason code, click Add Tag/Reason Code.

4. Enter the appropriate details.

5. Click Save & Close.
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Add Tags or Reason Codes field descriptions
Name Description
DP OU The partition of the organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Action The action associated with a tag or a reason code.

The options are:

• Never delete the interaction: To tag interactions that you do not want
anyone to delete.

• No action required: To tag interactions without associating any action.
Use this tag to filter interactions with specific or custom business needs.

• Do not allow download: To tag interactions that you do not want anyone
to download.

• Do not allow email: To tag interactions that you do not want anyone to
email.

• Do not allow download & email: To tag interactions that you do not want
anyone to download and email.

• Flag for QA: To tag interactions that you do not want to flag for quality
analysis.

• Start Recording: To provide reason codes to interactions that you want
to start recording.

• Stop Recording: To provide reason codes to interactions that you want
to stop recording.

• Resume Recording: To provide reason codes to interactions that you
want to resume the recording. Selecting this option allows the user to
resume the call recording in a specific time.

• Pause Recording: To provide reason codes to interactions that you
want to pause the recording. Selecting this option allows the user to
pause the call recording in a specific time.

You can set the time interval when you want to call auto-resume after a
specific interval.

• Cancel Recording: To provide reason codes to interactions that you
want to cancel.

Table continues…
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Name Description
Name The name of the default tag or reason code that you want to associate

with an interaction.

Note:

You cannot view the operation of a tag while tagging the interaction.

Tag names must be given according to the operation defined on the tag.
Default The option to choose a tag or a reason code as the default. By default,

the first tag is considered the default.
Active The option to choose the status of a tag or a reason code as active. By

default, this option is not selected.
Description The description of the tag or the reason code.
Auto-resume interval (Secs) The option to select a specific time for the recording of the interaction to

resume automatically.

This option is only available only if you select pause recording.

Icon Name Description
Add Tag or Reason Code The option to add a tag or a

reason code.
Remove Tag or Reason Code The option to remove a tag or a

reason code.

Manage recorded interactions

Playing recorded interactions
About this task
During an enquiry, customer dispute, or non compliance issue, as a supervisor or manager you
can listen to the recorded interaction and view the associated onscreen activity.
While listening to a recorded interaction, you can:

• Comment or tag a recorded interaction to provide information to evaluator or reviewer.
• Email a recorded interaction.
• Download a recorded interaction in different formats.
• Evaluate a recorded interaction.
• View previous evaluation comments.
• View interaction segments.
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Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.

The Interaction Details page displays a graph of the recorded interaction in the Audio
section along with the interaction details and the playback controls.

3. On the Interaction Details page, in the recorder panel, click one of the following:

•  icon: To listen to the recorded interaction.

•  icon: To stop the recorded interaction.

•  icon: To stop the playback of a recording and resume from where it stopped.

•  icon: To increase or decrease the speed of the recorded interaction.

•  icon: To open the screencast in a window to view the screens at any point of
evaluation without scrolling the screen.

4. In the Interaction Details tab, view the interaction details.

Interaction Details field descriptions
Name Description
Interaction ID The unique ID of the interaction.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Duration The duration of the interaction in the hh:mm:ss format.
Employee Code The employee code of the agent who attended to the interaction.
Employee Name The name of the employee who attended to the interaction.
Extension To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Site The name of the site that the employee belongs to.

The system administrator associates employees working in different
locations to the relevant sites. Supervisors and managers can monitor
interactions of employees based on the Site to which they belong to.

Number of Holds The number of times that the employee put the interaction on hold.
Number of DTMF Keys The number of times the DTMF (Dual Tone Multiple Frequency) keys

were pressed by the participants of an interaction. Each number is
associated with an action.

Groups The groups that the supervisor or manager has access to.
Reporting To The name of the supervisor or manager to whom the employee reports.

Table continues…
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Name Description
Queue The queue that the interaction is associated with.
Screen The field to indicate whether the screen capture is enabled for recording.
Transfers The number of times that the employee transferred the interaction.
Agent ID The ID of the agent logged in into the phone.
Called Party The extension number or the email ID of the called party.
Calling Party The extension number or the email ID of the calling party.
Total Hold Time The total duration for which the employee put the interaction on hold in

the hh:mm:ss format.

Hold Duration Details

Name Description
Hold Start Time The start time and date when the employee put the interaction on hold in

a 24-hour format: mm/dd/yyyy hh:mm:ss.
Hold End Time The end time and date when the employee put the interaction on hold in a

24-hour format: mm/dd/yyyy hh:mm:ss.
Hold Duration The duration when the employee put the interaction on hold in a 24-hour

format: hh:mm:ss.
DTMF Key The DTMF key pressed by the participants of the interaction.
Talking to (Agent ID) The ID of the agent logged in into the phone.
Agent Name The name of the agent who attended the interaction.
Extension The extension number of the employee on which the interaction is being

handled..
Dialed to The extension number of the calling party.

Viewing interaction segments
About this task
Use this procedure to view all the segments of the interaction, including interaction transfers,
conferences, and the duration for which the interaction was put on hold.

Procedure
1. On the Interaction Details page, click the Segment Details tab.

2. In the Segment Overview section, click the segment of the interaction that you want to
listen to or view.

The segment of the interaction plays in the Recorder panel.

3. In the Customer Interaction across Segments section, view the details of the interaction
across segments.

Managing recorded interactions

October 2019 Using Avaya Workforce Optimization Select 82
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Segment Details field descriptions
Name Description
Total Customer Call
Duration

The total duration of the interaction handled by the employee including
the hold time and time to transfer the interaction.

Customer Interaction
across Segments

The time on each segment of the interaction including transfer and
conferences of the interaction with other employees or agents.

Start Time The start time of the interaction in a 24–hour format: mm:dd:yyyy
hh:mm:ss.

End Time The end time of the interaction in a 24–hour format: mm:dd:yyyy
hh:mm:ss.

Dialed From To search for interactions by the extension number or email ID of the
called party. You can use any alphanumeric characters or symbols to
search an interaction.

For example, to search for interactions of a specific employee, enter the
extension number of the employee.

Dialed To To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

Total Duration The total duration of the interaction in a 24–hour format: hh:mm:ss
format.

Total Hold Duration The total duration for which the interaction was put on hold in in a 24–
hour format: hh:mm:ss format.

Total Transfers The total number of times that the interaction is transferred by the
employee.

Total Holds The total number of times that the interaction is put on hold by the
employee.

Total Conferences The total number of times that the interaction is put on conference by the
employee.

Adding comments to an interaction
About this task
Supervisors and managers can add comments to a recorded interaction.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.

3. On the Interaction Details, click Comments/Tags.

4. In comments, enter a comment.
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You can only update or delete the comments that you add. However, if you have access to
the interaction, then you can view all the comments made by others.

5. Click Submit.

Comments/Tags field descriptions
Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.
Actions The option to edit or delete a comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Do not allow download The tag used to specify that the interaction cannot be downloaded.
Do not allow download and
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.

Do not allow email The tag used to specify that the interaction cannot be sent by email.
Flag for QA The tag used to specify that the interaction is flagged for quality analysis.

Tagging an interaction
About this task
Supervisors can tag an interaction to enforce the following set of predefined actions:

• Never delete the interaction
• No action required
• Do not allow download
• Do not allow download and email
• Do not allow email
• Flag for QA

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.
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3. Click Comments/Tags.

4. On the Tags list, click the required tag.

5. Click Set.

Comments/Tags field descriptions
Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.
Actions The option to edit or delete a comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Do not allow download The tag used to specify that the interaction cannot be downloaded.
Do not allow download and
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.

Do not allow email The tag used to specify that the interaction cannot be sent by email.
Flag for QA The tag used to specify that the interaction is flagged for quality analysis.

Evaluating interactions
About this task
Use this procedure to view the previous evaluation scores for an interaction and to evaluate the
interaction. You can evaluate an interaction even when it is evaluated before.

Procedure
1. Click Interactions > Playback.

2. On the View list, click the view you want to filter.

3. To view the evaluation for an interaction, click the  icon in the interaction row.

4. On the Interaction Details page, click the Evaluations (x) tab, where x denotes the number
of times an interaction was evaluated.

5. Click the View ( ) icon to view the details of the evaluation scores that was received for
the interaction.
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6. To evaluate the interaction, click Evaluate Now.

The Avaya Workforce Optimization Select displays a blank form name and evaluation type
with default value as Normal.

Evaluations field descriptions
Name Description
Form The evaluation form based on which the evaluation is performed.
Reviewer The name of the employee who evaluated the interaction.

Any employee with appropriate privileges can evaluate an interaction.
Evaluation Type The name denoting the type of evaluation.

For example, Normal, Adhoc, or Training to indicate the purpose or
category of evaluation.

Score The score received by the employee during evaluation of the interaction.
Evaluation Date The date on which the evaluation is performed.
Evaluation Modified Date The latest date on which the evaluation was modified for the previous

evaluation.
Courses The course that was assigned to the employee based on the previous

evaluation scores.
Quizzes The quiz that was assigned to the employee based on the previous

evaluation scores.

Playing interaction transcript
About this task
Use this procedure to playback interactions that are transcribed from the Speech module.

Procedure
1. Click Interactions > Playback.

2. On the View list, click the view you want to filter.

3. To playback the interaction, click the  icon in the interaction row.

4. On the Interaction Details page, click the Speech tab.

Avaya Workforce Optimization Select displays the interaction transcript.

Interaction transcript field descriptions
Avaya Workforce Optimization Select displays the following interaction transcript with speaker separation
and time stamp if the speech parameter Diarization is set to True in SysAdmin. Click on any of the rows and
the audio graph moves to the corresponding section of the conversation.
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Name Description
Speech Search The list of searches and business criteria that

fetched the interaction and which the logged in user
has access to.

The phrases and/or words defined as part of the
search and business criteria that fetched the
interaction are highlighted in the transcript.

Speaker The splitting of audio recordings into individual
speakers.

Start Time The start time of the speaker conversation.
End Time The end time of the speaker conversation.
Text The text conversation or transcript of the speaker.

Note:
Avaya Workforce Optimization Select displays the entire conversation without speaker
separation and time stamp if the speech parameter Diarization is set to False in SysAdmin.

Downloading an interaction
About this task
Supervisors and managers can download interactions in WAV, MP4 (audio only), and MP4 (audio
and screens) formats. Use the MP4 (audio and screens) option only to download interactions with
screens and for nonvoice interactions.
You can directly download the WAV file to your local machine. The MP4 (audio only) and MP4
(audio and screens) formats are available to download from the Media Downloads page.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon next to the interaction that you want to play.

3. On the Interaction Details page, click the  icon.

4. On the Download page, type appropriate comments for the interaction.

5. Select the format in which you want to download.

• WAV: To download the interactions with recorded voice.

• MP4 (Audio Only): To download the interactions with recorded voice.

• MP4 (Audio and Screens): To download interactions with screens and for nonvoice
interactions.

6. Click Submit.
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Emailing an interaction
About this task
You can send an interaction as an email if you want other users to view or listen to the interaction.
The interaction is sent as a link, and the user must log on to the application to access the
interaction.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon next to the interaction that you want to play.

3. On the Interaction Details page, click the  icon.

4. Enter the message, recipient details, and click Send.

Email interaction field descriptions
Name Description
From The email address of the sender.
To The email address of the recipient to whom you want to mail the

interaction.
Subject The subject of the email.
Comments The body of the email.
Agent Name The name of the agent who handled the interaction.
Extension The phone extension number of the agent who handled the interaction.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
CC The email address of the employee to whom you want to mail a copy of

the interaction.

Managing adhoc interactions

Adhoc Interactions overview
Using adhoc interactions, you can import interactions, both voice and non-voice. You also have
the flexibility to use a series of related interactions to create a composite interaction that depict an
end-to-end customer journey.

Benefits:

• Import both voice and non-voice interactions to create an adhoc interaction.
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• Build a composite interaction adding the existing imported interactions, system interactions,
or both. You can add up to 15 interactions to form a composite interaction.

• Playback and evaluate the different adhoc interactions.

• Use the information to create a context from a series of interactions of a particular customer
with possibly different employees of an organization.

• Add comments to an adhoc interaction if the evaluator wants to provide important information
to another evaluator or reviewer.

• Upload an adhoc interaction in WAV, MP4, and M4a formats.

• Use existing tags or create one to apply to an adhoc interaction. Using tags, evaluators can
restrict specific actions on interactions such as downloading or mailing of interactions.

You can create, edit, and delete adhoc interactions only if you have the permission to manage
adhoc interactions. For more information about permissions and privileges, contact your system
administrator.

Viewing adhoc interactions
Procedure

1. Click Interactions > Adhoc Interactions.

2. In the View list, click the view that you want to filter.

The Adhoc Interactions page displays the details of each interaction for the selected view.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

8. (Optional) To edit an existing adhoc interaction, click Edit.
9. (Optional) To delete an existing adhoc interaction, click Delete.

You cannot delete an interaction when:

• A new evaluation task is associated with the interaction

• An evaluation is in progress or is complete for the interaction

Managing adhoc interactions

October 2019 Using Avaya Workforce Optimization Select 89
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


• An appeal is in progress for the interaction

• A calibration task is in progress for the interaction

Adhoc Interactions field descriptions
Name Description
Employee The name of the employee who handled the interaction.
Reporting to The name of the employee to whom the employee who handled the

interaction reports to.
Transaction Date The date on which the interaction took place
Source Type The source of the interaction.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

The default option is Imported.
Interaction ended by The employee who ended the interaction. The options are:

• Agent

• Customer
UCID The unique tag assigned to a call. Universal Call ID (UCID) provides a

way to track calls across multiple communication servers and Voice
Response Units.

Interaction ID The unique ID of the interaction.

Button Description
Edit To edit an adhoc interaction details.
Delete To delete an adhoc interaction.

If you delete a composite interaction, the evaluations associated with the
interaction remain intact. Deleting the interaction does not impact the
child interactions and the respective transactions.

You cannot delete an interaction when:

• A new evaluation task is associated with the interaction

• An evaluation is in progress or is complete for the interaction

• An appeal is in progress for the interaction

• A calibration task is in progress for the interaction

Managing recorded interactions

October 2019 Using Avaya Workforce Optimization Select 90
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Adding a view
About this task
Use the view to search for interactions based on the filters you specify.
By default, the AWFOS Default view comes with a set of pre defined filters configured by the
system administrator. You cannot modify the filters on the AWFOS Default view. You can also save
a view as an adhoc report.

Note:

The AWFOS Default view consists of predefined filters configured by your system administrator.
You cannot modify the filters on this view.

Procedure
1. Click Interactions > Adhoc Interactions.

2. To create a new view that match your required criteria, click Add .

Avaya Workforce Optimization Select displays the Create View page where you can define
the filter criteria and save the view.

3. On the Create View page, do the following:

a. Type the name and description of the view.

b. In Field, select the filter in which you want to apply the filter.

c. In Operator, select the operator for the filter.

d. In Value, enter the value that the records must match.

e. In Share, select with whom you want to share the view.

4. Click Save & Close.

Create View field descriptions
View

Name Description
Name The name of the view.

This field is mandatory.
Default The option to display the selected view as the default. You can set a View

as default if you want to see a certain set of interactions each time you
login.

Description The description that helps to understand the reason for creating a view.
Filter The filter criteria used to search the interactions.
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Name Description
Display Fields The columns displayed in the search results.

You can move or remove the fields in the Available Fields screen to the
Selected Fields screen while adding a view. The arrows next to the
Selected Fields allows the user to rearrange the order of the selected
fields.

Share The option to share the view with selected users, with everyone, or save
it as private.
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Filter

Name Description
Field The parameters used to filter the search results. The options are:

• Role

• Agent ID

• Extension

• Archived

• Called Party

• Calling Party

• End Time

• Interaction Status

• Direction

• Commented

• Department

• Duration

• Employee

• Employee Status

• Evaluated

• Flagged for QA

• Groups

• Interactions ID

• Interaction Comments

• Interaction Tags

• Interaction Type

• Organization Unit

• Queue

• Screen Captures

• Site

• Source Type

• Reporting to

• Tagged

• Tenure (In Weeks)

• Transaction Date
Table continues…
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Name Description
• UCID

• Variables 1–10

• Interaction ended by
Operator The operator used to specify the search criteria. The options are:

• Equals To

• Not Equal To

• Contains

• Does not contain

• Starts With

• Does not Start With

• Ends With

• Does not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between
Value The value specified in the search query that is used to match the records.

You can view the list of interactions that match the value in this list.

Fields

Name Description
Role To search for interactions of employees with the specified designation or

role.
Agent ID To search for interactions of employees with the specified agent or

network ID.
Extension To search for interactions by the extension number of the employee.
Archived To search for interactions that are archived.

The options to filter interactions based on archiving from the Value field
are:

• Yes: To filter the interactions that were archived.

• No: To filter the interactions that were not archived.
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Name Description
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

End Time To search for interactions based on a specific end time.
Interaction Status To search for interactions based on the recording status of the interaction.

The options are:

• NoRTP: Interactions that do not have any voice streams or RTP.

• Connected: Interactions with voice streams or RTP.

• Unknown: Non voice interactions.
Direction To search for interactions based on the interaction direction. The options

are:

• All

• Inbound

• Outbound
Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Department To search for interactions of employees who belong to the specified

department.
Duration To search for interactions by the duration specified in the hh:mm:ss

format.
Employee To search for interactions based on the employees that you have access

to.
Employee Status To search for interactions by the status of the employee attending to the

interaction. The options are:

• Active

• Inactive
Evaluated To search for evaluated interactions.
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Name Description
Flagged for QA To search for interactions that are flagged for QA.

The options to filter interactions based on flagging from the Value field
are:

• Yes: To filter the interactions that were flagged for QA.

• No: To filter the interactions that were not flagged for QA.
Groups To search for interactions of employees belonging to the specified group.
Interactions ID To search for interactions based on the interaction ID.
Interaction Comments To search for interactions based on specific comments provided by

employees.
Interaction Tags To search for interactions based on the specific tags used for association.
Interaction Type To search for interactions based on the type of interaction.
Organization Unit To search for interactions based on the name of the organizational unit.

Use the available operators to define your search criteria.

For example, when you use the Excludes operator and enter the name
of the organizational unit, a specific organizational unit is removed from
the search.

Queue To search for interactions by the queue that the interaction is associated
with.

Screen Captures To search for interactions with screens.
Site To search for the interactions of employees belonging to the specified

site.
Source Type To search for interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Reporting To To search for interactions based on the name of the supervisor.

For example, to search for interactions monitored by a specific
supervisor, use the Contains operator and specify the supervisor name.
The search results display the interactions by all employees assigned
under the selected supervisor.
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Name Description
Tagged To search for tagged interactions.

The options to filter interactions based on tags from the Value field are:

• Yes: To filter the interactions that were tagged.

• No: To filter the interactions that were not tagged.
Tenure (In Weeks) To search for interactions based on the tenure of the employee in weeks.
Transaction Date To search for interactions based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

You can also search for interactions for a specific date range.
UCID To search for interactions based on the universal call ID. This ID remains

the same even when a call is transferred to another agent or called party.
Custom Variables To search for interactions based on custom variables defined for your

business.
Interaction ended by To search for interactions based on who ended a interaction. The options

are:

• Agent

• Customer

Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Ends With To search for interactions that ends with a specified value.
Does not End With To search for interactions that does not end with a specified value.
Less Than To search for interactions that have a value less than the specified value.
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Name Description
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Display Fields

Name Description
Role The designation of the employee in the organization.
Agent ID The ID that the agent uses to log in to the phone. If you configure screen

captures, the screen captures are recorded against the agent ID.
Extension The extension number of the employee on which the interaction is being

handled.
Archived The option to indicate if the interaction is archived.
Called Party The contact number of the called party.
Calling Party The contact number of the called party.
End Time The end time of the interaction.
Interaction Status The option to indicate the status of an interaction. The options are:

• Active

• Inactive
Direction The directions of the interaction.
Department The name of the department that the employee belongs to.
Duration The duration of the interaction in the hh:mm:ss format.
Employee Status The status of the employee attending to the interaction. The options are:

The options are:

• Active

• Inactive
Evaluated The option to indicate if an interaction is already evaluated.
Flagged for QA The option to indicate if an interaction is selected for quality analysis.
Groups The name of the group that the employee belongs to.
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Name Description
Interaction Type The type of channel on which the interaction is delivered. The options

are:

• Voice

• Non Voice

• Email

• SMS

• Chat
Organization Unit The name of the organization unit that the employee belongs to.
Queue The queue that the interaction is associated with.
Screen Captures The field to indicate whether screen capture of the employee desktop is

enabled for recording.

When it is enabled for recording, the screens get captured for the
interactions.

Site The name of the site that the employee belongs to.
Tagged The option to indicate if an interaction is tagged.
Tenure (In Weeks) The employee’s tenure in the organization in weeks.
Custom Fields The interaction that consists of associated custom fields.

Share

Name Description
Me The option to set the view as private where other users will not be able to

view or use the view.
Selected Groups The option to share the view with specific people or groups.
Everyone The option to share the view with all users of the application.

By sharing the view with a group or with everyone, the system renders
results based on the access with whom the view is shared.

Note:

Users can only view search results and cannot edit the search results.

Button Description
Edit To edit an adhoc interaction details.
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Button Description
Delete To delete an adhoc interaction.

If you delete a composite interaction, the evaluations associated with the
interaction remain intact. Deleting the interaction does not impact the
child interactions and the respective transactions.

You cannot delete an interaction when:

• A new evaluation task is associated with the interaction

• An evaluation is in progress or is complete for the interaction

• An appeal is in progress for the interaction

• A calibration task is in progress for the interaction

Creating an adhoc interaction
Defining an adhoc interaction

About this task
Use this procedure to define the content of an adhoc interaction by specifying the interaction
source, employee association, interaction metadata, and business variables. Note that Avaya
Workforce Optimization Select generates a unique interaction ID when you define and save the
content of the adhoc interaction.
Composite interactions can consist up to 15 related interactions. A related interaction can be
system recorded or externally sourced.

Important:
You cannot create a composite interaction by using another composite interaction.

Before you begin
Get permission to manage adhoc interactions so that you can create, edit, and delete adhoc
interactions.

Procedure
1. Click Interactions > Adhoc Interactions.

2. Click Create Interaction.

3. In Interaction Source, click one of the following:

• External: To import interactions.

• Composite: To create interactions from existing interactions from system interactions,
imported interactions, or a combination of both.

4. Enter the details in all the fields and click one of the following:

• Save: To save the details in the database without adding interaction media.
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• Save & Add another: To save and create another adhoc interaction.

• Save & Evaluate: To save and evaluate the imported interaction immediately.

Next steps
Add interaction media.

Definition field descriptions
Name Description
Interaction Source
External To create an interaction by importing from an external source for

evaluation.
Composite To create an interaction from existing imported and system interactions.

You can create a combination of maximum 15 interactions.
Interaction ID The unique ID that the system automatically generates when you save an

adhoc interaction.
Select an Employee
DP OU To select a data partitioned OU type. The evaluation form is available for

selection when the user evaluates interactions of agents belonging to the
data partitioned OU type.

For example, Business, Client, Customer, or Line of Business.

Note:

This field is available only if you are using a data partitioned environment.

This field is mandatory.
Organization Unit(s) To select an organization unit. The evaluation form is available for

selection when the user evaluates interactions of agents belonging to the
selected Organization Unit.

The options are:

• OU Type

• Organization Units

Note:

This field is available based on the DP OU Type you select in a data
partitioned environment.

Site(s) To select the site to which the employee whose interaction is evaluated
belongs to.

Department(s) To select the department to which the employee whose interaction is
evaluated belongs to.

Group(s) To select the group to which the employee whose interaction is evaluated
belongs to.
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Name Description
Employee To select the employee whose interaction is evaluated from a list of

employees, which is based on the organization unit and group that the
user selects.

Interaction Metadata
Interaction Type To select the channel used for interaction.

The options are:

• Voice

• Non Voice

• Email

• SMS

• Chat

You can also select customized interaction if any custom interaction type
is created in the general settings by your administrator.

Interaction Date To create a historical date that the user deems appropriate based on the
context-specific interaction series between a customer and the
organization.

Important:

• This data does not have to match with the total duration of the related
interaction.

• Do not select the same start time and end time, or else the interaction
duration displays the value as 0.

Start Time To select the start time of the interaction in a date and 24–hour format:
mm:dd:yyyy hh:mm:ss. This option is user specific.

Important:

• This data does not have to match with the total duration of the related
interaction.

• Do not select the same start time and end time, or else the interaction
duration displays the value as 0.

End Time To select the end time of the interaction in a date and 24–hour format:
mm:dd:yyyy hh:mm:ss. This option is user specific.

If you enter a value that is less than the start time value, then the
application calculates the end time on the following day.

Note:

Do not select the same start time and end time, or else the interaction
duration displays the value as 0.

Queue To select the queue that the interaction is associated with.
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Name Description
Interaction Direction To select the interactions based on the direction of the interaction.

The options are:

• All

• Inbound

• Outbound
ID Type To select the interaction based on the type of station.

The options are:

• Agent ID: The ID that the agent uses to log in to the phone. If you
configure screen captures, the screen captures are recorded against
the agent ID.

• Extension: The VoIP phone extension of the employee. In a free seating
environment, the extension can be any free and unique extension
number.

• Port: The dummy recording stations used to record calls in Avaya
Session Border Controller for Enterprise deployments for calls that are
routed through IVRs. You must configure this port number range in SIP
adapter, where Avaya Session Border Controller for Enterprise is
enabled.

• Position ID: The ID that the agent uses to log in to the phone. If you
configure screen capture, the screen captures are recorded against the
position ID. This option is used for Avaya Communication Server 1000
deployment.

• Account Name: The unique name used for non-voice transactions. For
example, the name of the agent.

• SIP URI: The unique identification of an extension on which the agent is
taking calls in URI. For example, name@domain.com

• VDN: An extension number that is used to enable calls to connect to a
vector for processing. The calls are routed to a vector through VDNs.
As part of processing, the calls whose digits match with that of the
VDN, are routed to a specific destination.

• Hunt Group: A grouping of extensions handled by agents to interact.
ID Value To enter the relevant values based on the selected ID Type.
Called Party To select interactions based on the extension number or email ID of the

called party.

You can use any alphanumeric character or symbol.
Calling Party To select interactions by the extension number or email ID of the calling

party.
Tag(s) To add a tag to an adhoc interaction.
Business Variables
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Name Description
Varname The customized fields where an user can enter an option to create an

adhoc interaction.

Icon Name Description
Add To add a new business variable

Defining interaction media for external interactions
About this task
Use this procedure to define media to an adhoc interaction, when you select the source type as
external. Adding media to an adhoc interaction is optional.

Before you begin
Define an adhoc interaction.

Procedure
1. Click Interactions > Adhoc Interactions.

2. In the View list, click the view that contains the interaction to which you want to add an
interaction media.

3. Click the button in the required adhoc interaction row and click Edit.
4. Click Interaction Media.

5. On the Interaction Media page, do the following:

a. In the Transcript/Notes field, enter the details of the media, if any.

b. To import a media file, click Choose File in the Media Import section and select the
file from your local machine.

Composite interactions can consist up to 15 related interactions. A related interaction can
be system recorded or externally sourced.

Important:

You cannot create a composite interaction by using another composite interaction.

6. Click one of the following:

• Save: To save the details of the adhoc interaction.

• Save & Add another: To save and create another adhoc interaction

• Save & Evaluate: To save and evaluate the imported interaction immediately

Next steps
Summarize interaction details.
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Defining interaction media for composite interactions
About this task
Use this procedure to define media for an adhoc interaction and to add system and imported
interactions to a composite interaction. Adding media to an interaction is an optional process.

Before you begin
Define an adhoc interaction.

Procedure
1. Click Interactions > Adhoc Interactions.

2. In the View list, click the view that contains the interaction to which you want to add an
interaction media.

3. Click the button of the required adhoc interaction row and click Edit.
4. Click Interaction Media.

5. On the Interaction Media page, do the following:

a. In the Transcript/Notes field, enter the details of the media, if any.

b. In the Select Interactions section, select the required options, click  icon, and click
Apply.

The Select Interactions section displays a list of interactions based on the selected
filters.

c. Select the checkbox for the row that contains the required interaction.

The Selected Interactions section displays the interaction added to the list in a
sequence. You can drag and drop the selected interactions depending on the
sequence in which you want to play the interaction.

6. Click one of the following:

• Save: To save the details of the adhoc interaction.

• Save & Add another: To save and create another adhoc interaction.

• Save & Evaluate: To save and evaluate the imported interaction immediately.

Next steps
Summarize interaction details.

Interaction Media field descriptions
Name Description
Interaction
Transcript/Notes The notes that you can enter while adding an interaction media to an

adhoc interaction. This field is optional.

Table continues…

Managing adhoc interactions

October 2019 Using Avaya Workforce Optimization Select 105
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Name Description
Selected Interactions
Interaction ID The unique ID of the interaction. This is automatically generated when

an interaction is created.
Employee The name of the employee who handled the interaction.
Transaction Date The date on which the interaction took place.
Duration The duration of the interaction in the hh:mm:ss format.
Called Party The phone number of the called party.
Calling Party The phone number of the calling party.
Select Interaction
Interaction ID The unique ID of the interaction. This ID is automatically generated

when an interaction is created.
Employee The name of the employee who handled the interaction.
Reporting to The name of the supervisor or manager to whom the employee

reports.
Extension The phone number or email ID of the employee who interacted.
Queue The queue that the interaction is associated with.
Direction The direction of the interaction.

The options are:

• Inbound

• Outbound
Screens The field to indicate whether an interaction has screen capture.

The options are:

• Yes

• No
Start Time The start time of the interaction.
Duration The duration of the interaction in the hh:mm:ss format.

Button Description
Add to list To add one or more interactions to the selected interactions for playing.
Apply To filter the interactions based on the available fields.

Icon Name Description
Add Field To add a new field, related operator, and value to a

selected interaction.
Remove Field To remove a field, related operator, and value to a

selected interaction.
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Summarizing interaction details
About this task
Use this procedure to review the details of an adhoc interaction, which is already created and is
available for playback.

Important:
Skipping this procedure does not impact the interaction.

Before you begin
• Define an adhoc interaction.
• Define interaction media for an interaction

Procedure
1. Click Interactions > Adhoc Interactions.

2. In the View list, click the view that contains the interaction to which you want to add an
interaction media.

3. Click the button in the required adhoc interaction row and click Edit.
4. Click Summary.

The Summary page displays the details of the adhoc interaction.

5. If you are satisfied with the entries, click one of the following:

• Save & Close: To save the adhoc interaction on the Adhoc Interactions page.

• Save & Evaluate: To save and evaluate the imported interaction immediately.

Note:

Even if you do not save the interaction, the interaction is saved with the options you
entered earlier in the Definition and Interaction Media pages.

Summary field descriptions
Name Description
Interaction ID The unique ID of the interaction. This ID is automatically generated when

an interaction is created.
Interaction Source The source of the interaction.

The options are:

• External

• Composite
Employee The name of the employee who handled the interaction
Interaction Type The channel used for interaction.
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Name Description
Interaction Date The historical date of the interaction, which the user deems appropriate

based on the context-specific interaction series between a customer and
the organization.

Start Time The start time of the interaction.
End Time The end time of the interaction.
Queue The queue is the hunt group that you are associating with the interaction.
Interaction Direction The direction of the interaction.

The options are:

• Inbound

• Outbound
ID Type The interaction based on the type of station.

The options are:

• Agent ID: The ID that the agent uses to log in to the phone. If you
configure screen captures, the screen captures are recorded against
the agent ID.

• Extension: The VoIP phone extension of the employee. In a free seating
environment, the Extension can be any free and unique extension
number.

• Port: The MAC (media access control) address of the physical device or
phone that the employee uses.

• Position ID: The ID that the agent uses to log in to the phone. If you
configure screen capture, the screen captures are recorded against the
position ID. This option is used for Avaya Communication Server 1000
deployment.

• Account Name: The unique name for non-voice transactions. For
example, the name of the agent.

• SIP URI: The unique identification of an extension on which the agent is
taking calls in URI. For example, name@domain.com

• VDN: An extension number that is used to enable calls to connect to a
vector for processing. The calls are routed to a vector through VDNs.
As part of processing, the calls whose digits match with that of the
VDN, are routed to a specific destination.

• Hunt Group: A grouping of extensions handled by agents to interact.
ID Value The relevant values based on the selected ID Type.
Called Party The phone number of the called party.
Calling Party The phone number of the calling party.
Tags The tag added to an adhoc interaction.
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Name Description
Transcript Notes The notes that you can enter while adding an interaction media to an

adhoc interaction. This field is optional.
Selected Interactions The interactions that are added to a composite interaction. A composite

interaction can be a combination of only system interactions, imported
interactions, or both.

Deleting an adhoc interaction
About this task
Use this procedure to delete an adhoc interaction from the Adhoc Interactions page. However, you
cannot delete an interaction when:

• A new evaluation task is associated with the interaction
• An evaluation is in progress or is complete for the interaction
• An appeal is in progress for the interaction
• A calibration task is in progress for the interaction

Use this procedure also to remove the interaction association with evaluations, calibrations, or
appeals before you delete an adhoc interaction.

Before you begin
• Ensure that a purge rule exists in the application to delete the media files and associated

database records for an adhoc interaction.
• Get the required permissions to manage adhoc interactions for deleting an interaction.

Procedure
1. To delete an adhoc interaction from the Adhoc Interactions page, click the button next to

the required row and click Delete.

2. To delete an interaction that has a new evaluation task associated to it, decline the
corresponding task:

a. Click Evaluate > Evaluations > My Assignments.

b. On the My Assignment page, click the button next to the required row and click
Decline Selected Evaluations.

c. On the Adhoc Interactions page, click the button next to the required row and click
Delete.

3. To delete an interaction that has an evaluation in progress, delete the corresponding
evaluation task:

a. Click Evaluate > Evaluations > Draft Evaluations.

b. On the Draft Evaluations page, click the button next to the required row and click
Delete.
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c. On the Adhoc Interactions page, click the button next to the required row and click
Delete.

4. To delete an interaction that has an evaluation in progress or complete, delete the
corresponding evaluation task:

a. Click Evaluate > Evaluations > View Evaluations.

b. On the View Evaluations page, click the button next to the required row and click
Delete.

c. On the Adhoc Interactions page, click the button next to the required row and click
Delete.

5. To delete an interaction that has an appeal in progress, delete the corresponding
evaluation task:

a. Click Evaluate > Evaluations > Draft Evaluations.

b. On the Draft Evaluations page, click the button next to the required row and click
Delete.

c. On the Adhoc Interactions page, click the button next to the required row and click
Delete.

6. To delete an interaction that has a calibration task in progress, delete the corresponding
calibration task:

a. Click Evaluate > Calibration.

b. On the Calibration page, click the button next to the required row and click Delete.

c. On the Adhoc Interactions page, click the button next to the required row and click
Delete.

Playing adhoc interactions
About this task
During an enquiry, customer dispute, or noncompliance issue, or to evaluate, a supervisor or
manager can listen to an adhoc interaction and view the associated onscreen activity. An adhoc
interaction can be a combination of system interactions, imported interactions, or both.
While listening to an adhoc interaction, the supervisor or manager can:

• Comment or tag an interaction to provide information to the evaluator or reviewer.
• Email an interaction.
• View previous evaluation comments.
• View interaction segments.

Procedure
1. Click Interactions > Playback

The Playback page displays the interactions under the default view.
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2. To playback the corresponding interaction, click the  icon.

Important:

The source type field for the adhoc interactions can be Adhoc-External or Adhoc-
Composite.

The Interaction Details page displays a dummy graph of the interaction in the Audio
section, the interaction details, and the playback controls.

3. On the Interaction Details page, in the recorder panel, click one of the following:

•  icon: To listen to the recorded interaction.

•  icon: To stop the recorded interaction.

•  icon: To stop the playback of a recording and resume from where it stopped.

•  icon: To increase or decrease the speed of the recorded interaction.

•  icon: To open the screencast in a window to view the screens at any point of
evaluation without scrolling the screen.

•  icon: To get screen displays in a new window. This option is helpful when you are
working using multiple display monitors.

•  icon: To play the previous interaction.

•  icon: To play the next interaction.

4. In the Interaction Details tab, view the interaction details.

Interaction Details field descriptions
Note:

For a composite interaction, the interaction details fields refer to the related interaction that is
playing in the screen.

Name Description
Interaction ID The unique ID of the interaction.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Duration The duration of the interaction in the hh:mm:ss format.
Employee Code The employee code of the agent who attended to the interaction.
Employee Name The name of the employee who attended to the interaction.
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Name Description
Extension To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Site The name of the site that the employee belongs to.

The system administrator associates employees working in different
locations to the relevant sites. Supervisors and managers can monitor
interactions of employees based on the Site to which they belong to.

Number of Holds The number of times that the employee put the interaction on hold.
Number of DTMF Keys The number of times the DTMF or Dual Tone Multiple Frequency keys

were pressed by the participants of an interaction. Each number is
associated with an action.

Groups The groups that the supervisor or manager has access to.
Reporting To The name of the supervisor or manager to whom the employee reports.
Queue The queue that the interaction is associated with.
Screen The field to indicate whether the screen capture is enabled for recording.
Transfers The number of times that the employee transferred the interaction.
Agent ID The ID of the agent logged in into the phone.
Called Party The phone number or the email ID of the called party.
Calling Party The phone number or the email ID of the calling party.
Total Hold Time The total duration for which the employee put the interaction on hold in

the hh:mm:ss format.

Hold Duration Details

Name Description
Hold Start Time The start time and date when the employee put the interaction on hold in

a 24-hour format: mm/dd/yyyy hh:mm:ss.
Hold End Time The end time and date when the employee put the interaction on hold in a

24-hour format: mm/dd/yyyy hh:mm:ss.
Hold Duration The duration when the employee put the interaction on hold in a 24-hour

format: hh:mm:ss.
DTMF Key The DTMF key pressed by the participants of the interaction.
Talking to (Agent ID) The ID of the agent logged in into the phone.
Agent Name The name of the agent who attended the interaction.
Extension The extension number of the employee on which the interaction is being

handled..
Dialled to The extension number of the calling party.
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Viewing and playing related interactions
About this task
Use this procedure to view and play the related interactions that are associated with a composite
adhoc interaction. You can also use this option to manage externally sourced interactions.

Before you begin
Get the permission to manage adhoc interactions.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon for the row that contains the required interaction.

Important:

The source type field for the adhoc interaction must be Adhoc-Composite or Adhoc-
External.

The Interaction Details page displays a dummy graph of the interaction in the Audio
section, the related interaction details, and the playback controls.

3. Click Related Interactions (x), where (x) is the number of interactions that form the
composite interaction.

The Related Interactions page displays the details of the interactions that form the
composite interaction and the composite interaction details.

4. Click the  icon in the required row.

Important:

You can play any interaction in any sequence. You can even start playing a new
interaction without finishing another interaction. If you do not intervene, the related
interactions play these interactions in the sequence in which they were added to the
list .

Next steps
Add comments or tags to an adhoc interaction.

Related Interactions field descriptions
Interactions List
The name of this section is the name of the composite adhoc interaction.
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Name Description
Play The option to play the different interactions that form a composite

interaction.
Interactions ID The unique IDs of the child interactions. These IDs are system generated.
Employee The name of the employee whose interaction is evaluated.
Start time The start time of the interaction.
Duration The end time of the interaction.
Called Party The extension number of the called party.
Calling Party The extension number of the calling party.
Source Type The source of the interaction.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Details of the Composite Interaction

Name Description
Interaction ID The unique ID of the interaction. This ID is automatically generated when

an interaction is created.
Start time The start time of the interaction.

This value is the cumulative start date of all the related interactions that
form the composite interaction.

Note:

A composite interaction consists of a series of interactions that might
have taken place across days, weeks, or months with different durations
and possibly different employees. So, when you create a composite
interaction, you cannot enter a specific start time and end time. However,
to maintain consistency and a chronological flow, you must associate the
earliest related interaction start time with the composite interaction. Then
calculate the cumulative value of the series of the related interaction
durations.

Employee The name of the employee who created the composite interaction.

Table continues…
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Name Description
ID Type The interaction based on the type of station.

The options are:

• Agent ID: The ID that the agent uses to log in to the phone. If you
configure screen captures, the screen captures are recorded against
the agent ID.

• Extension: The VoIP phone extension of the employee. In a free seating
environment, the Extension can be any free and unique extension
number.

• Port: The MAC address of the physical device or phone that the
employee uses.

• Position ID: The ID that the agent uses to log in to the phone. If you
configure screen capture, the screen captures are recorded against the
position ID. This option is used for Avaya Communication Server 1000
deployment.

• Account Name: The unique name for non-voice transactions. For
example, the name of the agent.

• SIP URI: The unique identification of an extension on which the agent
takes calls in URI. For example, name@domain.com

• VDN: An extension number that is used to enable calls to connect to a
vector for processing. The calls are routed to a vector through VDNs.
As part of processing, the calls whose digits match with that of the
VDN, are routed to a specific destination.

• Hunt Group: A grouping of extensions handled by agents to interact.
Called Party The contact number of the party that was dialed.
Interaction Type The channel used for interaction.
Tags The tag added to an adhoc interaction.

Adding a tag is an optional process.
Interaction Date The historical date of the interaction, which the user deems appropriate

based on the context-specific interaction series between a customer and
the organization.

Table continues…
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Name Description
End Time The end time of the interaction.

This value is the cumulative end date of all the related interactions that
form the composite interaction.

Note:

A composite interaction consists of a series of interactions that might
have taken place across days, weeks, or months with different durations
and possibly different employees. So, when you create a composite
interaction, you cannot enter a specific start time and end time. However,
to maintain consistency and a chronological flow, you must associate the
earliest related interaction end time with the composite interaction. Then
calculate the cumulative value of the series of the related interaction
durations.

Interaction Direction The direction of the interaction.

The options are:

• Inbound

• Outbound
ID Value The relevant values based on the selected ID Type.
Calling Party The contact number of the party who is dialing.
Queue The skill or hunt group associated with the interaction.

Icon Name Description
Play To play the individual interactions

of a composite interaction.

You can play any interaction in
any sequence. You can play a
new interaction even without
completing the previous
interaction..

Important:

If you do not intervene, the
child interactions play in the
sequence when these
interactions were added to
the list

Evaluating adhoc interactions
About this task
Use this procedure to evaluate an external interaction or a composite interaction. By evaluating,
you can further gauge a series of related interactions between the customer with different
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employees of an organization over a period of time. You can even evaluate an interaction that was
evaluated earlier.

Procedure
1. Click Interactions > Playback.

2. On the View list, click the view you want to filter.

3. To play the adhoc interaction, click the  icon in the interaction row.

4. To evaluate the interaction, click Evaluate Now.

Avaya Workforce Optimization Select displays a blank form name and evaluation type with
the default value as Normal.

5. (Optional) To view the previous evaluations on the interaction, click the Evaluations (x)
tab, where x denotes the number of times an interaction was evaluated.

6. (Optional) To view the details of the evaluation scores for the interaction, click the  icon.

Evaluation field descriptions
Name Description
Form The evaluation form based on which the evaluation is performed.
Evaluation Type The name denoting the type of evaluation. These types indicate the

purpose or category of evaluation.

The options are:

• Normal

• Adhoc

• Training
General Comments The field to enter comments while evaluating an adhoc interaction.

This comment applies to the entire evaluation form.
Criteria The specific criterion that must be used while evaluating an interaction

You can also add one or more child criteria to a parent criterion.

Icon Name Description
- To define how an evaluator can enter comments

after an evaluation against a specific criterion for an
interaction.
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Playing interaction transcript
About this task
Use this procedure to playback interactions that are transcribed from the Speech module.

Procedure
1. Click Interactions > Playback.

2. On the View list, click the view you want to filter.

3. To playback the interaction, click the  icon in the interaction row.

4. On the Interaction Details page, click the Speech tab.

Avaya Workforce Optimization Select displays the interaction transcript.

Interaction transcript field descriptions
Avaya Workforce Optimization Select displays the following interaction transcript with speaker separation
and time stamp if the speech parameter Diarization is set to True in SysAdmin. Click on any of the rows and
the audio graph moves to the corresponding section of the conversation.

Name Description
Speech Search The list of searches and business criteria that

fetched the interaction and which the logged in user
has access to.

The phrases and/or words defined as part of the
search and business criteria that fetched the
interaction are highlighted in the transcript.

Speaker The splitting of audio recordings into individual
speakers.

Start Time The start time of the speaker conversation.
End Time The end time of the speaker conversation.
Text The text conversation or transcript of the speaker.

Note:
Avaya Workforce Optimization Select displays the entire conversation without speaker
separation and time stamp if the speech parameter Diarization is set to False in SysAdmin.

Downloading an adhoc interaction
About this task
Supervisors and managers must use this procedure to download interactions in the WAV, MP4,
MP3, and M4a formats.
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Note:
• You can download only external or imported interactions. You cannot download a

composite interaction because it is only a placeholder with a group of related
interactions.

• You cannot download an interaction that is tagged as Do not download or Do not
download & email.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon next to the interaction that you want to play.

3. On the Interaction Details page, click the  icon.

4. On the Download page, type appropriate comments for the interaction.

5. Click Submit.
6. Click Download.

a. For Google Chrome 72.x, Avaya Workforce Optimization Select opens the file in a
pop-up window from where you can play directly. Click  on the player to download the
file to your local machine and listen in your desired media player.

b. For Internet Explorer 11, Avaya Workforce Optimization Select prompts you to specify
the location where you want to save the file.

Note:

For WAV format audio files, click the download link at the end of the error message
to download and save the file.

c. For Microsoft Edge 42.x, Avaya Workforce Optimization Select opens the file in a pop-
up window from where you can play directly. Right-click  and click Save audio as to
download the file to your local machine and listen in your desired media player.

d. For Mozilla Firefox 68.x, Avaya Workforce Optimization Select opens the file in a pop-
up window from where you can play directly. Right-click  and click Save audio as to
download the file to your local machine and listen in your desired media player.

Note:

For WAV format audio files, Avaya Workforce Optimization Select prompts you to
specify the location where you want to save the file.

Important:

Only those files that are uploaded in the WAV, MP4, MP3, and M4a formats are eligible for
downloading. Note that you can only download the files in the same format in which the
files were uploaded.
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Emailing an adhoc interaction
About this task
You can send an adhoc interaction as an email if you want other users to view or listen to the
interaction. The interaction is sent as a link, and the user must log on to the application to access
the interaction.

Note:
• This option is available even when there is no media attached to an adhoc interaction.
• You cannot send an interaction as an email if it is tagged as Do not email or Do not

download & email.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon next to the interaction that you want to play.

3. On the Interaction Details page, click the  icon.

4. Enter the message, recipient details, and click Send.

Email interaction field descriptions
Name Description
From The email address of the sender.

This field is system populated.
To The email address of the recipient to whom you want to mail the

interaction.
Interaction ID The unique ID of the interaction. This field is system populated.
Subject The subject of the email.
Comments The body of the email.
Agent Name The name of the agent who handled the interaction.
Extension The phone number of the agent who handled the interaction.
Start Time The start time of the interaction in a mm:dd:yyyy hh:mm:ss format.
CC The email address of the employee to whom you want to mail a copy of

the interaction.
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Adding comments to an adhoc interaction
About this task
Supervisors and managers can add comments to an external or composite interaction.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.

3. Click Comments/Tags.

4. In comments, enter a comment.

You can only update or delete the comments that you add. However, if you have access to
the interaction, then you can view all the comments made by others.

5. Click Submit.

You can delete a comment after submitting, but you cannot edit it.

The Comments/Tags page displays the comment on the same page.

Adding tags to an adhoc interaction
About this task
Supervisors can tag an interaction to enforce the following set of predefined actions:

• Never delete the interaction.
• Do not allow download.
• Do not allow download & email.
• Do not allow email.
• Flag for QA.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.

3. Click Comments/Tags.

4. On the Tags list, click the required tag.

5. Click Set.
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Comments/Tags field descriptions
Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.
Actions The option to edit or delete a comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Do not allow download The tag used to specify that the interaction cannot be downloaded.
Do not allow download and
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.

Do not allow email The tag used to specify that the interaction cannot be sent by email.
Flag for QA The tag used to specify that the interaction is flagged for quality analysis.

Viewing previous evaluations
About this task
Use this procedure to view the details of the previous evaluations for an adhoc interaction, if there
are any existing evaluations.

Procedure
1. Click Interactions > Playback.

2. On the Playback page, click the  icon.

3. Click Evaluations (x), where (x) is the number of times an interaction is evaluated.

Evaluations field descriptions
Name Description
Form The evaluation form based on which the evaluation is performed.

Table continues…
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Name Description
Reviewer The name of the employee who evaluated the interaction.

Any employee with appropriate privileges can evaluate an interaction.
Evaluation Type The name denoting the type of evaluation. The type indicates the purpose

or category of evaluation.

The options are:

• Normal

• Adhoc

• Training
Score The score received by the employee during evaluation of the interaction.
Evaluation Date The date on which the evaluation is performed.
Evaluation Modified Date The latest date on which the previous evaluation was modified .
Courses The course that was assigned to the employee based on the previous

evaluation scores.
Quizzes The quiz that was assigned to the employee based on the previous

evaluation scores.

Managing adhoc reports

Adhoc reports overview
Using adhoc reports, a user can access, and generate reports in the following modules of Avaya
Workforce Optimization Select view criteria.

• Interactions

• Evaluate

• Learn

• Coach

Adhoc reports are ideal for users who do not have access to the Reports module or who want to
use the comprehensive view criteria to generate a report.

Each module contains a Reports tab from where you can access the adhoc reports. You can also
access these reports from the Reports module from the Adhoc Reports tab. The adhoc reports
data in any interface is specific to the module in which it is placed. For example, the Reports tab in
the Interaction module contains only those reports that are generated using Interaction View.

Using adhoc reports, you can:

• View the data generated by using Views in the respective modules.
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• Edit the adhoc reports depending on your business needs.

• Select and generate any report and view the reports in the Results screen of the Reports
module.

• Schedule the adhoc reports based on user preferences by providing email options.

• Export the data from the adhoc reports to Excel and PDF formats and print, email, or
download the files for future use.

• Share the reports with selected employees or with everyone.

• Delete and run the reports in the respective modules without navigating to the Reports
module.

Saving a view as an adhoc report
About this task
Use this procedure to save an existing view in the Interactions module as an adhoc report.

Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Interactions > Playback.

Avaya Workforce Optimization Select displays the interactions in the default view.

2. In the View field, click the view that you want to edit and save as an adhoc report.

3. Click Edit.

The system displays the Edit View page where you can make the required changes, if you
want.

4. After making the changes, click Save as Report.

Avaya Workforce Optimization Select displays the Adhoc Reports page.

5. Type the name of the reports, and select the output type that you want to generate the
report.

6. Click Save.

Related links
Adding a view on page 61
Create View field descriptions on page 64
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Viewing adhoc report
About this task
Use this procedure to view the reports generated using the Interactions module views.

Procedure
1. Click Interactions > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, click the report you want to view, which you have saved as an
adhoc report.

Avaya Workforce Optimization Select displays the details of the report. You can download,
email, or print the report.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

Editing an adhoc report
Procedure

1. Click Interactions > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, click the report you want to edit, and click Edit.
3. On the Edit View page, make the required changes, and click Save & Close.
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Emailing an adhoc report
About this task
You can email an adhoc report to other users, but they can view the report in read-only mode. The
report is sent as an attachment in the format in which the view is saved as an adhoc report.

Procedure
1. Click Interactions > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, click the report that you want to send as an email, and click
Email.

3. On the Email Report window, type the name of the recipient, enter your comments, and
click Send.

Downloading an adhoc report
About this task
Supervisors and managers can download adhoc reports in a specified format and save them for
future reference.

Before you begin
Specify the format when saving the view as an adhoc report.

Procedure
1. Click Interactions > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, click the report that you want to download, and click Download.

Avaya Workforce Optimization Select downloads the adhoc reports in the format that you
specified while saving the view. You can save the report on your machine for future use.

Printing an adhoc report
About this task
You can print adhoc reports in the format in which you saved the view as an adhoc report.

Procedure
1. Click Interactions > Reports.

The Reports page displays the list of existing reports.
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2. From the drop-down list, click the report that you want to print, and click Print.

Avaya Workforce Optimization Select displays the adhoc report in the format in which you
saved the view as a report.

3. To get a hard copy of the report, click the  icon in the lower-right corner of the page.

Adhoc reports field descriptions
Name Description
Employee The name of the employee for whom the adhoc report is created.
Reporting to The name of the reporting manager to whom the employee reports.
Start Time The time when the adhoc report is created in a date and 24–hour format:

dd:mm:yyyy hh:mm:ss. For example: 05/02/2017 23:21:03
End Time The time when the adhoc report ends in a date and 24–hour format:

dd:mm:yyyy hh:mm:ss. For example: 05/02/2017 23:21:03
Duration The duration of the interaction in an hh:mm:ss format.
Queue The queue that the adhoc report is associated with.
Organization Units The name of the organization unit that the employee belongs to.
Site The name of the site that the employee belongs to.
Groups The name of the group that the employee belongs to.
Tenure The tenure of the employee in the organization, in weeks.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

No of Holds The number of times that the employee put the interaction on hold.
Transfers The number of times that the employee transferred the interaction.
Total Hold Time The total duration for which the employee put the interaction on hold in

the hh:mm:ss format.
Screen Captures The field to indicate if the interaction has screens captures. The options

are:

• Yes

• No
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Name Description
Var1

Var2

Var3

Var4

Var5

Var6

Var7

Var8

Var9

Var10

The customized fields where an user can enter an option to create an
adhoc report.

Client Name The name of the client. This field is available only when you are using a
data partitioned environment.

Flagged for QA The option to flag an adhoc report for quality analysis.
Evaluated The option to select whether an interactions is evaluated. The options

are:

• Yes

• No
Tagged The option to tag an adhoc report.
Roles The option to select roles for creating an adhoc report. For example:

Agent, Supervisor, and Manager .
Department The option to select departments for creating an adhoc report.
ARCHIVED The option select the interactions that are archived.
Queue Type The option to select the interactions selected in a particular queue.
Interaction ID The unique ID of the interaction.
Interaction Status The recording status of the interaction.
Transfer Type The option that specifies how you transfer a call. The options are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.
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Button Description
Download To download the adhoc report.
Email To mail the adhoc report.
Print To print the adhoc report.

Viewing media downloads
About this task
Use this procedure to view the status of interactions you requested for download.
The Downloads window displays the details of the downloaded interactions and interactions that
are queued for download. You can view details such as file name or record ID, start and end time,
status, and the request date of the downloaded interaction. You can click the Link button to
download the interaction and save it to your local machine.
Interactions with only audio recorded are downloaded in the .WAV and .MP4 format. Interactions
with screen captures and audio are downloaded in the .MP4 format. Audio and screen recordings
are encrypted for security purposes.

Procedure
1. In the top-right corner of the Home page, click the  icon.

2. Click Media Downloads.

The Downloads page displays the details of the requested download.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

8. To view the change in status of the interaction downloads, click Refresh.
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Downloads field descriptions
Name Description
Link The link to download an interaction.
Media Type The format in which the interaction is downloaded. The options are:

• WAV: To download the interaction audio in .WAV format.

• MP4 (Audio Only): To download the interaction audio in .MP4 format.

• MP4 (Audio and Screens): To download the recorded interaction video
and audio in .MP4 format.

Interaction ID The unique ID of the interaction.
Start Time The start time of the interaction download request, specified in a 24–hour

format: hh:mm:ss.
End Time The end time of the interaction download request, specified in a 24–hour

format: hh:mm:ss.
Status The status of the request to download the interaction. The options are:

• New: A download request that is new.

• Queued: A download request that is in queue.

• In Progress: A download request that is in progress.

• Completed: A download request that has completed successfully.

• Failed: A download request that has failed due to some reason.
Requested Time The time at which the interaction download was requested.
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Chapter 6: Evaluating interactions

Evaluate overview
The Evaluate module in Avaya Workforce Optimization Select helps in quality management in a
contact center.
Quality managers can effectively evaluate employees by monitoring their interaction with
customers in the contact center.
The interactions provide valuable information about employee performance such as:

• Customer handling skills
• Sales techniques
• Product and service knowledge
• Technical skills for effective customer service
• Knowledge of corporate process and procedures
• Adherence to policies and rules

With the Evaluate module, you can review and evaluate agent performance.

Evaluation process checklist
This checklist provides the high-level process for creating and managing evaluations.

No. Task Description Notes

1 Build an Evaluation
Form with flexible criteria
and scoring.

Evaluation forms comprise of
criteria, scoring patterns, and
score weightage options.

See Defining an evaluation
form on page 137.
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No. Task Description Notes

2 Set up the Evaluation
Plan.

Evaluation plan is a mechanism
to automate the process of
selecting interactions using
predefined criteria and assigning
interactions to reviewers to
evaluate. See Defining an
evaluation plan on page 156.

3 Evaluate interactions
assigned through the
Evaluation Plan

With Evaluation Forms, you can
evaluate and score interactions.
See Evaluating an interaction on
page 169

4 Manage the workflow of
appeals and
reevaluations.

With Appeals, you can automate
the process of raising, reviewing,
and approving appeals. See 
Appeals workflow on page 151

5 Calibrate evaluations to
ensure all evaluators
provide consistent
scoring and evaluations.

Calibrations allow multiple
evaluators to assess a single
interaction to ensure consistency
in quality. See Calibrating
evaluations on page 209.

6 Generate and download
reports as needed.

With Reports, you can assess
and report on individual, group,
and overall contact center
performance. See Reports on
page 349.

Building an evaluation form

Evaluation form checklist
This checklist provides the high-level process for creating and managing an evaluation form.
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No. Task Reference Notes

1 Create Response Sets
to define scoring
variables for reviewers
and evaluators to score
an employee against an
evaluation criterion.

See Response Sets on
page 133.

2 Build evaluation forms
with flexible criteria and
scoring to track the
quality of an interaction.

See Defining an evaluation
form on page 137.

3 Add header information
to enable the evaluator
to enter additional
information about the
interaction being
evaluated.

See Defining Headers In
An Evaluation Form on
page 139.

4 Add parent and child
criteria to determine the
measures on which the
interaction must be
evaluated.

See Defining criteria for
evaluation on page 140.

5 Define the evaluating
mechanism as weighted
or nonweighted.

See Defining scoring
options on page 143.

Response Sets overview
Response Sets are scoring variables that you can use to measure agent performance against a
criteria. Response sets can range from being a Yes/No/NA or Comply/Does not comply to a
grading scale of 1 to 5. You can choose a response set while building an evaluation form to define
a scoring variable for a criteria.

For example, assume that you have a criteria to measure whether or not an agent greets the
customer. The response set for the criteria can be Yes or No. Hence, depending on the questions
you create for every criteria, you can determine the different response sets you want to add.

When you modify a response set, the changes are reflected in the evaluation form only when you
again pick the response set against a criterion. Else, the previous response set is considered. You
cannot delete a response set if there are evaluations associated to the response set.
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Viewing Response Sets
About this task
Use this procedure to view the list of response sets that you have access to. In the list, you can
view the details of whether a Response Set is used in an evaluation form and in evaluations for
scoring interactions.

Important:

You can add a Response Set or edit and delete an existing Response Set only if you have the
adequate permissions.

Procedure
1. Click Evaluate > Setup > Response Sets.

The Response Sets page displays a list of response sets.

2. View the details of the Response Set in the list.

If the response set is used in an evaluation form, the status is Yes in the Has forms
column.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

8. To edit a response set, click on the desired row.

9. To delete a response set, click Delete.

You can delete a Response Set only if it is not being used in any evaluation forms.

Response Sets field descriptions

Name Description
Response Set The name used to identify the Response Set used in an evaluation form.
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Name Description
Status The field to indicate whether the Response Set is active and available

during evaluations. The options are:

• Active: the Response Set is available when a new form is being built.

• Inactive: the Response Set is unavailable when a new form is being
built.

Description The description of the Response Set.

You can use the option to provide reasons for adding a response set or
important information about the response set you create for future
reference.

Has Evaluations The field used to identify whether there are evaluations performed using
the Response Set. The options are:

• Yes

• No
Has Forms The field used to identify whether the Response Set is used in any

evaluations. The options are:

• Yes

• No

Icon Name Description
Add To add a new Response Set.

Adding a Response Set
Procedure

1. Click Evaluate > Setup > Response Sets.

The Response Sets page displays a list of response sets.

2. On the Response Sets page, click Add.

3. On the Add Response Set page, enter the appropriate details.

4. Click one of the following:

• Save & Add Another: To save the Response Set that you created and add another
response.

• Save & Close: To save the Response Set that you created.

Add Response Set field descriptions

Name Description
Response Set Name The name used to identify the Response Set used in an evaluation form.
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Name Description
Control Type The type of control used to display options in an evaluation form. The

options are:

• Single Select : To create a drop down list of items for the user to
select. Use this option when you have many values, because the
values are collapsed.

• Radio Button: To display options in the form of radio buttons. Use this
option when you have values in small numbers and you want to display
all the options.

Responses The option used to specify the responses to the evaluation criteria
defined in an evaluation form.

You can add more than one responses to the set using spaces and
special characters.

Note that you cannot use the following special characters in between
words in a response: tilt (~), comma (,), hyphen (-), curly brackets ({}),
brackets([]), colon (:), quotation marks ("), Apostrophe ('), backslash (\),
vertical bar (|), semicolon (;), percentage (%), and angle quotes (<>).

Description The description of the Response Set.
Active The option to select the Response Set as active and available when

creating an evaluation form.

Evaluation Forms overview
Evaluation Forms are instruments that you can use to track the quality of an interaction.

Building an evaluation form involves the following tasks:

• Configure the re-evaluation lock-out time to specify the number of days after which the
evaluation cannot be edited. Configure the appeals lock-out time to specify the number of
days, post evaluation, after which the employee cannot raise an appeal.

• Configure options that enable the evaluator to enter additional information about the
interaction being evaluated.

• Enforce the evaluator to feed comments while evaluating an interaction.
• Associate departments, queues, and organization units to an evaluation form. Interactions of

agents belonging to only these associations can be evaluated using the evaluation form.
• Add parent and child criteria to determine the measures on which the interaction must be

evaluated. You can associate a response set (scoring variable) to a criterion. You can set a
response for conditional branching to define if a particular response must trigger additional
questions. You cannot associate scores to the additional questions. However, the responses
to the additional questions facilitate the evaluator in deciding whether to award a bonus or
penalty.

• Define scoring conditions like bonus, penalty, exclude from scores, and not applicable. You
can add a bonus or penalty at the parent criteria level, child criteria level, or at the overall
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evaluation form level. The bonus or penalty will be a part of the overall score that is
calculated for an evaluated interaction. Use the exclude from score option if you do not want
to tie any score to a response. Use the not applicable option to restrict the user from adding a
bonus or penalty to a response.

• Assign courses or quiz to agents based on the response of the evaluator.

• Define the evaluating mechanism as weighted or nonweighted. If you select nonweighted, the
scores achieved at the child criteria level rolls up to the parent criteria. The overall score is a
sum of all scores achieved against the criteria. If you select the weighted option, you must
define weights for every criteria. Weights defined at every criteria node (parent or child) must
sum up to 100. The score achieved at the criteria will be a product of the raw score and the
weight.

Creating an evaluation form
Defining an evaluation form

Procedure
1. Click Evaluate > Setup > Forms.

2. Click Add.

3. Enter the required details in the fields.

You can add the header information in the form only after you enter all the mandatory
fields.

4. Click Save as Draft.

The Evaluation Form page changes automatically to the name of the form and displays the
following message: Definition has been saved successfully.

Next steps
Add header information in the evaluation form.

Definition field descriptions

Name Description
Name The name of the evaluation form.

This field is mandatory.
Help Text The help text that is displayed for the evaluation form.
Re-Evaluation Lockout Time
(Days)

The number of days from the date of first evaluation after which the
interaction cannot be reevaluated using the form.

Appeal Lockout Time (Days) The number of days from the evaluation date after which an appeal
cannot be raised using the form.

General Comments
Mandatory

The field to enter comments while evaluating an interaction.
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Name Description
Default The option to set the evaluation form as default for all evaluations.

Note:

This field is available after you save the form.
Active The option to mark the form as active and available for employee

evaluations.

Note:

This field is available after you save the form.
Department The option to select a department. The evaluation form is available for

selection when the user evaluates interactions of agents belonging to the
Department.

Queue Type The option to select a queue. The evaluation form is available for
selection when the user evaluates interactions of agents belonging to the
Queue.

DP OU Type The option to select a data partitioned OU type. The evaluation form is
available for selection when the user evaluates interactions of agents
belonging to the data partitioned OU type.

For example, Business, Client, Customer, or Line of Business.

Note:

This field is available only if you are using a data partitioned environment.

This field is mandatory.
Organization Units The option to select an organization unit. The evaluation form is available

for selection when the user evaluates interactions of agents belonging to
the selected Organization Unit. The options are:

• OU Type

• Organization Units

Note:

This field is available based on the DP OU Type you select in a data
partitioned environment.

Button Description
Save as Draft To save the evaluation form as a draft in the Forms page.

Icon Name Description
Add Organization Unit To add a new organization unit

Remove Organization Unit To remove an organization unit
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Adding headers in an evaluation form
About this task
Use the header information to capture additional details about the interaction. You can use control
types such as radio button, single select, or text box to predefine how you want to capture the
information.

Before you begin
Define the evaluation form.

Procedure
1. Click Evaluate > Setup > Forms.

2. Click the row of the form for which you want to add the header information.

3. Click the Header Information tab.

4. Click the Edit icon.

5. Click the Add button.

6. On the Evaluation Form page, enter the required details.

7. Click one of the following:

• Save & Add Another: To save the header Information and add another header.

• Save & Close: To save the header information that you created.

Next steps
Define the evaluation form criteria.

Header Information field descriptions

Name Description
Field Name The name of the field in the header of the evaluation form.

This field is mandatory.
Control Type The type of control used to display options in the header of the evaluation

form. The options are:

• Text Box

• Radio Button

• Single Select
Options The option to define values for control type. This option is available for

the radio button and single select control types only. The evaluator can
select from the values that you define while evaluating an interaction.

This field is mandatory.
Display Order The option to set the order in which the options must be displayed.
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Name Description
Active The option to mark the header as active and available for selection in the

evaluation form.
Help Text The help text that describes the evaluation form.
Status The status of the header field. The options are:

• Active

• Inactive

Button Description
Add To add a header section in the evaluation form.
Edit To edit a header section in the evaluation form.
Delete To delete a header section in the evaluation form.

Defining criteria for evaluation
Before you begin

1. Define the evaluation form.
2. Add header information to the form.

Procedure
1. Click Evaluate > Setup > Forms.

2. Click the row of the form for which you want to define the criteria.

3. Click Edit.
4. Click Criteria.

5. To enter the name and description for a parent criterion, click Add Criterion.

The Criteria tab displays the options to add child criterion and responses.

6. To add a child, click Add Child for the corresponding parent criterion.

You can also create multiple parent criteria first and then create one or more child criteria
for each parent criterion.

7. Enter a sub-criteria name and click the  icon.

8. To add a response set, click Add Responses.

9. In the Responses tab, provide information for the following based on which the interaction
is evaluated:

a. In Response Set, click the required response set.

The Response(s) tab displays the options defined for the response set.

b. Select the scoring conditions for each response.

c. Specify a score and a bonus or penalty.

Evaluating interactions

October 2019 Using Avaya Workforce Optimization Select 140
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


d. (Optional) Add conditional branching for a response.

e. Assign a course or quiz for each response.

f. Click Set.

 If a quiz is associated with a course and the assignment is in new or pending state,
then you cannot assign the same quiz to a user.

Important:

You must always click Set while adding a criterion. Otherwise, the criteria and the
responses do not get added to the evaluation form.

10. To define the structure of comments while evaluating, click the Comments tab.

11. Enter your comments and click Submit.
Next steps
Add weightages.

Defining Criteria field descriptions

Name Description
Section The option to group one or more criteria under a category. However, it is

not mandatory to enter a section while adding a criterion.

For example, you might want to group criteria under sections such as
Compliance, Customer Service, and Overall Service.

Criterion The option to define a criterion that can be used to evaluate an
interaction. You can create a criterion and add child criteria to it.

Button Description
Reorder Form To move criteria across or within sections.
Add Criterion To add a criterion. For example, you can add a criterion to check whether

the agent greets the customer before starting a conversation.
Add Child To add one or more child criteria within a parent criterion. You can add

more than one child criterion to a parent. However, you can add only
three levels within the hierarchy. A parent criterion can have a child and
the child criterion can have another child.

Add Responses To add responses and define scoring options for a criteriaon. You can add
responses only to the last node in the hierarchy.

Response(s)

Name Description
Response Set Associate a response set to the criterion. The application populates the

scoring variables defined for the response set.
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Name Description
Response View the responses or scoring variables defined for the response set you

associate with a criterion.
Scoring Conditions Define a scoring condition for a response that the reviewer can select

while evaluating an interaction. The criteria response scores you enter
can contain zero, negative values, or integers.

The options are:

• Not Applicable: Define a score without a bonus or penalty.

• Exclude from Score: Exclude from defining score, bonus, or penalty.

• Bonus Criteria: Define a bonus and score for a response at the criteria
level.

• Bonus Parent Criteria: Define a bonus and score for a response at the
parent criteria level.

• Bonus Form: Define a bonus and score for a response at the form level.

• Penalty Criteria: Define a penalty and score for a response at the
criteria level.

• Penalty Form: Define a penalty and score for a response at the form
level.

Score Enter a score for the response.
Bonus/Penalty Enter the bonus or penalty for the scoring condition you select. The

options are:

• %

• Raw

Note:

You can add bonus and penalty can be added to individual criteria, sub-
criteria, or overall form.

Comments Mandatory Select to force the evaluator to provide comments to a response. You can
predefine a set of standard comments and make it mandatory for the
evaluator to pick one while evaluating the criterion.

Conditional Branching Define additional questions that must be triggered for a response.
However, scores cannot be associated to the additional questions.

After evaluating the conditional questions, the evaluator might reconsider
his response to the criterion that triggered the conditional branching.

Assign Course/Quiz Assign course or quiz to a response. Depending on the response you
select while evaluating, the application assigns the course or quiz
automatically to the employee.

You can assign multiple courses or quizzes to a user.
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Comments

Name Description
Comments Add comments to a criterion. Evaluators use comments to flag important

information or common problems in agent performance against a
response. For example, for a criteria for listening, you can add a
comment Agent interrupted customer if this is a common
problem.

Evaluators can either select from a predefined list of comments or enter
comments .

Description Add a description to a comment. Use this option to provide reasons for
adding a comment.

Default Mark a particular comment as the default. The default comment gets
associated with the criterion by default.

Active Make a comment active so that it becomes available while evaluating an
interaction.

Adding weightages
About this task
Use this procedure to add weightages to a criterion. You can define the evaluating mechanism as:

• Weighted: you must define weights for every criterion. Weights defined at every criterion
node, parent or child, must add up to 100.

• Nonweighted: The scores achieved at the child criterion level roll up to the parent criterion.
The overall score is a sum of all scores achieved against the criterion. The score achieved is
the product of the raw score and the weight.

Before you begin
Do the following:

1. Define the evaluation form.
2. Add header information to the form.
3. Add evaluation criteria to the form

Procedure
1. Click Evaluate > Setup > Forms.

2. Click the button on the row of the form for which you want to add weightages.

3. Click Edit.
4. Click Weightages.

5. Select one of the following Scoring options:

• Non Weighted Scores: If you select this option, click Save as a Draft.
• Weighted Scores: If you select this option, the Weightages page displays the Formula

field.
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6. (Optional) If you select Non Weighted Scores, click Save as a Draft. delete

7. (Optional) If you select Weighted Scores, the Weightages page displays the Formula
field. delete

8. To calculate scores based on weights, do the following :

a. In Formula, enter the formula for calculating the final scores.

You can define the formula only at the parent criteria level. The default formula for
evaluation form weightages is the sum of all the parent criteria.

b. For each criterion and child criterion, specify the weightage as a percentage value.

• The parent criteria scores is the sum of all subcriteria level weighted scores.

• The sum of weighted scores of child criteria rolls up to the parent criteria. To that
sum, the application applies the weight assigned to that parent criterion. Weights
defined at every criteria node, parent or child, must add up to 100.

Next steps
Preview the evaluation form.

Weightages field descriptions

Name Description
Scoring options Define the scoring mechanism. The options are:

• Non Weighted Scores: In this option, the scores achieved at the child
criterion level roll up to the parent criterion. The overall score is a sum
of scores achieved against all the criteria.

• Weighted Scores: In this option, you must define weights for every
criterion. Weights defined at every criterion node, parent or child, must
add up to 100. The score achieved is a product of the raw score and
the weight.

Formula Define the arithmetic formula to calculate the overall score. This option is
available when you select Weighted Scores.

The default formula for evaluation form weightages is the sum of all the
criteria. However, if you add a criterion later, you must manually update
the weightage because the criterion does not get updated automatically.
For example, if the default formula is C1 + C2 and you add C3, the
formula does not change to C1 + C2 + C3.

Previewing the evaluation form
About this task
Use this procedure to review all the sections, criteria and child criteria, the selected scoring
mechanism, and the scores in the evaluation form. The form is displayed in the evaluation form
preview when you evaluate an agent or employee.
To edit the evaluation form, you can go back to the respective screen and modify any section.
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Before you begin
1. Define the evaluation form.
2. Add header information to the form.
3. Add evaluation criteria to the form
4. Assign weights for scoring evaluation criteria.

Procedure
1. Click Evaluate > Setup > Forms.

2. Click the button next to the row of the form for which you want to preview the evaluation
form.

3. Click Edit.
4. To view the details of the evaluation form, click the Preview tab.

5. To validate if the evaluation form is complete and ready to be saved or published, click the
Test Form button.

6. To run the evaluation form, click Publish.

Evaluators can now evaluate by using the form.

Preview field descriptions

Name Description
Definition Preview the evaluation form definition before publishing the form.
Header Information Preview the header information before publishing the form.
Criteria Preview the criteria and the responses before publishing the form.
Weightages Preview the weights defined for all the criteria before publishing the form.
Test Form Validate that the form created is complete.

Button Description
Save as Draft Save the evaluation form in a draft state.

Viewing evaluation forms
About this task
Use the Forms page to view the list of evaluation forms that are Active or saved as Draft.
You can view information such as the user who created the evaluation form, the version of the
evaluation form, the scoring pattern and the department and organization unit associated to the
evaluation form.
To filter evaluation forms, use the sort and filter options in the list.

Procedure
1. Click Evaluate > Setup > Forms

The Forms page displays the list of Evaluation Forms.
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2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. To view the version history of an evaluation form, click the version number in the Version
column.

The Forms page displays the version history of the Evaluation Form in a new window.

8. To view the details of an evaluation form, click the  icon in the specific row.

9. To edit an evaluation form, click Edit.

You can only edit an evaluation form that has no evaluations performed by using the form.
If there are evaluations done using an evaluation form, you can edit the form but the
application creates another version and saves the form in draft mode. You have to publish
the revised form to make it active.

10. To delete an evaluation form, click Delete.

You cannot delete an Evaluation Form if there are any evaluations pending based on the
form.

Forms field descriptions
Name Description
Form The name of the evaluation form.
Created By The name of the employee who creates and owns the evaluation form.
OU(s) The organization unit associated with the evaluation form. The evaluation

form is available to evaluate employees belonging to the associated
organization unit.

Department The department associated with the evaluation form. The evaluation form
is available to evaluate employees belonging to the associated
organization unit.

Scoring Pattern The scoring pattern used for evaluating interactions. The options are:

• Weighted

• Non Weighted
Table continues…
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Name Description
Status The field to indicate whether the Evaluation Form is active and available

during evaluations. The options are:

• Active

• Inactive

• Draft
Default The field to indicate if the evaluation form is set as the default. The

options are:

• Yes

• No
Version The number to indicate the different versions of the evaluation form that is

already published.

Version

Name Description
Form The name of the evaluation form.
Created By The name of the employee who owns the evaluation form.
Created Date The date on which the employee created the evaluation form.
Updated By The name of the employee who updated the evaluation form.
Updated Date The date on which the evaluation form was updated.
Version The version number of the evaluation form.

Button Description
Duplicate Form To create a copy of the form. You can clone an evaluation form and reuse

the same with minor changes that meet your requirements.

Evaluation Types overview
As a Supervisor, Reviewer, or a QA specialist, before performing evaluations on interactions, you
might want to perform a test or a mock evaluation. Avaya Workforce Optimization Select gives you
the flexibility to create Evaluation Types to meet such specific requirements. You can create an
Evaluation Type to perform evaluations for either testing or training purposes. You can use the
Evaluation Type feature as a platform to train new hires within your organization.

Typically, interactions assigned through Evaluation Plan, Calibration, or Flagged interactions
automatically default to the Normal evaluation type and cannot be edited. For such evaluations,
the system calculates the agent’s performance based on the ratings and scores given by the
evaluator. However, for the evaluation types you create, you have the option to specify whether or
not you wish to include scores in evaluations. For example, you might want to create a training,
mock, or adhoc evaluation type to train Evaluators. In such cases, you need not include scores to
be considered in reports and notifications.
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Viewing Evaluation Types
About this task
Use the Evaluation Type page to view the list of evaluation types that you have created.
In the list, you can view the details of whether an Evaluation Type is used in an evaluation form
and in evaluations for scoring interactions.
To filter evaluation types, use the sort and filter options in the list.

Procedure
1. Click Evaluate > Setup > Evaluation Type.

The Evaluation Type page displays the list of evaluations.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. To edit an evaluation type, click the View (  ) icon in the desired row.

8. To delete an evaluation type, click Delete.

You cannot edit or delete an evaluation type that has evaluations associated with it.

Evaluation Type field descriptions
Name Description
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

Note:

You cannot inactivate, edit or delete the default evaluation type
named Normal.

Include in Score The field that indicates that scores will be included for evaluations
performed using the evaluation type.
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Name Description
Has Evaluations The field used to identify whether the Evaluation Type is used in any

evaluations. The options are:

• Yes

• No
Status The status of the Evaluation Type. The options are:

• Active

• Inactive
Description The description of the type of evaluation.

Icon Name Description
Add To add a new Evaluation Type.

Adding an Evaluation Type
Procedure

1. Click Evaluate > Setup > Evaluation Type.

The Evaluation Type page displays the list of evaluations.

2. On the Evaluation Type page, click Add.

3. On the Add Evaluation Type page, enter the appropriate details.

4. Click one of the following options:

• Save & Add Another: To save the Evaluation Type that you created and add another
type.

• Save & Close: To save the Evaluation Type that you created.

Add Evaluation Type field descriptions
Name Description
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.
Description The description of the type of evaluation.
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Name Description
Active The option to select the Evaluation Type as active and available when

evaluating interactions.

• Active: Makes the evaluation type available for selection while
evaluating an interaction.

• Inactive: Deactivates an evaluation type. You cannot deactivate the
Normal evaluation type that is active by default. You cannot perform
evaluations against an evaluation type that is inactive. If there are
evaluations tied to an evaluation type prior to deactivating it, you can
continue to view such evaluations.

You can change the status of the evaluation types you create. You will be
prompted with a message if you change the status of an evaluation type
that has evaluations associated.

Evaluation Type Category The option to select the Evaluation Type for scoring interactions. The
options are:

• Include in Score: Selecting this option has the following impacts:

- The system measures agent performance based on the scores rated
by the evaluator.

- You can generate evaluation specific reports.

- You can build an evaluation form such that courses or quizzes are
assigned to an agent based on the Evaluation score.

- You cannot edit this option if there are evaluations performed using
this evaluation type.

• Exclude from Score: Selecting this option has the following impacts:

- The system will not calculate agent performance based on the scores
rated by the evaluator.

- You cannot generate evaluation specific reports.

- Course and quiz assignments to agents will be ignored.

- Agents will not be able to raise an appeal against evaluations that are
excluded from scores.

- Evaluators can calibrate an evaluation even if the evaluation type is
excluded from scores.

- You can delete an evaluation type even if there are evaluations
performed using this evaluation type. The evaluations performed
using this evaluation type will also be deleted.

- You cannot edit this option if there are evaluations performed using
this evaluation type.

- The evaluator evaluating an interaction that is excluded from scores
will be prompted with a message.
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Appeals Workflow overview
The appeals workflow is a mechanism that you can use to automate the appeals process. Using
the appeals workflow, you can define who can appeal, who can review, who can approve, who can
escalate, and who can finally approve.
Every appeal raised moves through specific workflow states before it is finally approved by the
Final Approver who has the permissions to finally approve the appeal.
The permissions in the appeals workflow is defined at the role level. The Reviewer can be the
supervisor who provides feedback on the appeal, while the Approver is the Manager who reviews
and approves the appeal.
For more information on the appeals process, see Appeals on page 211.

Note:

You can create an appeals workflow for each data partitioned OU.
The following table describes the appeal workflow roles and permissions that are assigned based
on role:

Appeal workflow permissions

Appeal Process Role Allowed Actions
Creator Select one or more roles as the creator. Employees belonging to the role

and who have access to the data partitioned organization unit for which
the appeals workflow is created can raise an appeal.

Reviewer Review, Accept, Draw, and Decline

Select only one role as the reviewer. However, you can add multiple
named users or employees outside of the role hierarchy to review an
appeal. Named users comprise of employees who belong to the data
partitioned organization unit for which the appeals workflow is created.
Agents will not be part of the named users list.

The reviewer provides an input to the approver who can consider or
ignore the input.

Approver Accept, Draw, and Decline.

Select either a role or multiple named users as the approver. Employees
belonging to the role and who have access to the data partitioned
organization unit for which the appeals workflow is created can approve
or reject an appeal. The approver is usually the original evaluator or the
roles above in the hierarchy of the evaluator.

Final Approver Final Accept, Final Draw, and Final Decline.

Select either a role or multiple named users as the final approver.
Employees belonging to the role and who have access to the data
partitioned organization unit for which the appeals workflow is created
can do a final approve or a final reject.
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Viewing appeals workflow
About this task
Use the Appeal Workflow screen to view the roles and users defined in the workflow.

Procedure
1. Click Evaluate > Setup > Appeals Workflow.

The Appeals Workflow page displays a list of appeals workflow with names and other
details.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

Appeals Workflow field descriptions
Name Description
Workflow Name The name of the appeal workflow.
Creator The name of the employee who has raised the appeal.
Approver The names of the employees who have access to the organization unit

for which the appeals workflow is created to approve or reject an appeal.
Reviewer The name of the supervisor or manager who reviews the appeal.
Final Approver The name of the employee who approves or rejects the appeal.
Status The status of the appeal. The options are:

• Active

• Inactive

Defining an appeals workflow
Procedure

1. Click Evaluate > Setup > Appeals Workflow.

The Appeals Workflow page displays a list of appeals workflow with names and other
details.
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2. Select the DP OU Type for which you want to create the appeals workflow.

You can create a separate workflow for each data partitioned OU.

3. In Appeal Duration, select the number of days by which the appeals process can be
completed.

However, the system allows the appeal to be completed post the due date too.

Note:

Employees cannot raise fresh appeals against an evaluation when there is an appeal
already in progress.

4. To set the appeal workflow in active status, select Active.

5. In Appeal Process Role, view the appeal roles that are available in the workflow.

6. In Allowed Actions, view the permissions assigned for the roles in appeals process.

7. Select Roles and named users to assign users to the appeal process roles such as
creator, reviewer, approver, and final approver.

Note:

The appeals process roles are configured at role level, and not at employee level.

Appeals workflow field description
Name Description
Business [DP OU Type] The name of the data partitioned OU for which you want to define the

appeals workflow.

This field is mandatory.
Appeal Duration (Days) The number of days within which an appeal must to be completed. There

will be notifications sent 48 hours, 24 hours before the due date and on
the due date. However, the system processes the appeal even after the
due date. Appeals do not become inactive after the duration specified.

This field is mandatory.
Active The option to make the workflow open for the appeals process.
Appeal Process Role The role of the users in the appeals process.
Role The role selected to perform the assigned tasks in the appeals process.
Name User(s) The employees selected to perform the assigned tasks in the appeals

process.
Allowed Actions The set of actions defined for the specific role in the appeals process.
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Evaluation Metric overview
You can create an evaluation metric from the Evaluation Forms definition screen by associating
the metric to a particular criteria. The measures related to the metric get created as evaluations.
You can create multiple metrics for a particular criteria. Whenever a evaluation is performed on
this evaluation form, the score in the measure gets applied to that particular metric. For example,
you might have a evaluation form with the criteria:
Is welcome message prompted?
and you want to find out how many agents are greeting the customers with an welcome message.
You must tag this metric as a criteria and then create a performance scorecard. For those
employees who did not greet the customers, the system displays the score as zero.

Deleting an evaluation metric from the metrics screen disassociates it from the evaluation form.
However, you can delete an evaluation metric only when it is not associated with any scorecard or
metric views. To delete the metric, you must first disassociate it from any scorecard or metric
views where it is used.

Creating an evaluation metric
Procedure

1. Click Evaluate > Setup > Forms.

2. Select the form for which you want to create a metric and click the Edit button.

The system displays the following message: A new version of the form will be
created. Do you want to continue?

3. Click Yes.

4. On the Edit Form page, click Criteria.

5. On the Criteria page, scroll down and select the Create Metric check box.

6. On the Create Metric page, type the metric name.

The measure name is populated automatically with the metric name that you enter.

7. Click Apply.

The system displays the new metric and creates the related evaluation measure .
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Manage evaluations

Planning evaluation
Evaluation Plans

Using Evaluation Plans, you can track agent performance from recorded interactions. Evaluation
plans provide insight into the performance improvements made in your contact center operations.

Using evaluation plan, you can take advantage of the following features:

• Define target number of evaluations a reviewer needs to perform for an agent.

• Define which interactions to choose to evaluate.

• Distribute evaluation plan automatically to QA agents and reviewers to save time and
improve workflow.

• Define evaluation plans by Queue with the ability to create multiple evaluation plans for a
single Queue.

• Execute the evaluation plan for the selected employees and push calls through the
distribution pool.

• Assign interactions to QA reviewers from the distribution pool.

Evaluation plan checklist
This checklist provides the high-level process for creating and managing an evaluation plan.

No. Task Description Notes

1 Define evaluation plans
to set targets for
reviewers to evaluate
agents and interactions.

See Defining an evaluation
plan on page 156.

2 Identify employees
whose interactions must
be picked as part of the
evaluation plan.

See Selecting employees
for evaluation on
page 157.

3 Define the target number
of interactions to be
picked for each selected
employee.

See Setting employee
targets for evaluation on
page 158.

4 Select a specific set of
interactions for
evaluation.

See Selecting interactions
for evaluation on
page 160.
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No. Task Description Notes

5 Assign interactions to
reviewers and
evaluators for scoring.

See Assigning interactions
for evaluation on
page 161.

6 Review and publish the
evaluation plan.

See Reviewing and
publishing an evaluation
plan on page 162.

7 Schedule to execute the
evaluation plan so that
the interactions get
assigned as tasks to the
evaluator.

See Scheduling evaluation
plans on page 163.

Defining an evaluation plan
Procedure

1. Click Evaluate > Management > Plans.

2. Click Create Plan.

3. Enter a name and description for the plan.

4. In Target Period, select the option to define the target period. The options are:

• Weekly
• Monthly

5. (Optional) If you are using a data partitioned environment, select the DP OU Type, for
example, Client for whom you want to create the evaluation plan.

6. In Week Definition, select the start day of the work week.

Note:

By default, the administrator sets the start day of the week. You can change the day to
reflect your work week.

7. Click Save.

Next steps
Select employees whose interactions are picked as part of the evaluation plan.

Definition field descriptions
Name Description
Name The name of the evaluation plan.
Description The description of the evaluation plan.
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Name Description
Target Period The frequency at which interactions are assigned. The options are:

• Weekly

• Monthly
DP OU Type The organization units that are tied to the data partitioned OU type.

For example, Business, Client, Customer, or Line of Business.

Note:

This field is available in a data partitioned environment based on the
settings configured by the system administrator.

Week begins from The start of the work week. The options are:

• Monday to Sunday

• Sunday to Saturday

Note:

This options you see depend on the settings configured by your system
administrator.

Active The status of the evaluation plan.

Note:

This option is available after you save the plan as Draft.

Selecting employees for evaluation
Before you begin
Define an evaluation plan.

About this task
Use this procedure to select employees whose interactions must be selected as a part of the plan.
Selection criteria can be the organizational unit, site, departments, groups, role, reporting to
hierarchy, employee name, tenure of the employee, and custom fields.

Procedure
1. Click Evaluate > Management > Plans.

2. Click on the row of the plan for which you want to select employees for evaluation.

3. Click the Employee Section tab.

4. In the Employee Filter section, specify the search criteria to filter employees.

a. In Field, select the fields by which you want to filter employees to assign to the plan.

b. In Operator, select the operator for the filter.

c. In Value, enter the value that the records must match.
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d.
(Optional) To add multiple filters, click the  icon.

e. Click Apply Filter.

The Employee List section system displays the list of employees that match the
search criteria and are selected in the evaluation plan.

Next steps
Define the evaluation plan target.

Employee Section field descriptions
Name Description
Employee Filter The field to filter and search employees to add to the evaluation plan.

You must specify the following before you apply filters:

• Field: The fields used to filter the search.

• Operator: The operator used in the search criteria.

• Value: The value to match in the search.
Employee List The list that displays the search results for employees.

You can select one or more employees from the list.

Button name Description
Apply Filter To view the list of employees that match your search criteria.

Setting employee targets
Before you begin

• Define an evaluation plan
• Select employee for evaluation

About this task
Use this procedure to specify the target number of interactions that must be picked and assigned
for each of the employees selected.
You can perform the following tasks:

• Specify the interaction distribution to be random or specific. If the interaction distribution is
specific, depending on the target period you define for the plan, you can further specify the
interaction distribution.

• Define the interaction distribution for a given day of the week, if the target period is weekly.
The distribution across the week must not exceed the target.

• Define the interaction distribution for a week of the month, if the target period is monthly. The
distribution across the month must not exceed the target.

• Force the system to meet the distribution target. The system checks for interactions from
previous days of the week or weeks of a month to meet the distribution target.
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Procedure
1. Click Evaluate > Management > Plans.

2. Click on the row of the plan for which you want to select employees for evaluation.

3. Click Target.
4. In Employee, view the total number of employees selected for evaluation.

5. In Target, specify the number of interactions that the plan must assign on a weekly or
monthly basis.

6. Select the method of sampling interactions for evaluation. Choose one of the following
options:

• Random: to randomly select interactions for evaluation.

• Specific: to select a specific number of interactions on a week day in case of a weekly
plan or on a week in case of a monthly plan.

7. Select the following options for specific distribution:

a. In Distribution, select the week day or the week in a month.

b. In & must meet distribution target, you can specify if the weekly or monthly
distribution target must be met at any cost or not.

Next steps
Select interactions for evaluation.

Target field descriptions
Name Description
Employee The total number of employees selected for evaluation as part of the plan.
Target The target number of interactions that are assigned from the selected

plan.
Distribution The method of sampling interactions for evaluation. The options are:

• Random: Interactions are picked randomly when the plan is run during
the defined period.

• Specific: Interactions are assigned based on the distribution target
selected during the defined period.

Distribution On The number of interactions to be evaluated during the work week or
month.
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Name Description
Meet Distribution Target The option to specify if the weekly or monthly distribution target must be

met at any cost or not. The options are:

• Yes: Forces the system to meet the distribution target. For example,
assume you define the target as 5 interactions for each employee, a
weekly distribution of 2 interactions on Monday and 3 on Thursday, and
the option to meet distribution target as Yes. The system picks 2
interactions for the selected employees on Monday. If there are no
interactions for a particular employee on Monday, the system checks for
interactions from the previous days of the week and tries to meet the
distribution target. Similarly, for a monthly distribution, the system
checks for interactions from the previous weeks of the month and tries
to meet the distribution target. If the distribution target is not met due to
unavailability of interactions, the system will not roll over the target to
the next week or month.

• No: Tries to meet the distribution target. If the distribution target is not
met, the system continues to move ahead. The system will not check
for interactions from previous days of a week or weeks of a month.

Reporting to The supervisor to whom the employee reports.
Department The department to which the employee belongs.

Defining the interaction selection criteria
Before you begin

• Define an evaluation plan
• Select employee for evaluation
• Set employee targets

Procedure
1. Click Evaluate > Management > Plans.

2. Double-click the row of the plan for which you want to select employees for evaluation.

3. Click Interaction Selection.

4. To specify the search criteria to filter interactions to be evaluated do the following:

a. In Field, select the fields by which you want to filter interactions to assign to the plan.

b. In Operator, select the operator for the filter.

c. In Value, enter the value that the records must match.

d.

To add multiple filters, click the  icon.

Next steps
Assign interactions to be evaluated.
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Interaction Selection field descriptions
Name Description
Field The fields used to filter the interactions. The options are:

• Archived

• Calling Party

• Called Party

• Channel

• Commented

• DNIS

• Duration

• Hold Duration

• Interaction Tags

• Interaction Type

• No of Holds

• No of Transfers

• Queue

• Screen Captures

• Source Type

• Transcribed

• Transfer Number

• Transfer Type

• Variables 1 to 10

• Interaction Ended By
Operator The operator used in the search criteria.
Value The value to match in the search.

Assigning interactions for evaluation
Before you begin

• Define an evaluation plan
• Select employee for evaluation
• Set employee targets
• Define interaction selection criteria

Procedure
1. Click Evaluate > Management > Plans.
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2. Click on the row of the plan for which you want to select employees for evaluation.

3. Click Assignment.
4. In Default Form, select the default form to be associated with the evaluation plan.

5. In Assignments, select the option to assign interactions to reviewers or send the
interactions to the Distribution Pool.

6. To view a list of eligible reviewers who have access to the interactions and can evaluate
the interactions, click To Reviewers .

Avaya Workforce Optimization Select displays the reviewers, assignments under the
current plan, and the total assignments across all plans.

7. From the list, select the reviewers that you want to assign to evaluate the interactions.

Avaya Workforce Optimization Select displays the interactions in the Evaluate >
Evaluations > My Assignments page of reviewers.

8. To add interactions to the distribution pool, select To Distribution Pool.
Next steps
Preview and publish an evaluation plan.

Assignment field descriptions
Assignment

Name Description
Default Form The evaluation form that is set as the default for the

evaluation plan.
Assignments The total number of calls assigned to each reviewer.
Reviewer The employees who have access to the interactions

of the selected agents and who possess evaluation
permission.

Note:

Only supervisors or managers of the employees
selected to be evaluated are listed.

Number of interactions equally assigned from
this plan

The number of interactions the system equally
assigns to reviewers based on the target you
specify for the evaluation plan.

Total assignments across plans The number of interactions evaluated across
different plans during the last 30 days.

Reviewing and publishing an evaluation plan
Before you begin

• Define an evaluation plan
• Select employee for evaluation
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• Set employee targets
• Define interaction selection criteria
• Assign interactions for evaluation

Procedure
1. Click Evaluate > Management > Plans.

2. Click on the row of the plan for which you want to select employees for evaluation.

3. Click Preview.

4. On the Preview page, view the details of the evaluation plan.

5. To publish the evaluation plan, click Publish.

The plan starts running from the moment you publish the evaluation plan. Depending on
the plan definition, Avaya Workforce Optimization Select automatically searches for
interactions and starts assigning them.

Avaya Workforce Optimization Select displays the evaluation plan in the list on the View
Plans page with Active status.

6. To set the plan for execution, click Publish & Schedule.

From the scheduled data and time, the plan runs everyday and assigns tasks to the
selected reviewers.

Avaya Workforce Optimization Select assigns interactions to reviewers and evaluators
everyday from the scheduled date and time.

Note:

The evaluation plans run according to the time zone configured by the administrator in
Administration > Settings > General Settings.

Preview field descriptions
Name Description
Definition Defines the plan and sets the visibility.
Employee Selection Selects specific agents for evaluation.
Target Defines the targets for agents.
Interaction Selection Selects the interactions to be evaluated.
Assignment Assigns interactions to reviewers or push to the distribution pool for

evaluation.

Scheduling an evaluation plan
About this task
Use this procedure to schedule the evaluation plan to run on a scheduled date and time. The plan
runs everyday at the specified time from the effective date and assigns interactions to the selected
reviewers.
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Procedure
1. Select the saved evaluation plan and navigate to the Preview tab.

2. Click Publish & Schedule to set the plan for execution.

3. Select Run on a Schedule to enable the scheduler.

4. Select or enter the option to schedule the evaluation plan on specific date and time. The
options are:

• Effective Date: Specify a date from when the evaluation plan must run everyday and
assign interactions to the selected reviewers.

• Run At: Specify a particular date and time when the evaluation plan must run.

By default, the date is set to current date. You can schedule the plan to run on any date
beyond the current date.

Note:

The scheduled evaluation plans run according to the time zone configured by the
administrator in Administration > Settings > General Settings.

5. Click Save to save the evaluation plan.

Viewing evaluation plans
About this task
Use this procedure to view the list of evaluation plans along with details like the plan owner,
status, and employees covered.
You can also view the details of the last run date and period during which the plan is run.
On the Plans page, you can perform the following actions:

• Create an evaluation plan.
• Delete an evaluation plan.
• Run a plan instantaneously. You can select the Run now option to run a plan at that moment.

You can also select the Run option to run a plan from a previous date to the current date.
The system picks and assigns interactions to reviewers based on the date range you specify.
In both the cases, the assignment happens just once.

Procedure
1. Click Evaluate > Management > Plans.

The Plans page displays the list of saved and published evaluation plans.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.
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You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. To edit an evaluation plan, click the View (  ) icon on the desired row.

The system displays the evaluation plan in Edit mode allowing you to make changes to the
plan.

8. To delete an evaluation plan, select the evaluation plan you choose to delete, and click
Delete.

9. To run a plan, select the evaluation plan with Active status, and click Run Plan.

You can run the plan on the current date or for a specified period.

Plans field descriptions
Name Description
Plan Name The name of the evaluation plan.
Period The period during which the interactions of agents are evaluated.
Created By The name of the employee who owns the evaluation plan.
Employees Coverage The total number of employees that are selected for evaluation as part of

the plan.
Target The total number of interactions that are to be evaluated as part of the

plan.
Assigned The total number of interactions that are assigned to reviewers for

evaluation as part of the plan.
Run At The date and time when the evaluation plan is scheduled to run.
Last Run The date on which the evaluation plan was last run.
Last Run By The name of the employee by whom the evaluation plan was last run.
Status The status of the evaluation plan.

• Active

• Inactive
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Viewing employee coverage
About this task
Use the Employee Coverage page to view the list of employees covered under different evaluation
plans.
The list displays the quality scores, average handle time, number of evaluations covered, and the
projected coverage in the next 30 days for all the employees that you have access to.
To filter evaluations, use Views and the sort and filter options in the list.

Procedure
1. Click Evaluate > Management > Employees Coverage.

2. To view a list of employees covered across all plans, select the view and click View .

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

Employee Coverage field descriptions
Name Description
Employee The name of the employee who is evaluated.
Average QA Score The average score an employee receives during evaluation.
Avg Handle Time The average duration from the start of the interaction till the end including

the hold time.
Plans The total number of evaluation plans that an employee is covered in.
Tenure (In Wks) The tenure of the employee in the organization, in weeks.

Table continues…
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Name Description
Past Coverage The total number of interactions assigned for evaluations in the last 30

days.

The interactions might have been assigned through different plans,
distribution pool or adhoc evaluations.

Projected Coverage The total number of evaluations targeted for the employee across
different evaluation plans.

The value is the total number of interactions expected to be completed
within the next 30 days.

Viewing QA coverage
About this task
Use the QA Coverage page to view the list of all reviewers who have their evaluations tasks either
in pending or draft state. You can reassign tasks to another reviewer.
To filter evaluations, use Views and the sort and filter options in the list.

Procedure
1. Click Evaluate > Management > QA Coverage.

The QA Coverage page displays a list of evaluations covered for various employees.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. Select the evaluations that you want to reassign to other reviewers from the Re-assign To
drop-down list, and click Assign.

Avaya Workforce Optimization Select displays the evaluation task under the My
Assignments screen for the assigned employee.

A notification is sent to the assigned employee for evaluating the interaction.
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QA Coverage field descriptions
Name Description
Reviewer The name of supervisor or manager who evaluates the interactions.
Employee The name of the employee who is evaluated.
Supervisor The name of the supervisor or manager to whom the employee reports.
Transaction Date The date on which the interaction is recorded.
Transaction Type The type of channel on which the interaction is delivered.
Queue The queue that the interaction is associated with.
Origin The field to indicate the origin of the evaluation. The options are:

• Plan

• Adhoc
Screens The field to indicate if the interaction has screenscapture.
Interaction ID The unique ID of the interaction.
Status The field to indicate the status of the evaluation. The options are:

• New

• Draft

Assigning evaluations from Distribution Pool
About this task
Use this procedure to view and select interactions that you want to assign to reviewers for
evaluation.
To filter interactions, use Views and the sort and filter options in the list.
The interactions in the Distribution Pool are available when:

• A Supervisor flags interactions for QA while monitoring live interactions.
• An evaluator declines evaluations in the My Assignments page.

From the interaction list, you can select and evaluate an interaction that is not assigned to you.

Procedure
1. Click Evaluate > Management > Distribution Pool.

The Distribution Pool page displays the list of available interactions.

2. Click the check box of the row of the interaction that you want to assign from the list and
click the employee to whom you want to assign in the Assign to , and click Assign.

The Assign button automatically gets enabled.
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3. Click Assign.

The system displays the evaluation task in the My Assignments screen for the assigned
employee.

A notification is sent to the assigned employee for evaluating the interaction.

4. To assign an interaction to yourself , click the check box of the row of the interaction that
you want to assign from the list and click Add to My Assignments.

5. To delete an interaction from Distribution Pool, click the check box of the row of the
interaction that you want to assign and click Delete.

You can delete an interaction only if you have the relevant privileges.

Distribution Pool field descriptions
Name Description
Plan Name The name of the plan that is used for evaluating the interactions.
Interaction ID The unique ID of the interaction.
Interaction Date The date on which the interaction takes place.
Supervisor The name of the supervisor or manager to whom the employee reports.
Origin The field to indicate the origin of the evaluation. The options are:

• Plan

• Interaction Playback

• Live Monitoring
Duration The duration of the interaction in the hh:mm:ss format.
Screens The field to indicate if the interaction has screenscaptures.

Evaluate Interactions

Evaluating an interaction
About this task
When you evaluate an interaction, you can score the interaction on each evaluation criteria and
sub-criteria. You can view snippet comments, employee profile and interaction details, and each
segment of the interaction.
You can evaluate an interaction in any of the following ways:

• Evaluate when playing back audio recording from a previously recorded interaction.
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• Evaluate when playing back screen captures in a separate window from a previously
recorded interaction.

• Evaluate an employee’s performance in real time, while listening to the employee while they
are attending to the interaction.

• Evaluate interactions from your My Assignment page.

Procedure
1. To evaluate a recorded interaction:

a. Click Interactions > Playback.

b. On the Playback page, click the  icon next to the recorded interaction that you want
to evaluate.

c. On the Interaction Details page, click Evaluate Now.

2. To evaluate a live interaction:

a. Click Live Monitoring > Monitor.
b. On the Monitor page, click the  icon next to the live interaction that you want to

evaluate.

c. On the Interaction Details page, click Evaluate Now.

3. To evaluate interactions from My Assignments:

a. Click Evaluate > Evaluations > My Assignments (x), where x is the number is
incomplete tasks.

b. Click the  icon in the specific row.

Avaya Workforce Optimization Select displays the interaction in the Recorder panel.

When there is no evaluation form associated for an evaluation, the section below the
Recorder panel appears blank.

c. In Evaluation Type , click any active evaluation type.

d. In Form , click any active evaluation form.

Avaya Workforce Optimization Select displays the blank fields and sections that you
must enter details to complete the evaluation process.

e. In General Comments, enter your comments.

f. (Optional) Select the required header information.

g. Click the required criteria response, enter your criteria comments, and click Save.

You can enter criteria comments depending on how it is defined while creating the
form.

h. To enter snippet comments, click the Snippet Comments tab.

i. To view previous evaluations on the interaction during evaluation, click the Previous
Evaluations (x) tab, where x is the number of times an interaction was evaluated.
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j. To add comments and tags to the interaction during evaluation, click the Comments/
Tags tab, and enter comments and tags.

k. To view the interaction details during evaluation, click the Interaction Details tab.

The Adhoc Evaluations page displays the evaluation details.

Adding evaluation comments
About this task
Evaluators, managers, and supervisors can add comments to an evaluation either while they are
scoring it, or after complete scoring the form. Agents can add comments to an evaluation after the
evaluation is scored.
There are two types of comments that you can add when evaluating an interaction.

• Form comments: General comments that apply to the entire evaluation form.
• Evaluation criteria comments: Comments that apply to a specific criteria that you are

evaluating.
• Snippet comments: Comments that you can add to a particular segment of the interaction.

You can specify the start time, end time, and severity for a snippet comment.

Procedure
1. Click the Comments (  ) icon to the right of the evaluation criteria, and enter comments.

2. Enter your comments in the text area.

You can see the comments after you save the evaluation form.

3. In General Comments , enter overall comments for the evaluation.

Evaluation score calculation
The evaluator or reviewer scores the interaction by selecting appropriate responses against
criteria. The evaluator scores the interaction by responding to the evaluation questions in the form
and analyzing how the employees handle the interaction with customers.
The scoring mechanism can be weighted or nonweighted and the final score is awarded differently
for each scoring mechanism.
The overall score is calculated accordingly:

• For nonweighted evaluations, the scores achieved at the child criteria level roll up to the
parent criteria. The overall score is a sum of all scores achieved for the criteria.

• For weighted evaluations, weights are defined for every parent criteria, criteria and child
criteria. The weights must sum up to 100.
The score achieved at the criteria is a product of the raw score and the weight.

• The bonus or penalty is calculated at the parent or child criteria level, or at the overall
evaluation form level.
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If the evaluation form has an associated bonus or penalty as a percentage of the criteria
score, the overall score is calculated accordingly.

Example
Consider the following evaluation form with criteria and sub-criteria:
Section A: Greeting

• C1: Did the agent or employee greet the customer properly?
• C2: Did the agent or employee identify themselves with the customer?
• C3: Did the agent or employee mention that the interaction is being recorded?

Section B: Customer Service
• C1: Did the agent or employee verify the information provided by the customer?
• C2: Did the agent or employee rush or talk over the customer voice?
• C3: Did the agent or employee show empathy towards the customer?
• C7: How was the overall performance of the employee?

A bonus and penalty is given for evaluation responses 1, 2, and 3 at the parent criteria level. For
response 1 and 3 from the evaluator, a bonus of 2% and 3 points is awarded. For response 2, a
penalty of 1% is awarded.
The evaluation form is a weighted form, with the weightage given to criteria C4 to C7 towards the
overall scores given as 20, 10, 10, and 50.
The employee receives scores 3, 5, 2, 8, 5, 5, 10 for the evaluation criteria C1 to C7 based on the
evaluator scoring the interaction.
The total score is displayed after the evaluator scores each question in the form.
The overall scores are calculated as follows:
Criteria score with bonus and penalty
For bonus and penalty given as percentage, the score is calculated as:
Criteria score = Bonus or penatly percentage/100 added to or subtracted from the actual score
that is awarded..
For bonus and penalty given as raw score, the score is calculated as:
Criteria score = Bonus or penatly raw score plus or minus the actual score that is awarded.

• Bonus score for criteria C1 = 2 percent of 3 = 0.06.
Criteria C1 score = 3 + 0.06 = 3.06

• Penalty score for criteria C2 = 1 percent of 5 = 0.05
Criteria C2 score = 5 - 0.05 = 4.95

• Bonus score for criteria C3 = 1 points.
Criteria C3 score = 2 + 1 = 3

Criteria score based on weightage
For criteria C4 to C7, the score is calculated as score weight x the actual score that is awarded.
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Score weight = weightage percentage/100
Criteria score = weighted percentage/100 x actual score that is awarded.
The scores for criteria are:

• Criteria C4 score = 8 x 0.2 = 1.6
• Criteria C5 score = 5 x 0.1 = 0.5
• Criteria C6 score = 5 x 0.1 = 0.5
• Criteria C7 score = 10 x 0.5 = 5

The overall form score is the total of all criteria (parent) and sub-criteria (child criteria) scores in
each section of the form. 3.06 + 4.95 + 3 + 1.6 + 0.5 + 0.5 + 5 = 18.61 points.
The overall score is rounded off to 19 points.

Acknowledging an evaluation
About this task
After an evaluation is complete, the concerned employee receives a notification about the
evaluation score achieved with comments, if any. It is at the discretion of the employee to accept,
appeal, or take no action for an evaluation.

• Accept the evaluation.
• Appeal for another round of evaluation.

You can raise multiple appeals for the same evaluation. However, if an appeal is in progress,
you cannot simultaneously raise another appeal for the same evaluation.

You can also just view the interaction and take no action. In this scenario, the acceptance status
displays No Action when you view the evaluation.

Note:
These options are available only to those employees whose interactions are already
evaluated.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. Click the view that contains the evaluated interaction.

Avaya Workforce Optimization Select displays a list of interactions that are already
evaluated depending on your view permissions.

3. To view and acknowledge the evaluation score of an interaction, click the  icon of the
desired interaction row.

4. To acknowledge the evaluation scores, do one of the following:

• To accept the evaluation, click Accept.
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The Interaction Details page displays the following pop-up message: Are you sure
you want to Accept the Evaluation. and the option to enter optional
comments.

• To appeal for another round of evaluation, click Appeal.

On the New Appeal page, enter optional comments for the appropriate performance
criteria.

5. Click Save.

Avaya Workforce Optimization Select sends a notification to the employees who are
selected as reviewers in the appeal reviewer role.

Evaluation details field descriptions
Evaluation

Name Description
Form The form based on which the evaluation is performed.
Evaluation Type The type of evaluation. For example, Training, Adhoc, Mock, or Normal.
General Comments The comments that are entered by the evaluator during evaluation.
Section The section that groups the parent criteria and sub-criteria that must be

evaluated.
Criteria The parent criteria and sub-criteria that must be evaluated.

Note:

You can successfully save the evaluation only when you complete
evaluating all the criteria.

Snippet Comments

Name Description
Start Time The start time of a particular segment of the interaction on which the

evaluator provided the comments in hh:mm:ss format.
End Time The end time of a particular segment of the interaction on which the

evaluator provided the comments in hh:mm:ss format.
Severity The degree of severity of the evaluation results for a particular segment

of the interaction on which the evaluator provided the comments.

The options are:

• Low

• Medium

• High
Comments The comments that the evaluator provides for a particular segment of the

interaction that is being evaluated.
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Previous Evaluations

Name Description
Form The form based on which the evaluation is performed.
Reviewer The name of the supervisor or manager who evaluated the interaction.
Evaluation Type The type of evaluation. For example, Training, Adhoc, Mock, or Normal.
Score The score that is received by the employee during evaluation of the

interaction.
Evaluation Date The date on which the evaluation is performed.
Evaluation Modified Date The date on which the evaluation is modified.
Courses The course that is assigned to the employee based on the evaluation

scores.
Quizzes The quiz that is assigned to the employee based on the evaluation

scores.

Comments

Name Description
Date The date on which the comment is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
Comments The text message included as comments to the interaction.
From The name of the employee who adds the comment.

Tags

Name Description
Date The date on which the tag is added. The date is in the mm:dd:yyyy

hh:mm:ss format.
From The name of the employee who adds the tag.
Do not allow download The tag used to specify that the interaction cannot be downloaded.
Do not allow download &
email

The tag used to specify that the interaction cannot be downloaded or sent
by email.

Do not allow email The tag used to specify that the interaction cannot be sent by email.

Interaction Details

Name Description
Interaction ID The unique ID of the interaction.
Start Time The start time of the interaction in a 24–hour format: hh:mm:ss.
End Time The end time of the interaction in a 24–hour format: hh:mm:ss.
Duration The duration of the interaction in the hh:mm:ss format.
Employee Code The employee code of the agent who attended to the interaction.

Table continues…
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Name Description
Employee Name The name of the employee who attended to the interaction.
Extension To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Site The name of the site the employee belongs to.
Groups The name of the group that the employee belongs to.
Reporting To The name of the supervisor or manager to whom the employee reports.
Screen The field to indicate if the interaction has screens captured. The options

are:

• Yes

• No
Transfers The number of times that the employee transferred the interaction.
Agent Id The ID of the agent logged in into the phone.
Called Party The extension number or email ID of the called party.
Calling Party The extension number or email ID of the calling party.
Number of Holds The number of times that the employee put the interaction on hold.
Total Hold Time The total duration for which the employee put the interaction on hold in

the hh:mm:ss format.
Number of DTMF Keys The number of times the DTMF (Dual Tone Multiple Frequency) keys

were pressed by the participants of an interaction. Each number is
associated with an action.

Hold Duration Details

Name Description
Hold Start Time The start time and date when the employee put the interaction on hold in

a 24-hour format: mm/dd/yyyy hh:mm:ss.
Hold End Time The end time and date when the employee put the interaction on hold in a

24-hour format: mm/dd/yyyy hh:mm:ss.
Hold Duration The duration when the employee put the interaction on hold in a 24-hour

format: hh:mm:ss.
DTMF Key The DTMF key pressed by the participants of the interaction.
Talking to (Agent ID) The ID of the agent logged in into the phone.
Agent Name The name of the agent who attended the interaction.
Extension The extension number of the employee on which the interaction is being

handled..
Dialled to The extension number of the calling party.
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Emailing an evaluation
About this task
You can send an evaluated interaction as an email if you want other users to view or give
feedback on the evaluation. The evaluation gets displayed as a link, and the user must log on to
the application to access the evaluation.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. Click on Select for the row to view the evaluations and scroll to the extreme right and click
 icon.

Avaya Workforce Optimization Select displays the Evaluations Details page.

3. In the Evaluations tab, click Email.
4. Enter the message, recipient details, and click Send.

Printing an evaluation
About this task
You can print evaluations that you have access to.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. To view the details of an evaluation, click the View ( ) icon in the desired row.

The system displays the Call Details page.

3. In the Previous Evaluations tab, view the details of evaluations by other users for the same
interaction.

4. In the Evaluations tab, view the details of the current evaluation before printing.

5. In the list next to the Print tab, click Pdf or Excel.

Use the Excel option if you have a lengthy criteria name, because lengthy names get
truncated in the PDF format.

The system prints the evaluation criteria, responses, and scores given to the interaction in
the chosen format. The maximum score to the report and the percentage is rounded off to
2 decimals in both the formats.
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Viewing assignments for evaluations
About this task
Use this procedure to view the interactions that are assigned to you for evaluation.
You can view the evaluations already performed and search for interactions that you want to add
to My Assignments. The system displays the forms that are incomplete in the Draft Evaluations
tab, while the completed evaluation forms are displayed in the View Evaluations tab. To filter
evaluation assignments, use the sort and filter options in the list.
Choose the interaction that you want to evaluate or decline the interactions that are assigned to
you. The evaluation that a user declines moves to the distribution pool and will be available for
assignment. After you complete evaluating the interaction, the status of the evaluation assignment
is displayed as Completed.

Procedure
1. Click Evaluate > Evaluations > My Assignments (x), where x is the number of pending

assignments.

The My Assignments (x) page displays a list of evaluations that are assigned to you.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. In the My Assignments (x) page do the following:

a. To view the details of an interaction to evaluate, click on the View (  ) icon in the
desired row.

b. To view the interaction details and previous evaluations on the interaction, click the
Interaction Details tab.

c. To begin evaluation, on the Evaluate tab, select an evaluation form, evaluation type,
responses for the criteria.

d. To add comments or tag to the interaction, click the Comments/Tags tab.

8. To decline an evaluation assigned to you, select the interaction from the list and click
Decline Selected Evaluations.
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The evaluation moves to the Distribution Pool and is available for assignment.

My Assignments field descriptions
Name Description
Interaction ID The unique ID of the interaction that is evaluated.
Transaction Date The date on which the interaction is recorded.

• Chat

• Email

• Voice
Transaction Type The type of channel in which the interaction is recorded. The options are:

• Voice

• Chat

• Email
Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.
Employee The name of employee whose interaction is evaluated.
Reporting To The name of the supervisor or manager to whom the employee reports.
Queue The queue that the interaction is associated with.
Screens The field to indicate if the interaction has screens captures. The options

are:

• Yes

• No

Button Description
Decline Selected
Evaluations

To decline the selected interactions for evaluations.

Adding a view
About this task
To search for evaluations, you can use the AWFOS Default view, a saved view or a view that has
been shared by other users. If you want a new set of filter criteria, you can create a new view.

Note:

The AWFOS Default view consists of predefined filters configured by your system administrator.
You cannot modify the filters on this view.
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Procedure
1. Click Evaluate > Evaluations > View Evaluations.

The system displays the evaluations in the default view.

2. Click Add.

The system displays the Create View page.

3. On the Create View page, do the following:

a. Type the name and description of the view.

b. In Field, select the filter in which you want to apply the filter.

c. In Operator, select the operator for the filter.

d. In value, enter the value that the records must match.

4. Click Save & Close.

Add View field descriptions
Name Description
Name The name of the view.
Default The option to display the selected view as the default. You can set a view

as default if you want to see a certain set of evaluations each time you
login.

Description The description that helps to understand the reason for creating a view.
Filter The filter criteria used to search the evaluations.
Display Fields The columns displayed in the search results.

You can move or remove the fields in the Available Fields screen to the
Selected Fields screen while adding a view. The arrows next to the
Selected Fields allows the user to rearrange the order of the selected
fields.

Share The option to share the view with selected users, with everyone, or save
it as private.
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Filter

Name Description
Field The parameters used to filter the search results. The options are:

• Role

• Archived

• Acceptance Comments

• Acceptance Date

• Acceptance Status

• Called Party

• Calling Party

• Commented

• Criteria Comments

• Department

• Duration

• Employee

• Employee Status

• Evaluation Date

• Evaluation Form

• Evaluation Modified Date

• Evaluation Type

• General Comments

• Groups

• Include Calibration Evaluations

• Interactions ID

• Interaction Comments

• Interaction Direction

• Interaction Tags

• Max Score

• Organization Unit

• Queue

• Raw Score

• Reviewers

• Screen Captures
Table continues…
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Name Description
• Site

• Snippets

• Source Type

• Reporting to

• Interaction Date

• Interaction Type

• Transfer Number

• Transfer Type

• UCID

• Percentage

• Interaction Ended By
Operator The operator used to specify the search criteria. The options are:

• Equals

• Not Equal To

• Contains

• Does not Contain

• Starts With

• Does not Starts With

• Ends With

• Does not Ends With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between
Value The value specified in the search query that is used to match the records.

You can view the list of interactions that match the value in this list.

Fields

Name Description
Role To search for evaluations of employees with the specified designation or

role.
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Name Description
Archived To search for archived evaluations.
Acceptance Comments To search for evaluations based on the acceptance comments provided

by an employee after accepting an evaluation.
Acceptance Date To search for evaluations based on the date on which the agent accepted

the evaluation comments.
Acceptance Status To search for evaluations based on the status of an evaluated interaction

after it is signed off by an employee.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Criteria Comments To search for evaluations based on criteria comments.
Department To search for evaluations of employees belonging to the specified

department.
Duration To search for evaluations by the duration specified in the hh:mm:ss

format.
Employee To search for evaluations based on the employees that you have access

to.
Employee Status To search for evaluations based on employee status. The options are:

• Active

• Inactive
Evaluation Date To search for evaluations based on the specified evaluation date.
Evaluation Form To search for evaluations based on the name of the evaluation form.
Evaluation Modified Date To search for modified evaluations based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday
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Name Description
Evaluation Type To search for evaluations based on the evaluation type.
General Comments To search for evaluations based on the general comments provided for an

evaluation.
Groups To search for evaluations of employees belonging to the specified group.
Include Calibration
Evaluations

To search for evaluations that have been assigned for calibration.

Interactions ID To search for evaluations based on the interaction ID.
Interaction Comments To search for evaluations based on the interaction comments.
Interaction Direction To search for evaluations based on the interaction direction. The options

are:

• All

• Inbound

• Outbound
Interaction Tags To search for evaluations based on the interaction tags.
Max Score To search for evaluations based on the specified max score.
Organization Unit To search for evaluations based on the organization unit the employee

belongs to.
Queue To search for evaluations of employees belonging to the specified group.
Raw Score To search for evaluations based on the specified raw score.
Reviewers To search for evaluations based on the specified reviewers.
Screen Captures To search for evaluations of interactions with screens.

The options to filter evaluations whether the screens are captured from
the Value field are:

• Yes: To filter the evaluations that have screen captures.

• No: To filter the evaluations that do not have screen captures.
Site To search for evaluations of employees belonging to the specified site.
Snippet To search for a snippet that is a part of an interaction and associate a

comment to that section.

An employee can click on start and stop and provide a comment for that
segment.
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Name Description
Source Type To search for interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Reporting to To search for evaluations based on the name of the supervisor.

For example, to search for interactions monitored by a specific
supervisor, use the Contains operator and specify the supervisor name.
The search results display the interactions by all employees assigned
under the selected supervisor.

Interaction Date To search for evaluations based on the specific interaction dates.

The options available when you select Equals to as the operator are:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

For the operators Not Equal To, Contains, Does not contain, Starts
with, Does not Starts With, Ends With, Does not Ends With, Less
Than, Greater Than, Less Than or Equal, and Greater Than or Equal,
you can select a date.

For the operator Between, you can select a date range.
Interaction Type To search for evaluations based on the interaction type. The options aer:

• All

• Chat

• Email

• Sms
Transfer Number To search for interaction based on the station or the extension number of

the party to whom the interaction is transferred.
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Name Description
Transfer Type To search for interactions based on how you transfer a call. The options

are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

UCID To search for interactions based on the universal call ID. This ID remains
the same even when a call is transferred to another agent or called party.

Percentage To search for an evaluation based on the evaluation percentage.
Interaction ended by To search for interactions based on who ended a interaction. The options

are:

• Agent

• Customer

Operators

Name Description
Equals To search for evaluations that exactly match the specified value.
Not Equal To To search for evaluations that do not match the specified value.
Contains To search for evaluations that have the string or text that match the

specified value.
Does not contain To search for evaluations that do not have the specified value.
Starts with To search for evaluations that start with the specified value.
Does not Starts With To search for evaluations that does not start with the specified value.
Ends With To search for evaluations that ends with the specified value.
Does not Ends With To search for evaluations that does not end with the specified value.
Less Than To search for evaluations that have a value less than the specified value.
Greater Than To search for evaluations that have a value that is greater than the

specified value.
Less Than or Equal To search for evaluations that have a value less than or equal to the

specified value.
Greater Than or Equal To search for evaluations that have a value greater than or equal to the

specified value.
Between To search for evaluations that lie between the specified value.
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Display Fields

Name Description
Role The evaluations of employees with the specified designation or role.
Archived The option to indicate archived evaluations.
Acceptance Comments The option to indicate evaluations based on the acceptance comments

provided by an employee after accepting an evaluation.
Acceptance Date The option to indicate evaluations based on the date on which the agent

accepted the evaluation comments.
Acceptance Status The option to indicate evaluations based on the status of an evaluated

interaction after it is signed off by an employee.
Called Party The extension or email ID of the called party.
Calling Party The extension or email ID of the calling party.
Commented The option to indicate interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Criteria Comments The option to indicate evaluations based on criteria comments.
Department The option to indicate evaluations of employees belonging to the

specified department.
Duration The option to indicate evaluations by the duration specified in the

hh:mm:ss format.
Employee The option to indicate evaluations based on the employees that you have

access to.
Employee Status The option to indicate evaluations based on employee status. The options

are:

• Active

• Inactive
Evaluation Date The option to indicate evaluations based on the specified evaluation date.
Evaluation Form The option to indicate evaluations based on the name of the evaluation

form.
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Name Description
Evaluation Modified Date The option to indicate modified evaluations based on the following

options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday
Evaluation Type The option to indicate evaluations based on the evaluation type.
General Comments The option to indicate evaluations based on the general comments

provided for an evaluation.
Groups The option to indicate evaluations of employees belonging to the

specified group.
Include Calibration
Evaluations

The option to indicate evaluations that have been assigned for calibration.

Interactions ID The option to indicate evaluations based on the interaction ID.
Interaction Comments The option to indicate evaluations based on the interaction comments.
Interaction Direction The option to indicate evaluations based on the interaction direction. The

options are:

• All

• Inbound

• Outbound
Interaction Tags The option to indicate evaluations based on the interaction tags.
Max Score The option to indicate evaluations based on the specified max score.
Organization Unit The option to indicate evaluations based on the organization unit the

employee belongs to.
Queue The option to indicate evaluations of employees belonging to the

specified group.
Raw Score The option to indicate evaluations based on the specified raw score.
Reviewers The option to indicate evaluations based on the specified reviewers.
Screen Captures The option to indicate evaluations of interactions with screens.

The options to filter evaluations whether the screens are captured from
the Value field are:

• Yes: To filter the evaluations that have screen captures.

• No: To filter the evaluations that do not have screen captures.
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Name Description
Site The option to indicate evaluations of employees belonging to the

specified site.
Snippet The option to indicate a snippet that is a part of an interaction and

associate a comment to that section.

An employee can click on start and stop and provide a comment for that
segment.

Source Type The option to indicate interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Reporting to The option to indicate evaluations based on the name of the supervisor.

For example, to search for interactions monitored by a specific
supervisor, use the Contains operator and specify the supervisor name.
The search results display the interactions by all employees assigned
under the selected supervisor.

Interaction Date The option to indicate evaluations based on the specific interaction dates.

The options available when you select Equals to as the operator are:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

For the operators Not Equal To, Contains, Does not contain, Starts
with, Does not Starts With, Ends With, Does not Ends With, Less
Than, Greater Than, Less Than or Equal, and Greater Than or Equal,
you can select a date.

For the operator Between, you can select a date range.
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Name Description
Interaction Type The option to indicate evaluations based on the interaction type. The

options aer:

• All

• Chat

• Email

• Sms
Transfer Number The option to indicate interaction based on the station or the extension

number of the party to whom the interaction is transferred.
Transfer Type The option to indicate interactions based on how you transfer a call. The

options are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

UCID The option to indicate interactions based on the universal call ID. This ID
remains the same even when a call is transferred to another agent or
called party.

Percentage The option to indicate the evaluation percentage.
Interaction ended by The option to indicate interactions based on who ended a interaction. The

options are:

• Agent

• Customer

Share

Name Description
Me The option to set the view as private where other users will not be able to

view or use the view.
Selected Groups The option to share the view with specific people or groups.
Everyone The option to share the view with all users of the application.

By sharing the view with a group or with everyone, the system renders
results based on the access with whom the view is shared.

Note:

Users can only view search results and cannot edit the search results.
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Button Name Description
Save as Report The option to save a view as an adhoc report. You can view this report in

the Reports tab.

Viewing draft evaluations
About this task
Use the Draft Evaluations tab to view the list of evaluations that are work in progress or are
incomplete.
To filter evaluations, use views and the sort and filter options in the list.
You can create a new Evaluation and edit or delete an existing Evaluation if you have adequate
permissions.

Before you begin
Procedure

1. Click Evaluate > Evaluations > Draft Evaluations (x), where x is the number of
evaluations that are started but not complete.

2. Click the View drop down to search for evaluations that match the filter criteria defined in
the view.

The Draft Evaluations page displays a list of evaluations that are in draft state in the
selected view.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

8. To view the details of an evaluation, click the  icon in the specific row.

9. To edit an evaluation, select the interaction and click Edit.

Depending on your privileges, you can edit the evaluation scores, interaction comments,
and tags for the interaction.

10. To delete an evaluation, select the interaction and click Delete.
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Depending on your privileges, you can either delete evaluations assigned to you or all
evaluations.

Draft Evaluations field descriptions
Name Description
Employee The name of employee whose interaction is evaluated.
Acceptance Status The acknowledgement status of an evaluation by an employee. The

options are:

• Accepted: When an employee accepts an evaluation. The status
displays the date and time of the acceptance along with the comments,
if any.

• Appealed: When an employee rejects the evaluation and requests for
another round of evaluation. The status displays the date and time on
which the appeal was raised.

• No action: When an employee only views the evaluation and takes no
action.

Reporting To The name of the supervisor or manager to whom the employee reports.
Evaluation Date The date on which the interaction is evaluated.
Evaluated By The name of the employee who has evaluated the interaction.
Transaction Type The type of channel in which the interaction is recorded. The options are:

• Chat

• Email

• Voice
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.
Form The form based on which the evaluation is performed.
Score The score received by the employee during evaluation.
Queue The queue that the interaction is associated with.
Screens The field to indicate if the interaction has screens captures. The options

are:

• Yes

• No
Interaction ID The unique ID of the interaction that is evaluated.

Button Description
Edit To edit the selected evaluation.
Delete To delete the selected evaluation.
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Viewing evaluations
About this task
Use the View Evaluations page to view the list of evaluations completed by the employees that
you have access to.
To filter evaluations, use views and the sort and filter options in the list.
You can create a new Evaluation and edit or delete an existing Evaluation if you have adequate
permissions.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

2. Click View drop down to search for evaluations that match the filter criteria defined in the
view.

The View Evaluations page displays a list of completed evaluations in the selected view.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

8. To edit an evaluation, select the interaction and click Edit.

Depending on your privileges, you can edit the evaluation scores, interaction comments,
and tags for the interaction.

9. To delete an evaluation, select the interaction and click Delete.

Depending on your privileges, you can either delete evaluations assigned to you or all
evaluations.

10. To view the details of an evaluation, click the  icon in the specific row.

Avaya Workforce Optimization Select displays the details of the evaluated interaction and a
recorder panel for playing back the interaction, where you can click any of the following:

•  icon: To listen to the recorded interaction.

•  icon: To stop the recorded interaction.
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•  icon: To stop the playback of a recording and resume from where it stopped.

•  icon: To increase or decrease the speed of the recorded interaction.

•  icon: To download the interaction.

•  icon: To email the interaction

•  icon: To open the details in a new tab. This is helpful when you are viewing in
multiple monitors.

View evaluations field descriptions
Name Description
Employee The name of employee whose interaction is evaluated.
Acceptance Status The acknowledgement status of an evaluation by an employee. The

options are:

• Accepted: When an employee accepts an evaluation. The status
displays the date and time of the acceptance along with the comments,
if any.

• Appealed: When an employee rejects the evaluation and requests for
another round of evaluation. The status displays the date and time on
which the appeal was raised.

• No action: When an employee only views the evaluation and takes no
action.

Reporting To The name of the supervisor or manager to whom the employee reports.
Evaluation Date The date on which the interaction is evaluated.
Evaluated By The name of the employee who has evaluated the interaction.
Transaction Type The type of channel in which the interaction is recorded. The options are:

• Chat

• Email

• Voice
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.
Form The form based on which the evaluation is performed.
Score The score received by the employee during evaluation.
Queue The queue that the interaction is associated with.
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Name Description
Screens The field to indicate if the interaction has screens captures. The options

are:

• Yes

• No
Interaction ID The unique ID of the interaction that is evaluated.

Button Description
Edit To edit the selected evaluation.
Delete To delete the selected evaluation.

Performing adhoc evaluations
About this task
Use the Adhoc Evaluations page to search and list the interactions that you want to evaluate.
From the interaction list, you can select and evaluate an interaction that is not assigned to you.
To filter evaluations, use the view options and the sort and filter options in the list.

Procedure
1. Click Evaluate > Evaluations > Adhoc Evaluations.

2. Select a view in the view drop down to search for evaluations that match the filter criteria
defined in the view.

The selected view provides the interactions that match the filters.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

8. On the Adhoc Evaluations page, do any of the following:

• To evaluate an interaction, click the  icon in the specific row.
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• To assign an interaction to yourself for evaluation, select an interaction and click Add to
My Assignments.

The Type column in the My Assignments page displays whether the interaction is from
Plans or Adhoc.

You can evaluate the interaction using any evaluation form available for adhoc
evaluations.

Adhoc Evaluations field descriptions
Name Description
Employee The name of employee whose interaction is evaluated.
Reporting To The name of the supervisor or manager to whom the employee reports.
Transaction Date The date on which the interaction is recorded.

The time is available in a mm/dd/yyy hh:mm format.
Transaction Type The type of channel in which the interaction is recorded. The options are:

• Voice

• Chat

• Email
Queues The queue that the interaction is associated with.

The options are:

• Inbound

• Outbound
Screens The field to indicate if the interaction has screens captures. The options

are:

• Yes

• No
Interaction ID The unique ID of the interaction that is evaluated.
DP OU Type The partition of the organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
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Name Description
Transfer Type The option that specifies how you transfer a call. The options are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

Transfer Number The extension or station number of the party to whom the interaction is
transferred.

In case of conference calls, it is the station or the extension number of
another party such as a supervisor or an agent, who’s added in to the
conference.

Source Type The source of the interaction to be evaluated. The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Interaction ended by The party who ended the interaction. The options are:

• Agent

• Customer
UCID Universal Call ID is the unique tag assigned to a call. UCID provides a

way to track calls across multiple communication servers and Voice
Response Units.

Evaluation History

Name Description
Form The form based on which the evaluation is performed.
Evaluated By The name of the employee who has evaluated the interaction.
Status The status of the evaluation. The options are:

• Active

• Inactive
Score The score received by the employee during evaluation.
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Name Description
Evaluation Date The date on which the interaction is evaluated. The date is in the

mm:dd:yyyy format.
Course/Quiz The course or quiz assigned to the employee who is being evaluated.

Button Description
Add to My Assignments To add the selected evaluation to the My Assignments page.

Icon Name Description
Edit Interaction To edit the properties of an

imported interaction.

Adding a view
About this task
To search for adhoc evaluations, you can use the AWFOS Default View, a saved View or a View
that has been shared by other users. If you want a new set of filter criteria, you can create a new
View.

Note:

The AWFOS Default View consists of predefined filters configured by your system administrator.
You cannot modify the filters on this View.

Procedure
1. Click Evaluate > Evaluations > Adhoc Evaluations.

2. To create a new View that match your required criteria, click Add .

Avaya Workforce Optimization Select displays the Create View page where you can define
the filter criteria and save the View.

3. On the Create View page, do the following:

a. Type the name and description of the view.

b. In Field, select the filter in which you want to apply the filter.

c. In Operator, select the operator for the filter.

d. In Value, enter the value that the records must match.

e. In Share, select with whom you want to share the view.

4. Click Save & Close.
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Create View field descriptions
View

Name Description
Name The name of the view.

This field is mandatory.
Default The option to display the selected view as the default. You can set a View

as default if you want to see a certain set of interactions each time you
login.

Description The description that helps to understand the reason for creating a view.
Filter The filter criteria used to search the interactions.
Display Fields The columns displayed in the search results.

You can move or remove the fields in the Available Fields screen to the
Selected Fields screen while adding a view. The arrows next to the
Selected Fields allows the user to rearrange the order of the selected
fields.

Share The option to share the view with selected users, with everyone, or save
it as private.
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Filter

Name Description
Field The parameters used to filter the search results. The options are:

• Role

• Archived

• Audio Codec

• Called Party

• Calling Party

• Direction

• Commented

• Department

• Duration

• Employee

• Employee Status

• Flagged for QA

• Groups

• Hold Duration

• Hunt Group

• Interactions ID

• Interaction Comments

• Interaction Tags

• Interaction Type

• No of holds

• No of Transfers

• Organization Unit

• Queue

• Queue-Queue Type

• Screen Captures

• Site

• Source Type

• Reporting to

• Tagged

• Tenure (In Weeks)
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Name Description
• Transaction Date

• Transaction Type

• Transfer Number

• Transfer Type

• UCID

• VDN

• Interaction ended by
Operator The operator used to specify the search criteria. The options are:

• Equals To

• Not Equal To

• Contains

• Does not contain

• Starts With

• Does not Start With

• Ends With

• Does not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between
Value The value specified in the search query that is used to match the records.

You can view the list of interactions that match the value in this list.

Fields

Name Description
Role To search for interactions of employees with the specified designation or

role.
Agent ID To search for interactions of employees with the specified agent or

network ID.
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Name Description
Archived To search for interactions that are archived.

The options to filter interactions based on archiving from the Value field
are:

• Yes: To filter the interactions that were archived.

• No: To filter the interactions that were not archived.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

Interaction Status To search for interactions based on the recording status of the interaction.
The options are:

• NoRTP: Interactions that do not have any voice streams or RTP.

• Connected: Interactions with voice streams or RTP.

• Unknown: Non voice interactions.
Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Department To search for interactions of employees who belong to the specified

department.
Duration To search for interactions by the duration specified in the hh:mm:ss

format.
Employee To search for interactions based on the employees that you have access

to.
Employee Status To search for interactions by the status of the employee attending to the

interaction. The options are:

• Active

• Inactive
Evaluated To search for evaluated interactions.
Extension To search for interactions by the extension number of the employee.
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Name Description
Flagged for QA To search for interactions that are flagged for QA.

The options to filter interactions based on flagging from the Value field
are:

• Yes: To filter the interactions that were flagged for QA.

• No: To filter the interactions that were not flagged for QA.
Groups To search for interactions of employees belonging to the specified group.
Hold Duration To search for interactions based on the hold duration.
Interactions ID To search for interactions based on the interaction ID.
Interaction Comments To search for interactions based on specific comments provided by

employees.
Interaction Tags To search for interactions based on the specific tags used for association.
Interaction Type To search for interactions based on the type of interaction.
No of Holds To search for interactions with the specified number of holds.
No of Transfers To search for interactions with the specified number of transfers.
Organization Unit To search for interactions based on the name of the organizational unit.

Use the available operators to define your search criteria.

For example, when you use the Excludes operator and enter the name
of the organizational unit, a specific organizational unit is removed from
the search.

Queue To search for interactions by the queue that the interaction is associated
with.

Random Calls To get a view of the interactions randomly.

By default, Avaya Workforce Optimization Select displays the list of
interactions in the same sequence for all employees using a shared view.
If you select this option, Avaya Workforce Optimization Select randomly
displays the same list of interactions.

Screen Captures To search for interactions with screens.
Site To search for the interactions of employees belonging to the specified

site.
Source Type To search for interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.
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Name Description
Reporting To To search for interactions based on the name of the supervisor.

For example, to search for interactions monitored by a specific
supervisor, use the Contains operator and specify the supervisor name.
The search results display the interactions by all employees assigned
under the selected supervisor.

Tagged To search for tagged interactions.

The options to filter interactions based on tags from the Value field are:

• Yes: To filter the interactions that were tagged.

• No: To filter the interactions that were not tagged.
Tenure (In Weeks) To search for interactions based on the tenure of the employee in weeks.
Transaction Date To search for interactions based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

You can also search for interactions for a specific date range.
Language To search for interactions based on a specified language.
Transfer Type To search for interactions based on how you transfer a call. The options

are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

UCID To search for interactions based on the universal call ID. This ID remains
the same even when a call is transferred to another agent or called party.

Custom Variables To search for interactions based on custom variables defined for your
business.
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Name Description
Interaction ended by To search for interactions based on who ended a interaction. The options

are:

• Agent

• Customer

Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Ends With To search for interactions that ends with a specified value.
Does not End With To search for interactions that does not end with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Display Fields

Name Description
Role The designation of the employee in the organization.
Archived The option to indicate if the interaction is archived.
Audio Codec To search for interactions that are compressed using the selected audio

codec.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.
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Name Description
Calling Party To search for interactions by the extension number or email ID of the

calling party. You can use any alphanumeric characters or symbols to
search an interaction.

Direction To direction of the interaction. The options are

• All

• Inbound

• Outbound
Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Department The name of the department that the employee belongs to.
Duration To search for interactions by the duration specified in the hh:mm:ss

format.
Employee To search for interactions based on the employees that you have access

to.
Employee Status To search for interactions by the status of the employee attending to the

interaction. The options are:

• Active

• Inactive
Flagged for QA The option to indicate if an interaction is selected for quality analysis.
Groups The name of the group that the employee belongs to.
Hold Duration The total duration for which the employee put the interaction on hold in

the hh:mm:ss format.
Hunt Group A grouping of extensions handled by agents to interact.
Interaction ID To search for interactions based on the interaction ID.
Interaction Comments To search for interactions based on specific comments provided by

employees.
Interaction Tags To search for interactions based on the specific tags used for association.
No of holds The number of times that the employee put the interaction on hold.
No of Transfers The number of times that the employee transferred the interaction.
Organization Unit The name of the organization unit that the employee belongs to.
Queue To search for interactions by the queue that the interaction is associated

with.
Queue-Queue Type The queue that the interaction is associated with.
Screen Captures To search for interactions with screens.

Table continues…

Evaluating interactions

October 2019 Using Avaya Workforce Optimization Select 206
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Name Description
Site The name of the site that the employee belongs to.
Source Type The source of the interaction. The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Reporting to The supervisor to whom the employee handling the interaction reports to.
Tagged The option to indicate if an interaction is tagged.
Tenure (In Weeks) The employee’s tenure in the organization in weeks.
Transaction Date The date on which the interaction is recorded.
Transaction Type The type of channel on which the interaction is delivered. The options

are:

• Voice

• Chat

• Email
Transfer Number The station or extension number of the party to whom the interaction is

transferred.
Transfer Type The option that specifies how you transfer a call. The options are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

UCID Universal Call ID is the unique tag assigned to a call. UCID provides a
way to track calls across multiple communication servers and Voice
Response Units.

This ID remains the same even when a call is transferred to another
agent or called party.

VDN An extension number that is used to enable calls to connect to a vector
for processing. The calls are routed to a vector through VDNs. As part of
processing, the calls whose digits match with that of the VDN, are routed
to a specific destination.
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Name Description
Interaction ended by The interaction that indicates who ended a interaction.

The options are:

• Agent

• Customer

Share

Name Description
Me The option to set the view as private where other users cannot view or

use the View.
Selected Groups The option to share the view with specific people or groups.
Everyone The option to share the view with all users of the application.

By sharing the view with a group or with everyone, the system renders
results based on the access with whom the view is shared.

Note:

Users can only view search results and cannot edit the search results.

Calibrations overview
To maintain the quality of interactions with customers, supervisors, and Quality Assurance (QA)
reviewers, you can evaluate agents for their performance at regular intervals. However, since
these evaluations involve a level of subjectivity, consistency becomes a challenge.

The Calibration functionality helps different evaluators assess interactions similarly. It enables you
to measure a single transaction among multiple users, to ensure that all managers and
supervisors are using the evaluation form correctly and applying the quality criteria consistently.
Avaya Workforce Optimization Select provides the user with the flexibility to perform calibrations
for non voice interactions such as email and chat transactions

Viewing calibration
About this task
Use the Calibration page to view the evaluations that you have calibrated.
You can edit or delete a calibration from the list.

Procedure
1. Click Evaluate > Calibration.

The Calibration page displays list of all calibrations that you have created.
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2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. To edit a calibration, click the  icon in the desired row.

You can change interactions selected for calibration, reviewers, moderator, evaluation
form, due date, lock on due date, and the option to flag the task as calibration.

8. To delete a calibration, select the interaction that is already calibrated, and click Delete.

A calibration can be deleted, if there are active evaluations or pending tasks associated
with that calibration.

Calibration field descriptions
Name Description
Interaction ID The ID of the interaction that is calibrated.
Assigned Date The date on which the calibration was assigned.
Updated Date The date on which the calibration status is last updated.
Recommended Form The evaluation form based on which the calibration is performed.
Due Date The date by which the calibration needs to be completed.
Status The status of the calibration. The options are:

• Active

• Completed

• In progress

Calibrating evaluations
About this task
Use this procedure to create and manage calibrations for voice based interactions as well as non-
voice interactions, such as email and chat transactions.
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If you have adequate privileges to calibrate an interaction, you can assign the same interaction to
different evaluators. The evaluators can view the calibration tasks and evaluate that interaction.
Once the evaluators complete the evaluation, you can set the final consensus score and
standards for evaluating similar interactions.

Procedure
1. Click Evaluate > Calibration.

2. Click Create Calibration.

3. In the Select Interaction section, select the interactions that you want to assign from
calibration.

4. Filter the interactions you want to assign using Views.

5. In the Select Reviewers section, select the moderators who will evaluate the interaction.

You must select at least one reviewer and one moderator for calibrating the interaction.

6. Select the evaluation form that you want to assign for scoring the interaction.

7. In Due Date, select the date by when the moderators and reviewers must complete the
calibration task.

8. If you do not want evaluators to calibrate post the due date, click the Lock On Due Date
check box.

9. If you want the system to display the evaluation as a Calibration, click the Show it as a
Calibration check box.

Avaya Workforce Optimization Select displays the evaluation as Calibration in the My
Assignments page of the evaluators.

If the user does not select the option, the My Assignments screen displays the evaluation
as a task from Evaluation Plan.

New Calibration field descriptions
Select Interactions

Name Description
View The option that displays the filters used for the

selected view.
Employee The name of the employee who is evaluated.
Reporting To The name of the supervisor or manager the

employee reports to.
Extension The extension of the employee.
Queue The queue to which the interaction belongs.
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Name Description
Direction The direction of the call. The options are:

• Inbound

• Outbound
Screens The field to indicate whether the recording has

screen capture. The options are:

• Yes

• No
Interaction ID The record ID of the interaction.
Start Time The start time of the interaction.
Duration The total duration of the interaction.

Select Reviewers

Name Description
Evaluation Form The form based on which the evaluation is

performed.
Due Date The due by which the calibration needs to be

performed.
Lock On Due Date The date until which the calibration remains active.
Show it as a Calibration The option to mark the evaluation as a calibrated.

Appeals overview

Appeal summary
The Appeals feature in Avaya Workforce Optimization Select allows an employee with appropriate
permissions to appeal against an evaluation. An employee can raise an appeal from the View
Evaluations screen against each criterion.

The appeals process can be summarized as follows:

• An employee who belongs to the creator role defined in the appeals workflow, can raise an
appeal against an evaluation. It is not necessary that only agent can raise an appeal. Any
user who has access to the data partitioned organization unit of the agent can also raise an
appeal. When a user raises an appeal from the View Evaluations screen, the status of the
appeal appears as New. A notification is sent to users who are assigned the reviewer role in
the appeals workflow once an appeal is raised. Users within the hierarchy of the employee
who has handled the interaction for which appeal has been raised are also notified.
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• The next step in the appeals process is to review the appeal. At least one of the employees
defined as the reviewer role in the appeals workflow must review the appeal. Reviewers can
view the list of all the appeals raised on the Appeals page. Reviewers can select options like
Accept, Decline, Draw-score change, Draw-no score change. Post review, the status of the
appeal changes to In Review state. The agents only view the appeal status on the Appeals
page. Agents cannot view the reviewer name or the comments and actions that the reviewer
has taken. A notification is sent to the evaluator who evaluated the interaction after reviewers
provide their feedback. The verdict given by the reviewer is only a recommendation to the
approver. The approver is not bound by the verdict of the reviewer.

• Once reviewed, the appeal needs to be approved. Users who belong to the approver role
defined in the appeals workflow can approve or decline an appeal. The approver can select
options like Accept, Decline, Draw-score change, Draw-no score change.

- If the approver accepts all the criteria against which the appeal is raised, the status of the
appeal changes to Approved.

- If the approver declines all the criteria against which the appeal is raised, the status of the
appeal changes to Declined.

- Even if the approver accepts one criteria and marks the others as Decline, Draw - score
change, Draw - no score change, the status of the appeal changes to Partially Approved.

- Even if the approver selects one criteria as Draw - score change and marks the others as
Decline or Draw - no score change, the status of the appeal changes to Partially Draw -
score change.

- Even if the approver selects one criteria as Draw - no score change and marks the others
as Decline, the status of the appeal changes to Partially Draw - no score change.

• Post approval, the appeals process allows you to escalate the appeal. Only the roles above
the employee, whose interaction was appealed, can escalate. The status of the appeal
changes to Escalated. A notification is sent to users who are assigned the final approver role
in the appeals workflow once an appeal is escalated.

• Post approval, decline, or escalation, the appeal moves to the final approve, final decline, or
final draw state. Users who belong to the final approver role defined in the appeals workflow
can change the state of the appeal to final approve, final decline, or final draw. The final
approver can select options like Accept, Decline, Draw-score change, Draw-no score
change.

- If the final approver accepts all the criteria against which the appeal is raised, the status of
the appeal changes to Final Approved.

- If the final approver declines all the criteria against which the appeal is raised, the status of
the appeal changes to Final Declined.

- Even if the final approver accepts one criteria and marks the others as Decline, Draw -
score change, Draw - no score change, the status of the appeal changes to Partially Final
Approved.

- Even if the final approver selects one criteria as Draw - score change and marks the
others as Decline or Draw - no score change, the status of the appeal changes to Partial
Final Draw - score change.
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- Even if the final approver selects one criteria as Draw - no score change and marks the
others as Decline, the status of the appeal changes to Partial Final Draw - no score
change.

• Post approval or decline, a notification is sent to the agent who handled the interaction and
the supevisor.

If the user who raised the appeal is not satisfied with the reevaluation scores and feedback by the
evaluator, the user can reappeal against the evaluation.

For more information on appeal role definitions, see Appeals Workflow on page 151

Processing appeals
About this task
Depending on the role defined in the appeals workflow, you can process appeals from the Appeals
page. Use this procedure to review, accept, decline, draw, and escalate an appeal request. You
can also track the status of the appeal from the Appeals page.

Procedure
1. Click Evaluate > Appeals.

The Appeals page displays the list of appeals raised.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. To view the appeal details, click the  icon in the desired row.

8. Enter your comments in the Your Comments text box.

9. Select the Approval Status for the appeal.

10. Click Submit to save the changes.

The appeal status changes and appears on the Appeals page.
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Appeals field descriptions
Appeals

Name Description
Interaction ID The unique ID of the interaction being evaluated.
Employee The name of the employee whose performance is being evaluated.
Reporting To The name of the supervisor or manager the employee reports to.
Evaluation Date The date on which the evaluation is performed.
Form The evaluation form based on which the evaluation is performed.
Pre-Appeal Score The score received by the employee during evaluation.
Status The current status of the appeal.

Appeal Details

Name Description
Section The section of the evaluation for which an appeal is raised.
Criteria The evaluation criteria for which an appeal is raised.
Score The score received by the agent for the evaluation criteria.
Agent Comments The comments by the employee who raises the appeal.
Your Comments The comments or feedback you can provide during the review of the

appeal process.
Approval Status The approval status of the appeal that you can select during the review of

the appeal process. The options are:

• Accept: The option that allows the user to modify the scores for the
evaluation.

• Decline

• Escalate

• Draw - score change: The option that allows the user to modify the
scores for the evaluation.

• Draw - no score change

The options you see differ based on your role.

Appeal History

Name Description
Recommendation The name of the reviewer who reviews or evaluates the appeal.
Role The role defined in the appeals workflow who has permissions to review

or finally approve the appeal.
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Name Description
Comment The comments or feedback provided by the reviewers or evaluators

during the review of the appeal.
Recommendation The recommendation provided by the reviewer or evaluator.

Managing adhoc reports

Adhoc reports overview
Using adhoc reports, a user can access, and generate reports in the following modules of Avaya
Workforce Optimization Select view criteria.

• Interactions

• Evaluate

• Learn

• Coach

Adhoc reports are ideal for users who do not have access to the Reports module or who want to
use the comprehensive view criteria to generate a report.

Each module contains a Reports tab from where you can access the adhoc reports. You can also
access these reports from the Reports module from the Adhoc Reports tab. The adhoc reports
data in any interface is specific to the module in which it is placed. For example, the Reports tab in
the Interaction module contains only those reports that are generated using Interaction View.

Using adhoc reports, you can:

• View the data generated by using Views in the respective modules.

• Edit the adhoc reports depending on your business needs.

• Select and generate any report and view the reports in the Results screen of the Reports
module.

• Schedule the adhoc reports based on user preferences by providing email options.

• Export the data from the adhoc reports to Excel and PDF formats and print, email, or
download the files for future use.

• Share the reports with selected employees or with everyone.

• Delete and run the reports in the respective modules without navigating to the Reports
module.
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Saving a view as adhoc report
About this task
Use this procedure to save an existing view in the Evaluate module as an adhoc report. You
cannot edit or save a view if an appeal is in progress against an evaluation view.

Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Evaluate > Evaluations > View Evaluations.

The system displays the evaluations in the default view.

2. In the View field, click the view that you want to edit and save as an adhoc report.

3. Click Edit.

The system displays the Edit View page where you can make the required changes, if you
want.

4. After making the changes, click Save as Report.

Avaya Workforce Optimization Select displays the Adhoc Reports page.

5. Type the name of the reports, and select the output type that you want to generate the
report.

6. Click Save.

Viewing adhoc report
About this task
Use this procedure to view the reports generated using the Evaluate module.

Procedure
1. Click Evaluate > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, click the report you want to view, which you have saved as an
adhoc report.

Avaya Workforce Optimization Select displays the details of the report. You can download,
email, or print the report.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

Evaluating interactions
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4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

Editing an adhoc report
Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Evaluate > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, select the report that you want to edit, and click Edit.
3. On the Edit View page, make the required changes, and click Save & Close.

Emailing an adhoc report
Before you begin
Ensure that a view exists or create a view.

About this task
You can email an adhoc report if you want other users to view it. The report is sent as an
attachment in the format in which the view is saved as an adhoc report.

Procedure
1. Click Evaluate > Reports.

The system displays the list of existing reports.

2. Select the report that you want to send as an email, and click Email.
3. On the Email Report window, type the name of the recipient, and enter your comments.

4. Click Send.
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Downloading an adhoc report
About this task
Use this procedure to download your report in a pdf, excel, or csv format, which depends on the
format that you specify when saving the view as an adhoc report.

Before you begin
Ensure that a view exists or create a view.
Specify the format when saving the view as an adhoc report.

Procedure
1. Click Evaluate > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to download, and click Download.

The system downloads the adhoc reports in the format that you specified while saving the
view.

3. Save the report for future reference.

Printing an adhoc report
About this task
You can print the adhoc reports in the format in which you saved the view as a report.

Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Evaluate > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to print, and click Print.

The system displays the adhoc report in the format in which you saved the view as a
report.

3. (Optional) To get a hard copy of the report, click the  icon in the lower-right corner of the
page.
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Adhoc reports field descriptions
Evaluate Reports

Name Description
Employee The name of the employee for whom the adhoc report is created.
Acceptance Status The status of an evaluated interaction after it is signed off by an

employee. The options are:

• Accepted: When an employee accepts an evaluation. The status
displays the date and time of the acceptance along with the comments,
if any.

• Appealed: When an employee rejects the evaluation and requests for
another round of evaluation. The status displays the date and time on
which the appeal was raised.

• No action: When an employee only views the evaluation and takes no
action.

Interaction ID The unique ID of the interaction that is evaluated.
Transaction Type The type of channel on which the transaction is delivered. The options

are:

• Voice

• Chat

• Email
Queue The queue that the evaluation is associated with.
Form The form based on which the evaluation is performed.
Score The score that the employee receives during the evaluation.
Max Score The cumulative score of the raw scores or the weighted scores.

Note that the bonus score or the penalty score does not get added to the
max possible score. For example: If the maximum score is 100 and
bonus is 5, then the agent scores 105, the percentage is 105%. However
the maximum score is 100. The application does not add bonus or
penalty to the max score.

Evaluated By The name of the employee who evaluated the adhoc report.
Evaluation Date The time when the adhoc report is created in a date and 24–hour format:

dd:mm:yyyy hh:mm:ss. For example: 05/02/2017 23:21:03
Screens The field to indicate if the evaluation has screen captures. The options

are:

• Yes

• No

Table continues…
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Name Description
Acceptance Comments The option for an agent to comment after accepting an evaluation of an

interaction.

This is an optional field.
Acceptance Date The date on which the agent accepted the evaluation comments.
Evaluation Type The type of evaluation. For example, Adhoc, Exclude, Mock, or Normal.
Source Type The source of the interaction. The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Reporting to The name of the reporting manager of the employee.
Transfer Type The option that specifies how you transfer a call. The options are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

UCID Universal Call ID is the unique tag assigned to a call. UCID provides a
way to track calls across multiple communication servers and Voice
Response Units.

Interaction ended by The party who ended the interaction. The options are:

• Agent

• Customer

Button Description
Download To download the adhoc report.
Email To mail the adhoc report.
Print To print the adhoc report.
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Chapter 7: Managing coaching

Coach overview
The Coach module provides an automated framework for building personalized agent training
programs using quality and performance data. Supervisors and managers can provide guidance
and critical feedback to agents who require improvement in specific areas of performance.
Support to define a list of performance attributes and create coaching plans for specific groups or
employees is also available. The alerts and reports in Avaya Workforce Optimization Select
ensure follow-up is done on time.
Using the Coach module, you can:

• Address coaching needs of an agent by identifying areas of focus and define parameters to
specify skills and reasons for coaching.

• Build a coaching plan to define the number of coaching sessions agents need to complete
within a specified period.

• Create task-oriented action plans in the form of coachings and assign them to agents to
improve specific areas. Coachings are usually Instructor Led Training (ILT) sessions that are
tracked in Avaya Workforce Optimization Select. Supervisors and managers can also link
coachings to e-Learning courses and quizzes.

As a result, supervisors can generate relevant summary reports to view a snapshot of all the
accepted and completed coaching assignments in the system.

Manage Coaching

Adding Skills
About this task
Use this procedure to create a list of skills or competencies. Skills are used for selection while
defining a coaching session.

Procedure
1. Click Coach > Parameters.

2. On the Skills page, click Add Skill.
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3. On the Add New Skill page, enter the appropriate details and click one of the following:

• Save & Add Another: To save the skill that you created and add another skill.

• Save & Close: To save the skill that you created.

The Skills page displays the new skill that you created.

Add New Skill field descriptions
Name Description
Skills The unique name of the skill that you are creating.

You can enter up to 100 characters in this field.

This field is mandatory.
Description A brief description of the skill.

You can enter up to 500 characters in this field.
Active The option to select the skill as an active skill.

By default, Active is selected.

Adding Reasons for Coaching
About this task
Use this procedure to create a list of reasons for coaching. Reasons for coaching are used for
selection while defining a coaching session.

Procedure
1. Click Coach > Parameters.

2. Click Reasons for Coaching.

3. On the Reasons for Coaching screen, click Add Reason.

4. On the Add New Reason screen, enter the appropriate details and click one of the
following:

• Save & Add Another: To save the reason that you created and add another reason.

• Save & Close: To save the reason that you created.

Managing coaching
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Add New Reason field descriptions
Name Description
Reason The unique name of the reason that you are creating.

You can enter up to 100 characters in this field.

This field is mandatory.
Description A brief description of the reason.

You can enter up to 500 characters in this field.
Active The option to flag the reason as active and make it available for selection

while creating coachings.

By default, Active is selected.

Coaching Plans

Viewing coaching plans
About this task
Use this procedure to view coaching plans that are used by supervisors to assign employees or
groups of employees a certain number of coaching assignments within a specified period.
Supervisors, managers, or quality analysts can use the coaching plans to plan the number of
coaching assignments that the employees are assigned to.

Procedure
1. Click Coach > Plans.

The Plan page displays the list of coaching plans.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

Coaching Plans

October 2019 Using Avaya Workforce Optimization Select 223
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

Plan field descriptions
Name Description
Coaching Plan The coaching plan that is assigned to the coaching assignment.
Target The number of coaching assignments that the assigned employees are

expected to complete.
Created By The name of the user who created the coaching assignment.
Created On The date in mm/dd/yyyy format on which the coaching assignment was

created.
Updated By The user who has updated the coaching assignment.
Updated On The date on which the coaching assignment was updated. The date is in

the mm:dd:yyyy format.
Status The status of the plan.

The options are:

• Active: You must publish a plan to make it active.

• Inactive: This is the default option.

Creating a coaching plan
About this task
Use this procedure to create coaching plans for employees that you have access to. Use
Coaching plans to assign employees or groups of employees a certain number of coaching
assignments within a specified period.

Procedure
1. Click Coach > Plans.

The Plan page displays the list of coaching plans.

2. Click Create.

3. On the Definition page, enter the appropriate details and click Save.

Avaya Workforce Optimization Select displays the Employee Section page.

4. On the Employee Section page, do the following:

a. To apply the filter that you defined in the employee filter to be assigned to the
coaching plan, click Apply Filter.
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b. Assign the number of coaching assignments that the assigned employees are
expected to complete in the Target field.

c. Select the check box next to the employee based on the criteria available and define
the number of assignments to be taken by them as part of the plan and click Save.

Avaya Workforce Optimization Select displays the Preview & Save page where you can
review the accuracy and a summary of the details of the coaching plan.

5. On the Preview & Save page, click one of the following:

• Save: to save the coaching plan in the Plans list

• Publish: to change the plan into active state

Note:

Only active plans are available to supervisors or managers for associating with a
coaching task.

Plans field descriptions
Definition

Name Description
Coaching Plan The coaching plan that is associated with the coaching. Depending on the

plan selected, coaching assignments are created for the employees who
were targeted as part of plan.

You can enter up to 100 characters in this field.

This field is mandatory.
Plan Period (Days) The duration in which the user is planning to ramp up the employee. The

number of days during which the coaching assignments must be
completed by the employees.

If the targeted number of assignments are not met, alerts are sent to the
creator of the coaching plan and the reporting manager. Alerts are sent in
48 hours, 24 hours, and on the last day of the plan.

You can enter up to a 4 digits in this field.

This field is mandatory.
DP OU Type The employees belonging to the data partition OU type that the plan will

be applied.

This field is mandatory.
Description A brief description of the plan function.

You can enter up to 500 characters in this field.

Coaching Plans
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Employee Filter

Name Description
Field The option to select one of the filters for employees to add a coaching

assignment.

The options are:

• Department

• Employee

• Groups

• Organization Unit

• Role

• Site

• Reporting To

• Tenure (Weeks)
Operator The Operator relative to the field selected. The options are:

• Equals To

• Not Equal To

• Contains

• Does Not Contain

• Starts With

The default value is Equals.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

Employee List

Name Description
Target The number of coaching assignments that the assigned employees are

expected to complete.

The target is evenly distributed to all the employees listed. However, the
user can alter the target for each employee.

This field cannot exceed 2 digits.

This field is mandatory.

Table continues…
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Name Description
Number of Coaching
Assignments

The number of coaching assignments that you want the employee to
complete.

You must type 0 in the Number of Coaching Assignments field if an
employee need not take any assignments even if the employee is part of
the plan.

Employee The name of the employee to whom the coaching assignment is
assigned.

Tenure (Weeks) The tenure in weeks of the employee in the organization.
Supervisor The reporting manager of the employee.

This field is mandatory.
Department The department that the employee belongs to.
Average QA Score The average quality score received by the employee across all

evaluations.

Preview & Save

Name Description
Coaching Plan The coaching plan that is associated with the coaching. Depending on the

plan selected, coaching assignments are created for the employees who
were targeted as part of plan.

Plan Period (Days) The duration in which the user is planning to ramp up the employee. The
number of days during which the coaching assignments must be
completed by the employees.

Target The number of coaching assignments that the assigned employees are
expected to complete.

The target is evenly distributed to all the employees listed. However, the
user can alter the target for each employee.

Status The status of the plan. Only active plans are available to supervisors or
managers for associating with a coaching task.

Employee The name of the employee to whom the coaching assignment is
assigned.

Tenure The tenure in weeks of the employee in the organization.
Number of Coaching
Assignments

The number of coaching assignments that you want the employee to
complete.

Button Name Description
Save To save the plan at any stage of creating
Edit To edit the plan details
Publish To publish the plan to change the status of the plan to active

Only active plans are available to supervisors or managers for
associating with a coaching task.

Coaching Plans
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Adding a view
About this task
To search for coachings, you can use the AWFOS Default view, a saved view or a view that has
been shared by other users. If you want a new set of filter criteria, you can create a new view.

Note:

The AWFOS Default view consists of predefined filters configured by your system administrator.
You cannot modify the filters on this view.

Procedure
1. Click Coach > Coachings.

The system displays the coachings in the default view.

2. Click Add.

The system displays the Create View page.

3. On the Create View page, do the following:

a. Type the name and description of the view.

b. In Field, select the filter in which you want to apply the filter.

c. In Operator, select the operator for the filter.

d. In value, enter the value that the records must match.

4. Click Save & Close.

Note:

Alternatively the view can be saved as a report.

Add View field descriptions
Name Description
Name The name of the view.

This field is mandatory.
Default The option to display the selected view as the default. You can set a view

as default if you want to see a certain set of coachings each time you
login.

Description The description that helps to understand the reason for creating a view.
Filter The filter criteria used to search the coachings.
Share The option to share the view with selected users, with everyone, or save

it as private.
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Filter

Name Description
Field The parameters used to filter the search results. The options are:

• Role

• Coaching Level

• Coaching Status

• Completion Date

• Delivery Date

• Department

• Employee Status

• Follow Up Date Time

• Groups

• Organization Unit

• Site
Operator The operator used to specify the search criteria. The options are:

• Equals To

• Not Equal To

• Contains

• Does not Contain

• Starts With

• Does not Starts With

• Ends With

• Does not Ends With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between

• Includes

• Excludes
Value The value specified in the search query that is used to match the records.

You can view the list of coachings that match the value in this list.

Adding a view

October 2019 Using Avaya Workforce Optimization Select 229
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Field

Name Description
Role To search for coachings based on the designation of the employee in the

organization.
Coaching Level To search for coachings
Coaching Status To search for the status of the coaching whether the coaching is

accepted, completed, or new.
Completion Date To search for coachings based on the completion date.
Delivery Date To search for coachings based on a delivery day, week, or month.
Department To search for a coaching by the name of the department that the

employee belongs to.
Employee Status To search for an interaction by the status of the employee attending to the

interaction. The options are:

• Active

• Inactive
Follow Up Date Time To search for coachings based on a follow up day, week, or month.
Groups To search for coachings of employees belonging to the specified group.

To search for coachings based on the status of the employee. The
options are:

• Active

• Passive
Organization Unit To search for coachings based on the name of the organizational unit.

Use the available operators to define your search criteria.

For example, when you use the Excludes operator and enter the name
of the organizational unit, a specific organizational unit is removed from
the search.

Site To search for coachings of employees belonging to the specified site.

Operator

Name Description
Equals To To search for coachings that exactly match the specified value.
Not Equal To To search for coachings that do not match the specified value.
Contains To search for coachings that have the string or text that match the

specified value.
Does not Contain To search for coachings that do not have the specified value.
Starts with To search for coachings that start with the specified value.
Does not Starts With To search for coachings that does not start with the specified value.
Ends With To search for coachings that ends with the specified value.

Table continues…
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Name Description
Does not Ends With To search for coachings that does not end with the specified value.
Less Than To search for coachings that have a value less than the specified value.
Greater Than To search for coachings that have a value that is greater than the

specified value.
Less Than or Equal To search for coachings that have a value less than or equal to the

specified value.
Greater Than or Equal To search for coachings that have a value greater than or equal to the

specified value.
Between To search for coachings that lie between the specified value.

Share

Name Description
Me The option to set the view as private where other users will not be able to

view or use the View.
Selected Groups The option to share the view with specific people or groups.
Everyone The option to share the view with all users of the application.

By sharing the view with a group or with everyone, the system renders
results based on the access with whom the view is shared.

Note:

Users can only view search results and cannot edit the search results.

Button Name Description
Save as Report The option to save a view as an adhoc report. You can view this report in

the Reports tab.

Viewing coaching assignments
About this task
Use this procedure to view the Coachings screen that lists all coaching sessions set up for the
employees that the logged user has access to. The list displays all the coaching assignments that
are Completed, New, or Pending.
You can create a new coaching assignment, edit or delete existing coaching sessions if you have
adequate privileges.

Procedure
1. Click Coach > Coachings.

The Coachings page displays a list of coaching sessions.

Viewing coaching assignments
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2. To view the details of a coaching assignment, click the  icon in the desired row.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

8. To delete a coaching assignment, click Delete.

My Assignments field descriptions
Name Description
Coaching Purpose The reason for creating the coaching assignment.
Coaching Level The level of the coaching assignment. The options are: 1, 2, or 3.
Skills The unique name of the skill that you are creating for a coaching

assignment.
Reasons for Coaching The unique name of the reason that you are creating for a coaching

assignment.
Delivery Date The expected delivery date of the coaching assignment. The date is in

the mm:dd:yyyy format.
Completion Date The expected completion date of the coaching assignment. The date is in

the mm:dd:yyyy format. By default, the nearest completion date
assignment shows on top of the list.

Coach The name of the coach assigned to the employee for coaching.
Created By The name of the user who created the coaching assignment.
Follow up date The follow-up date after the coaching session was completed. The date is

in the mm:dd:yyyy format.
Status The status of the coaching assignment.
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Creating coaching assignments
About this task
Use this procedure to create coaching assignments for employees that the logged in user has
access to.
You can select the employees and assign coaching. You can also associate parameters such as
metrics, skills or competencies, reasons for coaching, provide an action plan, and schedule the
coaching assignments. You can also assign quiz to a coaching. You can attach e-learning courses
and documents or also provide URLs to courses that are deadline driven.
A notification is sent to the selected employees when you assign the coaching assignment. The
employees can view the coaching assigned on the My Assignments page.

Procedure
1. Click Coach > Coachings.

The Coachings page displays a list of coaching sessions.

2. Click Create.

3. On the Coachings page, do the following:

a. Enter the appropriate details in the Coaching Plan, Coach, Coaching Level, and
Coaching Purpose fields.

b. To apply the filter that you defined in the employee filter to be assigned to the
coaching assignment, click Apply Filter.

c. In Employee List section, select the check box next to the employee based on the
criteria available and enter the details rest of the fields.

d. Click Assign Coaching.

The system saves the coaching assignment and displays on the Coachings screen.
Employees whom you have assigned this coaching assignment receive a notification in
their inbox that a new coaching assignment is available for them.

Coachings field descriptions
Coaching

Name Description
DP OU Type The partition of the organizational unit that the employee belongs to.

This field is mandatory in a data partitioned environment.
Coaching Plan The coaching plan to assign to the coaching assignment.

Table continues…
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Name Description
Coaching Level The level of the coaching assignment. The options are:

• 1

• 2

• 3

A higher level coaching indicates that the selected employees need
rigorous coaching.

The default level is 1.

This field is mandatory.
Coaching Purpose The reason for creating the coaching assignment.

This field cannot exceed 500 characters.

This field is mandatory.
Coach The name of the coach assigned to the employee for coaching .

Employee Filter

Name Description
Field The option to select one of the filters for employees to add a coaching

assignment.

The options are:

• Department

• Employee

• Groups

• Organization Unit

• Role

• Site

• Reporting To

• Tenure (Weeks)
Operator The Operator relative to the field selected. The options are:

• Equals

• Not Equal To

• Contains

• Does not contain

• Starts with

The default value is Equals.

This field is mandatory if you select Field.

Table continues…
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Name Description
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

This field is mandatory if Field is selected.

Employee List

Name Description
Target The number of coaching assignments that the assigned employees are

expected to complete.

The target is evenly distributed among all the employees listed. However,
you can alter the target for each employee.

This field cannot exceed 2 digits.

This field is mandatory.
Number of Coaching
Assignments

The number of coaching assignments that you want the employee to
complete.

You must enter 0 in the Number of Coaching Assignments field if an
employee need not take any assignments even if the employee is part of
the plan.

Employee The name of the employee to whom the coaching assignment is
assigned.

Tenure (Weeks) The tenure in weeks of the employee in the organization.
Supervisor The reporting manager of the employee.

This field is mandatory.
Department The department that the employee belongs to.

Parameters

Name Description
Reasons for Coaching The reasons for coaching parameters defined in the Parameter section of

the Coach module.
Skills The skills or competencies parameters defined in the Parameter section

of the Coach module.

Coachings field descriptions

October 2019 Using Avaya Workforce Optimization Select 235
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Action Plan

Name Description
Action Plan A brief description of the action that the employee is expected to perform.

For example, Take a quiz or Enroll in class.

This field cannot exceed 1000 characters.

This field is mandatory.
Expected Improvement The improvement you expect to see in the performance of the employee

after the coaching is complete. For example, decreased AHT.

This field cannot exceed 1000 characters.
Schedule The schedule of the coaching assignment. You can set the schedule for a

particular day and time and also define the duration of the coaching
session.

Completion Date The expected completion date of the coaching assignment.

The deadline must be met by the coach and employee.

This field is mandatory.
Duration (Mins) The duration of the coaching session.

Follow-up

Name Description
On The date of follow-up.

You can select a date to follow up the coaching to monitor if the purpose
of coaching is met and also track the improvement.

__ days after the completion
of the Coaching

The number of days from the coaching session after which the follow-up
session must be performed.

The default value is 15.

Comments

Name Description
Enter comments The option to enter the comments regarding the coaching.

This field cannot exceed 1000 characters.

Button Name Description
Apply Filter To apply the filter that you defined in the employee filter to be assigned to

the coaching assignment
Assign To associate a course or a quiz to an assignment
Assign Coaching To assign the coaching assignment after entering all the details on the

Coachings page
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Viewing My Assignments
About this task
Use the My Assignments screen to view the list of coaching sessions that is assigned to you.
After you complete the assignment, you must go to the respective assignment on the My
Assignments page and click Complete. Only then the status of the assignment is updated to
Completed. You can also enter your comments before accepting the coaching session.

Procedure
1. Click Coach > My Assignments (x), where (x) is the number of assignments assigned to

you.

The My Assignments page displays the assignments assigned to you.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

My Assignments field descriptions
Name Description
Coaching Purpose The reason for creating the coaching assignment.
Coaching Level The level of the coaching assignment. The options are: 1, 2, or 3.
Coaching Plan The coaching plan that is assigned to the coaching assignment.
Employee The name of the employee to whom the coaching assignment is

assigned.
Delivery Date The expected completion date of the coaching assignment. The date is in

the mm:dd:yyyy format.
Completion Date The expected completion date of the coaching assignment. The date is in

the mm:dd:yyyy format. By default, the nearest completion date
assignment shows on top of the list.
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Name Description
Updated On The date on which the coaching assignment was updated. The date is in

the mm:dd:yyyy format.
Coach The name of the coach assigned to the employee for coaching.
Created By The name of the user who created the coaching assignment.
Follow up date The follow-up date after the coaching session was completed. The date is

in the mm:dd:yyyy format.
Status The status of the coaching assignment.

Managing adhoc reports

Adhoc reports overview
Using adhoc reports, a user can access, and generate reports in the following modules of Avaya
Workforce Optimization Select view criteria.

• Interactions

• Evaluate

• Learn

• Coach

Adhoc reports are ideal for users who do not have access to the Reports module or who want to
use the comprehensive view criteria to generate a report.

Each module contains a Reports tab from where you can access the adhoc reports. You can also
access these reports from the Reports module from the Adhoc Reports tab. The adhoc reports
data in any interface is specific to the module in which it is placed. For example, the Reports tab in
the Interaction module contains only those reports that are generated using Interaction View.

Using adhoc reports, you can:

• View the data generated by using Views in the respective modules.

• Edit the adhoc reports depending on your business needs.

• Select and generate any report and view the reports in the Results screen of the Reports
module.

• Schedule the adhoc reports based on user preferences by providing email options.

• Export the data from the adhoc reports to Excel and PDF formats and print, email, or
download the files for future use.

• Share the reports with selected employees or with everyone.
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• Delete and run the reports in the respective modules without navigating to the Reports
module.

Saving a view as an adhoc report
Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Coach > Coachings.

The system displays the coachings in the default view.

2. In the View field, click the view that you want to edit and save as an adhoc report.

3. Click Edit.

The system displays the Edit View page where you can make the required changes, if you
want.

4. After making the changes, click Save as Report.

Avaya Workforce Optimization Select displays the Adhoc Reports page.

5. Type the name of the reports, and select the output type that you want to generate the
report.

6. Click Save.

Related links
Adding a view on page 228

Viewing adhoc reports
About this task
Use this procedure to view the reports generated by using the Coach module.

Procedure
1. Click Coach > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, click the report that you want to view, which you saved as an
adhoc report.

displays the details of the report. You can download, email, or print the report.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.
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4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

Editing an adhoc report
Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Coach > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to edit, and click Edit.
3. On the Edit View page, make the required changes, and click Save & Close.

Emailing an adhoc report
Before you begin
Ensure that a view exists or create a view.

About this task
Use this procedure to email an adhoc report if you want other users to view it. The report is sent
as an attachment in the format in which the view is saved as an adhoc report.

Before you begin
Procedure

1. Click Coach > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to send as an email, and click Email.
3. On the Email Report page, type the name of the recipient, and enter your comments.

4. Click Send.
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Downloading an adhoc report
About this task
Supervisors and managers can download adhoc reports in a specified format to keep for future
reference.

Before you begin
• Ensure that a view exists or create a view.
• Ensure that you specify the format when saving the view as an adhoc report.

Procedure
1. Click Coach > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to download, and click Download.

The system downloads the adhoc reports in the format that you specified while saving the
view.

Printing an adhoc report
About this task
You can print the adhoc reports in the format in which you saved the view as a report.

Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Coach > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to print, and click Print.

The system displays the adhoc report in the format in which you saved the view as a
report.

3. (Optional) To get a hard copy of the report, click on the  icon in the upper-right corner of
the page.
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Reports field descriptions
Coach Reports

Name Description
Coaching Purpose The reason for creating the coaching assignment.
Coaching Level The level of the coaching assignment. The options

are: 1, 2, or 3.
Employee The name of the employee to whom the coaching

assignment is assigned.
Delivery Date The expected completion date of the coaching

assignment. The date is in the mm:dd:yyyy format.
Completion Date The expected completion date of the coaching

assignment. The date is in the mm:dd:yyyy format.
By default, the nearest completion date assignment
shows on top of the list.

Coach The name of the coach assigned to the employee
for coaching.

Follow up date The follow-up date after the coaching session was
completed. The date is in the mm:dd:yyyy format.

Status The status of the coaching assignment.

The options are:

• New

• Complete

Button Description
Download To download the adhoc report.
Email To mail the adhoc report.
Print To print the adhoc report.
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Chapter 8: Managing learning

Learn overview
Using the Learn module, you can put knowledge in the hands of those who need it, when they
need it the most. Contact centers will have better trained, motivated, and empowered agents,
resulting in improved customer satisfaction, retention, advocacy, and profitability. You can train the
agents in your contact center with courseware and quiz to help improve their efficiency.
Using the Learn module you can:

• Upload videos, slide presentations, and other courseware to assign to selected employees.
• Attach a quiz with randomization of questions for courses.

Viewing course and quiz library
About this task
Use the Library screen to view the list of courses and quizzes that you have created or have
access to.

Procedure
1. Click Learn > Library.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.
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Library field descriptions
Name Description
Format The format of the course or quiz.
Name The name of the course or quiz.
Topic The topic of the course or quiz.

Courses and quizzes can be grouped into topics when they are created.
Duration The duration of the course or quiz that is assigned.
Type The type of assignment. The options are:

• Course

• Quiz

• Course & Quiz
Status The status of the assignment. You can assign an option only when it is in

active state.

The options are:

• Inactive: This is the default option.

• Active: Only active assignments are available for associating with a
library.

Assigning a course or a quiz
About this task
Use this procedure to assign a course or quiz to employees that you have access to.

Procedure
1. Click Learn > Library.

2. Select the courses or quizzes that you want to assign from the listing of directories.

3. Click Assign.

4. On the Assign Course/Quiz page, filter the employees you want to assign the course or
quiz to using theDepartment, Role, and Employeesdrop-down list.

5. For completion of the course or quiz, select a Due Date.

6. Click Assign.

The system displays the course or quiz in the inbox of the assigned employee, and also on
the My Assignments screen of the employee.
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Adding a quiz
Procedure

1. Click Learn > Library.

2. On the Library screen, click Add Quiz.

3. On the Definitions screen, enter the appropriate details and click Save as Draft.
4. On the Questions screen, click Add.

5. On the Add Question page, do the following:

a. In the Question text field, enter the question.

b. In the Options text field, enter an answer. Click Add to add as many options as you
want to provide to the employee.

c. Select the option that denotes the correct answer.

d. To save the question, click Save & Close.

e. To add as many questions to the quiz as you want, click Save & Add another

The question automatically gets displayed in the Questions tab.

6. Click Save as Draft.
7. On the Grading screen, enter a grade to the quiz and click Save as Draft.
8. On the Preview screen, get a view of the summary of the quiz and to review the data for

accuracy and click one of the following:

9. Click one of the following:

• Save: To save the quiz

• Publish: To change the plan to active state

Quiz field descriptions
Definition

Name Description
Name The unique identifying name for the quiz. You can enter up to 500

characters in this field.

This field is mandatory.
Description A brief description of the function of the quiz. You can enter up to 1000

characters in this field.

Table continues…
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Name Description
Topic The topic of the quiz. You can enter up to 100 characters in this field.

This field is mandatory.
Duration (Mins) The time that the employee has to complete the quiz. This field cannot

exceed 4 digits.
Pass (%) The percentage that the employee needs to pass the quiz.

You can enter a value that is less than or equal to 100.

This field is mandatory.
Quiz Lockout duration
(Days)

The number of days that the quiz remains valid after it has been
assigned. If a quiz is used in multiple courses, an assigned user or
employee does not have to retake a quiz that they have already been
assigned or completed.

The value for this field cannot exceed 4 characters.
Number of Questions to be
assigned

The value to assign a certain number of questions in the quiz on a
random basis. For example, you may have 30 questions in the quiz and
want to assign only 10 randomly.

The value for this field cannot exceed 3 characters.

This field is mandatory.
Assigned Questions
Lockout (Weeks)

The value to maintain the history of quiz questions assigned for a certain
period (in weeks) so that the quiz is not reassigned within that particular
period. The questions assigned previously will not appear in the
reassigned quiz. It starts from the date of first assignment of quiz.

For example, consider a quiz with 30 questions, of which 10 questions
are assigned, and a tracking period of 3 weeks. If a user is assigned Quiz
ABC four times within the 3–week period, the first time the user will be
assigned 10 questions. The second time the user will be assigned 10
questions from the remaining 20 unassigned questions, and the third time
the user will be assigned the remaining 10 questions. On the fourth
assignment, any 10 questions from the 30 questions will be assigned.

Any assignment after the expiration of the 3–week tracking period can
contain any group of 10 questions. If a value is not entered for the
tracking period, any 10 questions might appear in the assignment.

The value for this field cannot exceed 3 characters.
OUs The organization associated with the library.
Skills The skill or competency that you want the employee to develop.

Note:

Skills are created in the Parameters section.
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Questions

Name Description
Question The unique question in the quiz. You can enter up to 1000 characters in

this field.

This field is mandatory.
Option The response to the question in the quiz. You can enter up to 500

characters in this field.

This field is mandatory.

Grading

Name Description
Grade The unique identifying name for the grade. You can enter up to 100

characters in this field.

This field is mandatory.
Minimum value The lowest range of the score of the grade in the quiz. This field cannot

exceed 100 characters.

This field is mandatory.
Maximum value The highest range of the score of the grade in the quiz. This field cannot

exceed 100 characters.

The grade ranges must ensure 100% coverage.

For example, Grade A is 91.00 to 100, Grade B is 81.00 to 90.99, and
Grade C is 0 to 80.99.

This field is mandatory.

Preview

Name Description
Definition The quiz details you have entered while adding the quiz.
Questions The questions and the options you have created while adding the quiz.
Grading The grading range details you specified while adding the quiz.

Copying a quiz
About this task
Use this procedure to copy a quiz from the source to the destination library to increase its reach in
the organization. Unlike a course, a quiz cannot be uploaded to the assignments, must be
manually created, and can be specific.

Copying a quiz
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Procedure
1. Click Learn > Library.

2. On the Library page, select the quiz that you want to copy from the directory list.

Note:

• You can select only one quiz at a time.

• You can select only the quizzes with active status.

3. Click Copy.

4. On the Create duplicate Course/Quiz page, type the name of the quiz.

• You can also retain the default, which is the name of the original quiz. In this case, the
Library page displays the name as Copy of x, where x is the name of the original quiz.

• You can also create a copy of the copied quiz.

5. Click Create.

The Library page displays the copy of the quiz in the directory list.

6. To delete a copy, select the row that contains the quiz and click Delete .

If you delete the original quiz, the copy of the quiz is not impacted.

Adding a course
About this task
Use this procedure to add courses in the Learn module. Courses can either be links to external
URLs, file documents that are copied into the system, or system quizzes. After you add the
course, the system displays it in Library, where the course can be assigned to employees.

Procedure
1. Click Learn > Library.

2. On the Library screen, click Add Course.

3. On the Course page, enter the appropriate details and click one of the following:

• Save & Close: To save the course.

• Save & Add Another: To add another course.
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Course field descriptions
Name Description
DP OU Type The partition of the organization unit for which the course is made

available.
Name The unique identifying name of the course. You can enter up to 500

characters in this field.

This field is mandatory.
Description A brief description of the function of the course. You can enter up to 1000

characters in this field.
Topic The topic of the course. You can enter up to 500 characters in this field.

This field is mandatory.
Type The type of file. The options are:

• File: To upload a file.

• URL: To enter the location or the source of the course.

This field is mandatory.
File The location or the source of the course. You can specify the complete

path or select the file from the desired location.

This field is mandatory.
Associated Quiz The quiz that you must assign to the course. You can assign multiple

quizzes that are available. However, associating a quiz with a course is
not mandatory.

Reassignment Lockout
(days)

The number of days for which the assigned course is restricted from
being reassigned.

The maximum limit for number of days is 4 digits.
OU(s) The name of the organization units who can access the course.
Skills The skill or competency that you want the employee to develop.

Note:

Skills are created in the Parameters section.

Adding a view
About this task
To search for learning assignments, you can use the AWFOS Default view, a saved view or a view
that has been shared by other users. If you want a new set of filter criteria, you can create a new
view.

Note:

Course field descriptions
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The AWFOS Default view consists of predefined filters configured by your system administrator.
You cannot modify the filters on this view.

Procedure
1. Click Learn > Team Assignments.

The system displays the assignments in the default view.

2. Click Add.

The system displays the Create View page.

3. On the Create View page, do the following:

a. Type the name and description of the view.

b. In Field, select the filter in which you want to apply the filter.

c. In Operator, select the operator for the filter.

d. In value, enter the value that the records must match.

4. Click Save & Close.

Related links
Add a view field descriptions on page 250

Add a view field descriptions
Create View

Name Description
Name The name of the view.

This field is mandatory.
Default The option to display the selected view as the

default. You can set a view as default if you want to
see a certain set of assignments each time you
login.

Description The description that helps to understand the reason
for creating a view.

Filter The filter criteria used to search the assignments.
Share The option to share the view with selected users,

with everyone, or save it as private.
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Filter

Name Description
Field The parameters used to filter the search results.

The options are:

• Role

• Assigned Date

• Department

• Due Date

• Employee Status

• Groups

• Organization Unit

• Site
Operator The operator used to specify the search criteria.

The options are:

• Equals To

• Not Equal To

• Contains

• Does not Contain

• Starts With

• Does not Starts With

• Ends With

• Does not Ends With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between
Value The value specified in the search query that is used

to match the records.

You can view the list of assignments that match the
value in this list.

Adding a view
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Field

Name Description
Role To search for assignments based on the designation of the employee in

the organization.
Assigned Date To search for an assignment based on the day, week, or month when the

assignment was assigned.

A user can access the data based on a specific selected date.
Department To search for an assignment by the name of the department that the

employee belongs to.
Due Date To search for an assignment by based on the completion day, week, or

month.

A user can access the data based on a specific selected date.
Employee Status To search for an assignment by the status of the employee attending to

the interaction. The options are:

• Active

• Inactive
Groups To search for assignments of employees belonging to the specified group.
Organization Unit To search for assignments based on the name of the organizational unit.

Use the available operators to define your search criteria.
Site To search for assignments of employees belonging to the specified site.

Operators

Name Description
Equals To To search for assignments that exactly match the specified value.
Not Equal To To search for assignments that do not match the specified value.
Contains To search for assignments that have the string or text that match the

specified value.
Does not Contain To search for assignments that do not have the specified value.
Starts with To search for assignments that start with the specified value.
Does not Starts With To search for assignments that does not start with the specified value.
Ends With To search for assignments that ends with the specified value.
Does not Ends With To search for assignments that does not end with the specified value.
Less Than To search for assignments that have a value less than the specified

value.
Greater Than To search for assignments that have a value that is greater than the

specified value.
Less Than or Equal To search for assignments that have a value less than or equal to the

specified value.

Table continues…
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Name Description
Greater Than or Equal To search for assignments that have a value greater than or equal to the

specified value.
Between To search for assignments that lie between the specified value.

Button Name Description
Save as Report The option to save a view as an adhoc report. You can view this report in

the Reports tab.

Related links
Adding a view on page 249

Viewing team assignments
About this task
Use the Team Assignments screen to view the list of courses and quizzes assigned to employees
that the logged in user has access to.
The list displays all the courses and quizzes that are Completed, New, or Pending.

Procedure
1. Click Learn > Team Assignments.

Avaya Workforce Optimization Select displays the list of team assignments.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.
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Team Assignments field descriptions
Name Description
Format The format of the course or quiz.
Employee The name of the employee who is taking the assignment.
Reporting To The reporting manager of the employee to whom the course or quiz is

assigned.
Name The name of the course or quiz.
Topic The topic of the course or quiz.

Courses and quizzes can be grouped into topics when they are created.
Assigned By The name of the user who assigned the course or quiz.
Assigned Date The date and time on which the course or quiz was assigned.
Assigned From The source from where the course or quiz is assigned.

Courses and quizzes can be assigned from Coach, Learn, or Evaluate
modules.

Due Date The date by which the course or quiz must be completed.
Duration The duration of the course or quiz that is assigned.
Score The score of the employee.

The system displays the scores only if the assignment contains a quiz.
Type The type of assignment. The options are:

• Course

• Quiz

• Course & Quiz
Status The status of the course or quiz. The options are:

• New

• Pending

• Completed

Viewing courses assigned to you
About this task
Use the My Assignments screen to view the list of courses and quizzes that are assigned to the
logged in user. The list displays all the courses and quizzes that are Completed, New, or Pending.
After the logged in user has gone through the course, the user can click Done and then take a
quiz if there is one associated to it.
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Procedure
1. Click Learn > My Assignments.

The My Assignments (x) page displays a list of courses or quizzes that are assigned to
you, where x denotes the number of incomplete tasks.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

My Assignments field descriptions
Name Description
Format The format of the course or quiz.
Name The name of the course or quiz.
Topic The topic of the course or quiz.

Courses and quizzes can be grouped into topics when they are created.
Assigned By The name of the user who assigned the course or quiz.
Assigned Date The date and time on which the course or quiz was assigned.
Assigned From The source from where the course or quiz is assigned.

Courses and quizzes can be assigned from Coach, Learn, or Evaluate.
Due Date The date by which the course or quiz must be completed.
Duration The duration of the course or quiz that is assigned.
Score The score of the employee.

Scores show only if the assignment is a quiz.

Table continues…
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Name Description
Type The type of assignment.

The options are:

• Course

• Quiz

• Course & Quiz
Status The status of the course or quiz.

The options are:

• New

• Pending

• Completed

Taking a course or a quiz
Before you begin
For the course or quiz to play successfully, you must first install the Windows Media Player plugin
for your browsers.

Procedure
1. Click Learn > My Assignments.

The My Assignments (x) page displays a list of courses or quizzes that are assigned to
you, where x denotes the number of incomplete tasks.

2. Click the course or quiz.

Avaya Workforce Optimization Select plays the course or quiz directly in your default web
browser using Windows Media Player.

3. View the course status on completion.

If a particular course is not yet complete, the quiz details associated to that course displays
as Pending.

Managing learning
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Managing adhoc reports

Adhoc reports overview
Using adhoc reports, a user can access, and generate reports in the following modules of Avaya
Workforce Optimization Select view criteria.

• Interactions

• Evaluate

• Learn

• Coach

Adhoc reports are ideal for users who do not have access to the Reports module or who want to
use the comprehensive view criteria to generate a report.

Each module contains a Reports tab from where you can access the adhoc reports. You can also
access these reports from the Reports module from the Adhoc Reports tab. The adhoc reports
data in any interface is specific to the module in which it is placed. For example, the Reports tab in
the Interaction module contains only those reports that are generated using Interaction View.

Using adhoc reports, you can:

• View the data generated by using Views in the respective modules.

• Edit the adhoc reports depending on your business needs.

• Select and generate any report and view the reports in the Results screen of the Reports
module.

• Schedule the adhoc reports based on user preferences by providing email options.

• Export the data from the adhoc reports to Excel and PDF formats and print, email, or
download the files for future use.

• Share the reports with selected employees or with everyone.

• Delete and run the reports in the respective modules without navigating to the Reports
module.

Saving a view as an adhoc report
About this task
Use this procedure to save an existing view in the Learn module as an adhoc report.

Before you begin
Ensure that a view exists or create a view.

Managing adhoc reports
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Procedure
1. Click Learn > Team Assignments.

The system displays the assignments in the default view.

2. In the View field, click the view that you want to edit and save as an adhoc report.

3. Click Edit.

The system displays the Edit View page where you can make the required changes, if you
want.

4. After making the changes, click Save as Report.

Avaya Workforce Optimization Select displays the Adhoc Reports page.

5. Type the name of the reports, and select the output type that you want to generate the
report.

6. Click Save.

Related links
Adding a view on page 249

Viewing adhoc report
About this task
Use this procedure to view the reports generated using the Learn module.

Procedure
1. Click Learn > Reports.

The Reports page displays the list of existing reports.

2. From the drop-down list, click the report you want to view, which you have saved as an
adhoc report.

Avaya Workforce Optimization Select displays the details of the report. You can download,
email, or print the report.

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.

6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

Managing learning
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The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

Editing an adhoc report
Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Learn > Reports.

The Reports page displays the list of existing reports.

2. Select the report you want to edit, and click Edit.
3. On the Edit View page, make the required changes, and click Save & Close.

Emailing an adhoc report
About this task
You can email an adhoc report if you want other users to view the report. The report is sent as an
attachment in the format in which the view is saved as an adhoc report.

Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Learn > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to send as an email, and click Email.
3. On the Email Report window, type the name of the recipient, and enter your comments.

4. Click Send.

Downloading an adhoc report
About this task
Supervisors and managers can download adhoc reports in a specified format to keep for future
reference.

Managing adhoc reports
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Before you begin
• Ensure that a view exists or create a view.
• Ensure that you specify the format when saving the view as a report.

Procedure
1. Click Learn > Reports.

The Reports page displays the list of existing reports.

2. Select the report, which you want to download, and click Download.

The system downloads the adhoc reports in the format which you specified while saving
the view.

Printing an adhoc report
About this task
Use this procedure to print an adhoc report in the format in which you saved the view as a report.

Before you begin
Ensure that a view exists or create a view.

Procedure
1. Click Learn > Reports.

The Reports page displays the list of existing reports.

2. Select the report that you want to print, and click Print.

Avaya Workforce Optimization Select displays the adhoc report in the format in which you
saved the view as a report.

3. To get a hard copy of the report, click on the  icon on the upper-right corner of the page.

Adhoc reports field descriptions
Name Description
Format The format of the course or quiz.
Agent The name of the agent who is taking an

assignment.
Reporting to The reporting manager of the employee to whom

the course or quiz is assigned.
Name The name of the course or quiz.

Table continues…
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Name Description
Topic The topic of the course or quiz.

Courses and quizzes can be grouped into topics
when they are created.

Assigned By The name of the user who assigned the course or
quiz.

Assigned Date The date and time on which the course or quiz was
assigned.

Assigned From The source from where the course or quiz is
assigned.

Courses and quizzes can be assigned from Coach,
Learn, or Evaluate modules.

Due Date The date by which the course or quiz must be
completed.

Duration The duration of the course or quiz that is assigned.
Type The type of assignment. The options are:

• Course

• Quiz

• Course & Quiz
Score The score of the employee.

The system displays the scores only if the
assignment contains a quiz.

Status The status of the course or quiz. The options are:

• New

• Pending

• Completed

Button Description
Download To download the adhoc report.
Email To mail the adhoc report.
Print To print the adhoc report.

Managing adhoc reports
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Chapter 9: Analyzing contact center
performance

Analyze overview
Using the Analyze module, a user with the appropriate permissions can create scorecards and
metric views to measure and analyze the performance of employees, departments, roles, and
sites in an organization.

Using Analyze module you can:

• Measure the performance of employees from raw transaction data, such as the number of
interactions handled, total talk time, or number of coachings taken.

• Define metrics that determine the criteria to measure performance. You can use a variety of
sources to define a comprehensive metric library that align with your business processes and
strategic organizational goals.

• Generate time-based scorecards to get a snap shot of the overall performance of employees,
departments, roles, or sites.

Features of the Analyze module
• Measures: For more information see, Measures overview on page 262.
• Metrics: For more information see, Metrics overview on page 265.
• Scorecards: For more information see, Scorecards overview on page 285.

Managing Measures

Measures overview
A measure is the raw transaction data associated with an employee. For example, the number of
interactions handled, the total talk time, the number of evaluations completed, or the hold time of
an interaction. You can view the measures in read-only mode. All measures are calculated and
stored on a daily basis. You can use one or more measures to create custom metrics, which is
further used in metric views and scorecards for analyzing the performance of an employee, a role,
a department, and a site.
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Measures are categorized under the following Avaya Workforce Optimization Select modules:

• Interactions

• Evaluate

• Coach

• Learn

Apart from these categories, some measures are also categorized under WFM as a part of
Teleopti WFM integration.

Viewing system measures
About this task
Measures are raw transaction data associated with an employee. These measures are generated
by the system and are calculated and stored on a daily basis in the database. You can use these
measures to create custom metrics.

Procedure
1. Click Analyze > Measures.

Avaya Workforce Optimization Select displays the Measures page with all the system
measures in a read-only mode.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.
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System Measures field descriptions
View Measures

Name Description
Name The name of the measure.
Alias The acronym for the name of the measure.
Description A brief description of the measure .
Category The field name to categorize the measures based on the modules. The

modules are:

• Interactions

• Coach

• Learn

• Evaluate

Avaya Workforce Optimization Select Measures

Name Description
Total Talk Time The duration of the call.
Total Hold Time The duration of the total number of times an employee keeps a call on

hold.
Number Of Interactions The number of interactions handled by an employee.
Number Of Interactions
With Transfers

The number of calls transferred by a employee.

Number Of Interactions
With conferences

The number of calls where an employee could not resolve a customer
issue and set up a conference call between a senior employee and the
customer.

Number Of Interactions
With Holds

The number of calls that were put on hold.

Quality Score The evaluation score received by an employee.
Appeals Accepted The number of appeals based on which the scores are modified.
Appeals Declined The number of appeals based on which the scores remain the same.
Appeals Drawn The number of appeals based on which the scores do not change.
Appeals Raised The number of appeals raised for the evaluations.
Evaluations Completed by
Reviewers

The number of evaluations completed.

Number Of Evaluations
accepted by Agents

The number of evaluations for each employee.

QuizScore The score received by an employee when an assignment contains a quiz.

Table continues…
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Name Description
Number Of Quizzes The number of quizzes assigned to an employee.
Coachings delivered The number of coaching sessions delivered to an employee.
Coachings taken The number of coaching sessions taken by an employee.
Wrapup Time The time an employee spends in updating the information associated with

the concluded interaction.

WFM Measures

Name Description
Idle Time The duration of the time an employee is not engaged in an interaction.
Logged In Time The total duration of the time when the employee is logged in for an

interaction.
Ready Time The duration of time when an employee is logged in and is in a ready

state.
READY_TIME_OF_SCHEDU
LED

The time duration in ready state as defined in a schedule.

Schedule Ready Time The duration of time when an employee is ready as defined in a
schedule.

Managing Metrics

Metrics overview
Metrics are performance indicators. The Analyze module provides a predefined set of system
metrics. You can also create custom metrics based on your specific business needs. If you want to
give importance to a metrics that drives performance improvements, you can flag the metric as a
Key Performance Indicator (KPI) in the system. One or more metrics are used to build scorecards
for assessing the performance of an employee, role, department, or site in an organization over a
period of time. As a part of integration with Teleopti WFM, both the predefined and custom metrics
are divided into two sets.

Avaya Workforce Optimization Select system metrics
• Interactions Handled
• Average Quiz score
• Coachings Taken
• Average Talk Time
• Average QA score
• Coachings Delivered

Managing Metrics

October 2019 Using Avaya Workforce Optimization Select 265
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


• Average Handle Time

WFM system metrics
• Availability
• Occupancy
• Adherence
• Attendance

Custom metrics
Custom metrics are created from the following sources:

• Measures: One or more measures are used as the source to create a custom metric. You can
tie multiple measures by a formula that defines how the system must calculate the custom
metric. For example, to calculate the average talk time for employees, you choose the Total
Talk Time measure and the Number of Interactions measure, and specify Average as the
formula.

• Derived: An existing metric is used as the source to create a custom metric. You can specify
an aggregation and a formula to define how the custom metric is calculated.

• Data Entry: Manual data entries are used as the source to create a custom metric. You can
add values for a metric for a specific period of time. You can define an aggregation to specify
whether you want the system to calculate the sum, average, minimum, or maximum range of
the values that you enter. For example, you might want to create a custom metric where you
manually enter values for the number of interactions or evaluations completed by all
departments every quarter. In this case, you must use Data Entry as the metric source,
define the time period as quarterly, and aggregation as Average.

• External Import: External data is imported in a specified template to create a custom metric.
For example, if you are using an HR system to track the attendance of employees, you can
use External Import as the metric source to import that data as a custom metric. Depending
on the parameters that you define for the custom metric, the system provides a template,
which you can download to enter values for the custom metric and import the same into the
system.

Note:

You cannot delete a custom metric if it is used in any metric view or is a part of a scorecard.

System Metrics field descriptions
System Metrics are applied at employee level and are available only in the read-only mode.
All System Metrics are stored on a daily basis.

Avaya Workforce Optimization Select system metrics

Name Description
Average Handle Time An employees’s average handle time for interactions.

Table continues…
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Name Description
Calls Handled The number of calls handled by each employee.
Average QA Score The average quality score.
Coachings delivered The average coachings delivered.
Coachings taken The number of coachings taken by each agent.
Average Quiz Score The average quiz score for assignments that contain a quiz.

WFM system metrics

Name Description
Availability The time when the agent is attending to a customer or waiting for a call.

The formula for calculating this metric is Ready Time/Logged in Time.
Occupancy The percentage of ready time that an agent spends actively handling

interactions.

The formula for calculating this metric is (Ready Time - Idle
Time ) / Ready Time.

Adherence The average of the ready time versus the scheduled ready time.

The formula for calculating this metric is Ready Time / Schedule Ready
Time.

Attendance The percentage of the number of hours when an agent attended an
interaction over the number of hours the interaction was scheduled.

The formula for calculating this metric is Sum of Ready Time / Sum of
Schedule Ready Time.

Viewing Metrics Definition
About this task
Use this procedure to view the available system and custom metrics in the application.

Procedure
1. Click Analyze > Metrics.

The Definition tab on the left panel gets selected. The system displays the Metric page
with the details of the available metrics.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.
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5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To reset the sorting, click the  icon.

7. (Optional) To view the measures that are used in a particular metric, click the  icon
next to the metric.

Avaya Workforce Optimization Select displays the expanded view of the measures for the
selected metric in a read-only mode.

8. (Optional) To edit a particular metric, click on the metric row.

Avaya Workforce Optimization Select displays the Edit Metric page.

9. (Optional) To delete a particular metric, click on the radio button next to the metric.

The Delete tab gets enabled for deleting the metric.

Creating or adding a custom metric
About this task
Use this procedure to create custom metrics if the system metrics do not meet your requirements.

Before you begin
Get the required permissions to create a custom metric.

Procedure
1. Click Analyze  > Metrics.

2. Click the Add button.

3. On the Create Metric page, do the following:

a. Type the name, alias, and description of the metric.

b. To select a category, click one of the existing categories in the Category field.

c. (Optional) If you do not find the category you want, click Add to add a custom
category.

The system displays the Add Category page, where you can enter the name of the
category and save it.

d. To select the source of the metric, click one of the sources in the Source field.

The system displays a dynamic screen that changes with the selected metric source.

e. Enter the required fields.

4. Click Save & Close.

Analyzing contact center performance
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5. To add or create another metric, click the Save & Add another button.

Create Metric field descriptions
Name Description
Name The name of the metric
Key Performance Indicator The option to select a metric as the key indicator for

measuring an employee’s performance.

All the metrics that are flagged as KPIs contains a *
symbol before them.

Alias The alias name of the metric.

The alias must be within a DP OU.
Description A description of the specifications of the metric.
Category The option to group the metric under a category for

generating an output.

Depending on the metric definition, you can group
metrics under relevant categories. For example, if
the metric is used to calculate AHT, you can group it
under a category called Interactions.

You can create custom categories to group metrics
based on your requirements by clicking the Add
button.

You can also delete a category, if it is not
associated with any metric.

Source The option to define the source of the metric. The
options are:

• Measure

• Derived

• Data Entry

• External Import
Measure(s) The option to select the system measure for

creating a particular metric.

This option is only available when you select the
source as:

• Measure

• Derived

Table continues…
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Name Description
Formula The option to add a formula for multiple measures

to specify what the system must do to derive a
metric. For example, if you add the Total Talk Time
measure and the Number of Interactions measure
and specify Average as the formula, the system
calculates the AHT of all calls handled by
employees.

This field is only available when you select the
metric source options as Derived.

Metric The option to select a metric for creating a derived
metric.

This field is available when you select the source as
Derived.

Period The option to select the time period for the metric.
The options are:

• Daily

• Weekly

• Monthly

• Quarterly

• Yearly

This field is available when you select the source
as:

• Data Entry

• External Import
Aggregation The option to specify an aggregation to define what

calculation is applied to derive the metric. The
options are:

• Average

• Sum

This option is available only when you select the
metric source option as:

• Data Entry

• External Import

Table continues…
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Name Description
Units of Measure The unit of measure for the metric. All metrics are

measured against a number indicating a count or
time indicating a period. For example, for the AHT
metric, the unit of measure is time. The options are:

• Number

• Time
Direction The option to specify the direction of the metric in

increasing or decreasing order in percentage for a
particular period of time. For example, for the AHT
metric, you must specify a decreasing scale to see
this metric decrease for an agent. The options are:

• Increasing is Better

• Decreasing is Better

The increasing score is calculated by dividing your
score divided by the target score. The decreasing
score is divided score is calculated by dividing the
target by your score.

Minimum Value The minimum value for a derived metric. You must
type the specified minimum value.

This option is available only when you select the
metric source option as:

• Data Entry

• External Import
Maximum Value The maximum value for a custom metric. You must

type the specified maximum value.

This option is available only when you select the
metric source option as:

• Data Entry

• External Import
Association The option to specify to whom the metric calculation

must be associated. The options are:

• Employee

• Department

• Role

This option is available only when you select the
metric source option as:

• Data Entry

• External Import
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Editing a custom metric
About this task
Use this procedure to edit a custom metric if you want to change the details associated with it. All
custom metrics are active unless you choose to make them inactive while editing the metric.
However, if the metric is used in an active scorecard, you cannot make it inactive or delete it. To
make it inactive or delete it, you must disassociate it from the scorecards in which it is used.

Procedure
1. Click Analyze  > Metrics.

The system displays the list of metrics that exists in the system.

2. Select the metrics that you want to edit from the list and click Edit.
3. On the Edit page, make changes to the required fields

a. Change the name, alias, and description of the metric, if required.

b. To flag a metric as a KPI to drive a performance measure, select the Key
Performance Indicator check box.

Alternately, you can clear the Key Performance Indicator check box, if you do not
want to flag it as a KPI.

c. To make the metric as inactive, clear the Active check box.

d. To change a category, click one of the existing categories in the Category field.

e. (Optional) If you do not find the category you want, click Add to add a custom
category.

The system displays the Add Category page, where you can enter the name of the
category and save it.

f. To change the source of the metric, click one of the sources in the Source field.

The system displays a dynamic screen that changes with the selected metric source.

g. Enter the required fields.

4. Click Save & Close.

5. To add or create another metric, click the Save & Add another button.

Edit Metric field descriptions
Name Description
Name The name of the metric

Table continues…
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Name Description
Key Performance Indicator The option to flag a metric as the key indicator for measuring an

employee’s performance.

All the metrics that are flagged as KPIs contains a * symbol before them.
Alias The alias name of the metric.

The alias must be within a DP OU.
Active The option to change a custom metric to inactive.

All custom metrics are active unless you choose to make them inactive
while editing the metric. However, if the metric is used in an active
scorecard, you cannot make it inactive or delete it. To make it inactive or
delete it, users have to disassociate it from the scorecards in which it is
used.

Description A description of the specifications of the metric.
Category The option to group the metric under a category for generating an output.

Depending on the metric definition, you can group metrics under relevant
categories. For example, if the metric is used to calculate AHT, you can
group it under a category called Interactions.

You can create custom categories to group metrics based on your
requirements by clicking the Add button.

You can also delete a category, if it is not associated with any metric.
Source The option to define the source of the metric. The options are:

• Measure

• Derived

• Data Entry

• External Import
Measure(s) The option to select the system measure for creating a particular metric.

This option is only available when you select the source as:

• Measure

• Derived
Formula The option to add a formula for multiple measures to specify what the

system must do to derive a metric. For example, if you add the Total Talk
Time measure and the Number of Interactions measure and specify
Average as the formula, the system calculates the AHT of all calls
handled by employees.

This field is only available when you select the metric source options as
Derived.

Metric The option to select a metric for creating a derived metric.

This field is available when you select the source as Derived.
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Name Description
Period The option to select the time period for the metric. The options are:

• Daily

• Weekly

• Monthly

• Quarterly

• Yearly

This field is available when you select the source as:

• Data Entry

• External Import
Aggregation The option to specify an aggregation to define what calculation is applied

to derive the metric. The options are:

• Average

• Sum

This option is available only when you select the metric source option as:

• Data Entry

• External Import
Units of Measure The unit of measure for the metric. All metrics are measured against a

number indicating a count or time indicating a period. For example, for
the AHT metric, the unit of measure is time. The options are:

• Number

• Time
Direction The option to specify the direction of the metric in increasing or

decreasing order in percentage for a particular period of time. For
example, for the AHT metric, you must specify a decreasing scale to see
this metric decrease for an agent. The options are:

• Increasing is Better

• Decreasing is Better

The increasing score is calculated by dividing your score divided by the
target score. The decreasing score is divided score is calculated by
dividing the target by your score.

Minimum Value The minimum value for a derived metric. You must type the specified
minimum value.

This option is available only when you select the metric source option as:

• Data Entry

• External Import

Table continues…

Analyzing contact center performance

October 2019 Using Avaya Workforce Optimization Select 274
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Name Description
Maximum Value The maximum value for a custom metric. You must type the specified

maximum value.

This option is available only when you select the metric source option as:

• Data Entry

• External Import
Association The option to specify to whom the metric calculation must be associated.

The options are:

• Employee

• Department

• Role

This option is available only when you select the metric source option as:

• Data Entry

• External Import

Metrics Views
Manage views

Using views, you can filter data by specific criteria.

Depending on the business requirement, you can create different views with filters using logical
conditions. For example, to search for metrics that are grouped by employee role, you can define
filters based on the designation of the employees in the organization. The view displays the
metrics that match the search criteria.

Note:

When you log in to the application for the first time, the system displays the default AWFOS View
with a preconfigured set of parameters. You can create a new view to search and play the desired
interactions.

After you create a view, you can use it anytime later.

You can do the following while creating views:

• Create multiple filters.

• Use the default view that comes with a preconfigured set of parameters.

• Define the search criteria with a comprehensive list of parameters.

• Share the new view with other users.
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Viewing Metrics
Procedure

1. Click Analyze > Metrics.

2. In the left pane, click Views.

3. Click one of the available views.

The system displays the details of the selected view in a tabular format .

4. (Optional) To view the selected metrics view in view mode, click View.

The system displays the metric on the View Mode screen with related details .

5.
(Optional) To view the selected metrics in full screen mode, click the  icon.

6. (Optional) To view the details in the Category column, click on the hyperlink.

You can drill down to the next level metrics in the hierarchy. For example: If you selected
the Group by use tags as Department, then you can click the particular Department and
the system displays the Employee-level metrics. If you further click the name of the
employee, the system displays the metric view output of the employee only. If there are
other employees reporting to that particular employee, then the system displays the names
of all the employees.

7. (Optional) To go back to the previous metric views, click the breadcrumbs provided on the
top of the page.

For example: To go back to the Department view, click Department on the top of the page
that displays Department>Employee.

Adding a metric view
Procedure

1. Click Analyze > Metrics.

2. In the navigation pane, click Views.

3. Click Add.

4. On the Create View page, enter the required details.

5. Click Save & Close.

6. (Optional) To add another metric view, click Save & Add another.

Setting up filters for a view
About this task
Using filters in view, you can add:

• Multiple search parameters within a single filter criteria.
• Multiple values separated by commas to match a single parameter .
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Procedure
1. In Filter add fields, operators and values for

a. In Field, select the field on which to apply the filter.

b. In Operator, select the operator which to apply.

c. In Value, enter the value that the records must match.

2. To add additional filters, click Add Field.

3. In Display Fields, select the fields to be displayed.

4. In Share, select the groups and employee to share the view.

5. To save the view, click the Save & Close button.

Configuring display fields for a view
About this task
When you select a view, you can view the details of the metrics in the list. All metric information is
not displayed. If you do not see the specific fields you are looking for, you can configure additional
fields to display in the list.

Procedure
To move fields to the Selected Metric(s) list:

1. Select one or more fields from the Available Metric(s) list by doing one of the following:

a. To search a metric, type the first few characters of the metric name in Search.

b. To move a single selection from the list, click the Move Selected button.

c. To move multiple selections from the list, click the Move All button.

To remove fields from the Selected Metric(s) list:

2. Select one or more fields from the Selected Metric(s) list by doing one of the following:

a. To search a metric, type the first few characters of the metric name in Search.

b. To remove a single selection from the list, click the Remove Selected button.

c. To move multiple selections from the list, click the Remove All button.

Next steps
Share a view.

Sharing a view
About this task
Use this procedure to share a view that you created so that other users can reuse the shared view
to search for metrics.
You can keep the saved view private or share the view with specific employees, or everyone. The
selected users can see the shared view in their saved views.
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Procedure
1. In Share, select one of the following :

• Me
• Selected Groups
• Everyone

2. To share the view with selected groups, select Selected Groups.

The system displays the Group and Employee search and select options.

3. Select one or more groups from the Available Groups list.

a. To search a group, type the first few characters of the group name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

4. To remove groups from the Selected Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

5. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in
Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

6. To remove employees from the Selected Employees list; select one or more employees
and use the Remove Selected and Remove All buttons.

7. Click Save and Close.

Create View field descriptions
Create View

Name Description
Name The name of the custom metric view.
Default The option to select a view as the default view.
Category The option to select a category for adding or creating a metric view or for

generating view output based on categories. The options are:

• Interactions

• Evaluate

• Coach & Learn

• System

You can also add system and custom categories.
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Name Description
Period Type The time period for which you want to create the metric view. The options

are:

• Weekly

• Monthly

• Quarterly

• Yearly
Period The option to select a time period based on the period type selected.

For example, if you choose period type as Weekly, the options can be
Current Week, Last Two Weeks, Last One Week + Current. Current Week
includes the beginning of the ongoing week to the day when the option is
selected. For example, if you are creating a metric view on Wednesday,
the current week is from Monday to Wednesday.

You can also enter a specific date range by selecting the Custom Period
option.

From The option to select a time period from when you want to add or create a
metric view or to generate a view output based on the period type
selected.

This option is only available when you select Custom Period in the
Period field.

To The option to select a time period until when you want to add or create a
metric view or to generate a view output based on the period type
selected.

This option is only available when you select Custom Period in the
Period field.

Show Only KPIs The option to filter metrics and choose KPIs while building metric views
for flagging metrics as KPIs.

Available Metric(s) The list of available metrics for creating a metric view. The list consists of
both system metrics and custom metrics.

Selected Metric(s) The list of metrics that are selected from the list of available metrics.
Group by The option to group the metrics view depending on the output. The

options are:

• Site

• Department

• Role

• Employee
Export The option to export the metric view on your system. The options are:

• Excel

• CSV
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Name Description
Filter The filter criteria used to search the metric.
Share The option to share your metric view with specific users. The options are:

• Me

• Selected Groups

• Everyone

Filter
Name Description
Field The option to filter a metric criteria. The options are:

• Role

• Department

• Employee

• Site
Value The option to enter the value, which must be based on the option selected in

the Field option. The default value is All.

For example: If you select Department, then you can type the value as Name
of the department. If you select Employee, then you can type the name of
one or more employee or retain the default value All to indicate all
employees.

Editing a metric view
Procedure

1. Click Analyze > Metrics.

2. Click Views and click the view that you want to edit.

3. Click Edit.
4. On the Edit View page, enter the required details.

5. Click Save & Close.

Edit View field descriptions
Edit View

Name Description
Name The name of the custom metric view.
Default The option to select a view as the default view.
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Name Description
Category The option to select a category for adding or creating a metric view or for

generating view output based on categories. The options are:

• Interactions

• Evaluate

• Coach & Learn

• System

You can also add system and custom categories.
Period Type The time period for which you want to create the metric view. The options

are:

• Weekly

• Monthly

• Quarterly

• Yearly
Period The option to select a time period based on the period type selected.

For example, if you choose period type as Weekly, the options can be
Current Week, Last Two Weeks, Last One Week + Current. Current Week
includes the beginning of the ongoing week to the day when the option is
selected. For example, if you are creating a metric view on Wednesday,
the current week is from Monday to Wednesday.

You can also enter a specific date range by selecting the Custom Period
option.

From The option to select a time period from when you want to add or create a
metric view or to generate a view output based on the period type
selected.

This option is only available when you select Custom Period in the
Period field.

To The option to select a time period until when you want to add or create a
metric view or to generate a view output based on the period type
selected.

This option is only available when you select Custom Period in the
Period field.

Show Only KPIs The option to filter metrics and choose KPIs while building metric views
for flagging metrics as KPIs.

Available Metric(s) The list of available metrics for creating a metric view. The list consists of
both system metrics and custom metrics.

Selected Metric(s) The list of metrics that are selected from the list of available metrics.
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Name Description
Group by The option to group the metrics view depending on the output. The

options are:

• Site

• Department

• Role

• Employee
Export The option to export the metric view on your system. The options are:

• Excel

• CSV
Filter The filter criteria used to search the metric.
Share The option to share your metric view with specific users. The options are:

• Me

• Selected Groups

• Everyone

Filter
Name Description
Field The option to filter a metric criteriabased on the following options:

• Role

• Department

• Employee

• Site
Value The option to enter the value based on the field entered in the Field option. The

default value is All.

For example: If you select Department, then you can enter the value as Name of
the department. If you select Employee, then you can retain the default value All
to indicate all employees, or type the names of the employees.

Downloading a metric view
Procedure

1. Click Analyze > Metrics.

2. To view the list of available metrics, click Views.

The system displays a list of the available metrics.

3. Click any of the available metric views you want to download.

The system displays the details of the metric view you select in a tabular format .
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4.
To download the selected metric view, click the  icon.

The system downloads the metrics as an Excel file.

Importing a custom metric
About this task
To create a custom metric, you can import the metric data from a file import or through a data
entry. Use this procedure to generate a template, replicate the required data, and import custom
metrics data from the external spreadsheet at employee level.

Procedure
1. Click Analyze > Metrics.

2. Click Custom Metric Import.
3. On the Metric Import Screen page, do the following:

a. Enter the required details in following fields:

• Association
• Period

You can enter only those details in the fields that are flagged for import when a metric
was defined.

b. Click Generate Template.

The system displays the hyperlink for downloading the template.

4. (Optional) To make changes to your template selections, click the Reset button.

5. Click DownloadTemplate.

The system downloads the template as an Excel file.

6. Enter and replicate the data in the file based on your requirements.

You can replicate multiple data entries by using this option at one go. For example, you
select time period as monthly, and create data for January. You can now replicate the
subsequent months at one time and change the name of the month to February, March,
and so on in the Excel file.

7. To import the .xls file, click Browse, and then click the Import button.
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Custom Metric Import field descriptions
Name Description
Association The option that was specified at the organization level while defining a

metric. The options are:

• Employee

• Department

• Role
Period The time period that was specified to define at what intervals the metric

must be calculated by the system. The options are:

• Daily

• Weekly

• Monthly

• Quarterly

• Yearly

Button Description
Generate template To generate a template.
Reset To reset the selections for the Association and Period fields.
Browse To open the file from your local machine.
Import To import the template after filling the data for the metric for a stipulated

period.

Creating a custom metric data entry
About this task
Use this procedure to create custom metrics by manually adding values for a metric. The values
are entered at a department, role, or employee level for a fixed period to define this metric.

Procedure
1. Click Analyze > Metrics.

2. Click Custom Metric Data Entry.

The system displays the Metric Data Entry Screen page.

3. In Metric, click an option depending on your requirements.

The system displays the time period and the option to type the values for your selected
association.
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4. Click Save.

The system displays a message that the metrics data is saved successfully.

Custom Metric Data Entry field descriptions
Name Description
Metric The name of the metric that was provided when defining a metric with the

source as Data Entry.
Time Period The option to select the dates for which the metric data entry is

applicable.

The time period is the same as the time that was selected while defining
the metrics.

Value The option to type a value for the association.

Use the minimum value and the maximum value column as guidelines to
type this value for each association.

Managing Scorecards

Scorecards overview
Scorecards are statistical templates that are used for deriving performance data by using various
metrics . Scorecards provide a systematic approach to measure, monitor, and act upon the
different metrics in a contact center environment. These metrics are used by supervisors and
managers to track and manage the performance of employees. You can build a scorecard at role,
department, employee, or site level by adding metrics to analyze the performance during a
specific period within your organization .

Depending on the kind of performance scorecard report you want to generate, you can build
customized scorecards by using various filters. You can build time-based scorecards by
associating one or more metrics, adding categories to group multiple metrics, and defining grades.
The grades are defined at the metric level, category level, and at the scorecard level based on
your specific requirements. The grading level in scorecards is used only for the purpose of
grouping metrics.

Scorecards can be divided into two types depending on their views:

• Scorecard view: To generate reports for generic performance measurement based on
employee, role, department, and site.
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• Performance view: To view the relative performance of an employee at role and department
levels. For example, using a performance scorecard, you can view the top or bottom
performers in a department.

Viewing scorecard templates
About this task
With appropriate permissions, you can view the scorecard templates that you created. You can
also view the scorecards that are created by another user and already exist in the system.

Procedure
1. Click Analyze > Scorecards.

2. On the Scorecards screen, click Scorecard.

The Scorecard page displays a list where you can see the details of the scorecard
templates.

3. (Optional) To view the revisions of a particular scorecard, click the  next to the
scorecard.

The Scorecard page displays the expanded view of all the versions for the scorecard.

4. Click Analyze > Metrics.

The Definition tab on the left panel gets selected. The system displays the Metric page
with the details of the available metrics.

5. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

6. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

7. (Optional) To clear the filters from all the columns, click the  icon.

8. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

9. (Optional) To reset the sorting, click the  icon.

Viewing saved scorecards
Procedure

1. Click Analyze > Scorecards.
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2. On the Scorecards screen, click the  icon next to the Saved Scorecards x, where x is
the number of scorecards saved in your application.

The system displays all the scorecards saved according to category.

3. To view the details of the saved scorecards in a particular category, click the  icon.

The system displays the scorecards list in that category.

4. In the scorecard list, click the scorecard that you want to view.

The system displays the details of the scorecard in a tabular format.

View Scorecards field descriptions
Name Description
Add Scorecard The option to add a new scorecard.
Scorecard The name of the scorecard.
Grading Level The option to define at what value level the scorecard is graded. The

options are:

• Category level

• Metric level

• Scorecard level

The scores graded at the grading level gets selected in the scorecard
definition interface. For example, if the grading level is category, the
metric scores gets grouped to the corresponding category and the output
is graded at the categories.

Target The option to enter a value to define the scorecard target. The target can
be any of the following:

• Time in hh/mm/ss format upto 23:59:59

• Number upto 10,000

• Percentage upto 100%
Effective From The date from which the scorecard is applied. The date is in the mm/dd/

yyyy format.
Status The status of the scorecard. The options are:

• Draft

• Active

A scorecard is in Draft status until all the steps and their definitions are
complete and you do not click the Publish tab. The status changes to
Active from Draft when you publish it. You can then save it for different
purposes.
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Name Description
Version The version number of the scorecard. The system displays the latest

version as the default version. You cannot roll back to a previous version.
However, you can view the details of any of the previous versions, and
use the information to create a new scorecard template.

Created By The name of user who created the scorecard.
Created Date The date and time on which the scorecard was created. The date is in the

mm/dd/yyyy format hr/min/sec format.
Updated By The name of the user who updated the scorecard.
Updated Date The date on which the scorecard was updated. The date is in the mm/dd/

yyyy hr/min/sec format.
Used in Scorecard The number of scorecards in which the scorecard template is used. The

system displays whole numbers only.
Description The description of the scorecard.

Do not create a new revision of a scorecard, if there is a change in the
title or description of the scorecard.

Creating or adding a scorecard
About this task
Use this procedure to create a scorecard using one or more system or custom metrics.

Procedure
1. Click Analyze > Scorecards.

2. Click Scorecard.

3. On the Scorecard screen, click the Add Scorecard button.

Avaya Workforce Optimization Select displays the Create Scorecard page.

4. On the Definition tab, enter the required details.

Avaya Workforce Optimization Select displays the scorecard in the scorecard view in the
draft status. You cannot run the scorecard to generate an output in the draft state, until you
enter the details in the remaining tabs.

5. Click Save.

Avaya Workforce Optimization Select displays the message that the scorecard is saved
successfully and the remaining tags get enabled.

6. Click the Metric tab, and click Add Category.

Avaya Workforce Optimization Select displays dynamic fields.

7. Enter the required details and click Save.
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Avaya Workforce Optimization Select displays the message that the scorecard is saved
successfully.

8. (Optional) To add another category, click Add Category.

9. Click the Grades tab.

10. Select one of the following and enter the required details:

• Grading Scale: This is the default option.

• Make or Break
11. Click Save.

Avaya Workforce Optimization Select displays the message that the scorecard grading is
saved successfully.

12. Click the Share tab and select the required option.

13. Click Save

Avaya Workforce Optimization Select displays the message that the scorecard details are
saved successfully.

14. To preview the details of the scorecard in a read-only mode, click the Preview tab. You can
go back to any of the tabs to make changes to your scorecard, if required.

15. To publish the scorecard select one of the options from the Effective Date field, and then
click Publish.

Avaya Workforce Optimization Select displays the message that the scorecard is published
successfully. The scorecard status changes from draft to active in scorecards view, and
you can save the scorecard for future use.

Editing a scorecard
About this task
Use this procedure to edit an existing scorecard and saving as a revision for future reference. Do
not create a new revision if the title or description of an existing scorecard is changed. The
Grading Level field is disabled in edit mode.

Procedure
1. Click Analyze > Scorecards.

2. Click Scorecard.

3. On the Scorecard screen, select the scorecard that you want to edit, and click Edit.
4. On the Definition tab, enter the required details.

Avaya Workforce Optimization Select displays the scorecard in the scorecard view in the
draft status. You cannot run the scorecard to generate an output in the draft state, until you
enter the details in the remaining tabs.
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5. Click Save.

Avaya Workforce Optimization Select displays the message that the scorecard is saved
successfully and the remaining tags get enabled.

6. Click the Metric tab, and click Add Category.

Avaya Workforce Optimization Select displays dynamic fields.

7. Enter the required details and click Save.

Avaya Workforce Optimization Select displays the message that the scorecard is saved
successfully.

8. (Optional) To add another category, click Add Category.

9. Click the Grades tab.

10. Select one of the following and enter the required details:

• Grading Scale: This is the default option.

• Make or Break
11. Click Save.

Avaya Workforce Optimization Select displays the message that the scorecard grading is
saved successfully.

12. Click the Share tab and select the required option.

13. Click Save

Avaya Workforce Optimization Select displays the message that the scorecard details are
saved successfully.

14. To preview the details of the scorecard in a read-only mode, click the Preview tab. You can
go back to any of the tabs to make changes to your scorecard, if required.

15. To publish the scorecard select one of the options from the Effective Date field, and then
click Publish.

Avaya Workforce Optimization Select displays the message that the scorecard is published
successfully. The scorecard status changes from draft to active in scorecards view, and
you can save the scorecard for future use.
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Create, Add, or Edit Scorecards field descriptions
Name Description
Definition The option to define a new scorecard. The criteria are:

• Organization units, departments, or designations

• Daily, Weekly, Monthly, Quarterly, or Yearly

• Existing set of metrics

• Grading level: Category, metrics, and scorecard levels

• Weightages and targets at the metric level
Metric The option to select one or more metrics for a scorecard.
Grades The option to describe a grade. Some of the options are:

• Excellent

• Good

• Poor

You can add customized grades based on the need of the organization.
The grades are also associated with colors. For example: Excellent can
be mapped with green, and a poor grade can be mapped with red.

Share The option to share a scorecard. The options are:

• Me

• Selected Groups

• Every one
Preview The option to view the completed scorecard draft and make any changes

if required. This option also contains the Publish button to change the
status of the scorecard from draft to active. You can save a scorecard
only when the status is active.

Definition

Name Description
Name The name of the scorecard.
Alias The alias name of the scorecard.
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Name Description
Target The time period for which you are creating the scorecard.

You can choose only the next target levels in the target hierarchy. For
example: For a daily scorecard, you can choose only daily as the metrics.
For weekly, you can choose daily and weekly. Again, for yearly targets,
you can choose daily, weekly, monthly, quarterly, and yearly metrics as
the target time.

If you want to change the target for a particular scorecard, you must
delete the scorecard and create a new one with the required definitions.

Grading Level The option to define at what value level the scorecard is graded. The
options are:

• Category level

• Metric level

• Scorecard level

The scores graded at the grading level gets selected in the scorecard
definition interface. For example, if the grading level is category, the
metric scores gets grouped to the corresponding category and the output
is graded at the categories.

The Grading Level field is disabled in edit mode.
Description A brief description of the scorecard.
Scorecard Association The associated field, operator, and value for a scorecard view.
Field The parameters used to filter the scorecards. The options are:

• Role

• Department

• Site

You can add more than one field depending on your requirements.

Table continues…
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Name Description
Operator The operator used to specify the scorecard criteria. The options vary

depending on the field that you select.

For Role:

• All

• Agent

• Role 1: This is a variable. You can add customized roles depending on
the need of your organization.

• Supervisor

For Department:

• All

• Dept 1: This is a variable. You can add customized departments
depending on the need of your organization.

• IT

• Operations

For Site:

• All

• Site 1: This is a variable. You can add customized departments
depending on the need of your organization.

Value The value specified for the operator to apply in the scorecard.

Metric

Name Description
Category The option to provide a category for defining a metric. The options are:

• Interactions

• Evaluations

• Coach

• Learn

You can also add customized options as required.

This option is mandatory for a category-level and metric-level scorecard.
For scorecard-level metrics, the category field is optional.

If the definition of category is complete the color associated with it is
green. If it is incomplete, the color is red.

You can also delete a category if no metrics are associated with the
particular category.

Table continues…
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Name Description
Metric The option to associate a metric to a scorecard. The options vary

depending on your selections while defining the scorecard in the
Definition tab.

Target The target time or number for which the metric is associated to the
scorecard.

You can add whole numbers or time in hh:mm:ss format .
Units of Measure The unit of measure for calculating the target for a metric. The options

are:

• Number

• Time
Weight The weightage given to each metric within a category and at all grading

levels. The weightage must follow the following rules:

• The sum of category weights must sum up to 100%

• The sum of metric weights within a category must sum up to 100%
Display Order The order in which the metrics are displayed. The system displays the

order in whole numbers only.

Grades

Name Description
Grading Scale The option to define multiple metric or category value ranges and grade

each of them. This is the default option.

You can select distinct colors for each grading range defined.
Make or Break The option to create a make or break range and assign a corresponding

score to the threshold value. When you add a value in the Value field, the
value in percentage gets automatically displayed in the Value(%) field.

Grading Scale
Name Description
Metric Value
From The option to enter the lower bound metric value for a grading scale.

The corresponding percentage gets populated automatically in the From (%)
field.

To The option to enter the upper bound metric value for a grading scale.

When you enter the upper bound metric value, the corresponding percentage
gets populated automatically in the To (%) field.

Score
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Name Description
Type The type of score associated with a scorecard. The options are:

• Varying

• Fixed
From The option to enter the lower bound score value for a grading scale.

For example, if you enter the From range as 50 and the To range as 100, the
scorecard displays the absolute score of the employee within the range of 50 to
100.

The application displays to the accuracy of two decimals. Natural numbers are
not supported.

To The option to enter the upper bound score value for a grading scale.

For example, if you enter the From range as 50 and the To range as 100, the
scorecard displays the absolute score of the employee within the range of 50 to
100.

Grade
Grade The option to apply grades to a particular scorecard metric.

For example: You can select A, B, and C.

You can add customized grades based on the needs of the organization. The
grades are also associated with colors.

Color The option to associate a color to a grade.

For example: An A grade can be mapped to green , and a C grade can be
mapped to red.

Make or Break
Name Description
Metric Value
Operator The option to select the relational operator around a metric or category value to

create a make or break range.

The option to select a criteria for assigning a threshold value to create a make
or break range. The options can be:

• Greater Than or Equal To

• Lesser Than or Equal To
Value The option to enter the lower bound metric value for a grading scale.

The corresponding percentage gets populated automatically in the From (%)
field.

Score
Score The option to enter a threshold value to create a make or break range.
Grade
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Name Description
Grade The option to apply grades to a particular scorecard metric.

For example: You can select A, B, and C.

You can add customized grades based on the needs of the organization. The
grades are also associated with colors.

Color The option to associate a color to a grade.

For example: An A grade can be mapped to green , and a C grade can be
mapped to red.

Share

Name Description
Me The option to not share the scorecard .

This is the default option.
Selected Groups The option to share the scorecard with selected groups within the

organization.
Everyone The option to share the scorecard with everyone who has the appropriate

permissions.

Preview

Name Description
Scorecard Effective The option to select the date from which the scorecard must be applied.

The date is in the mm/dd/yyyy format. You can apply it immediately or
from a later date .

The effective date must be from the beginning of a period. For example, if
it is monthly, the selected date must be from the beginning of next month.
If it is for next year, the selected date must be from the beginning of next
year.

Publish The option to publish a scorecard. A scorecard becomes active only after
it is published and available for saving.

Running a scorecard
Procedure

1. Click Analyze > Scorecards.

2. On the Scorecards screen, click one of the following:

• Scorecard
• Saved Scorecard x, where x is the number of scorecards saved in your application.

The Scorecard page displays a list of available scorecards.

3. Select the scorecard that you want to modify, and click Run.
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Based on your selections , the system displays dynamic fields for the particular scorecard.

4. Select one of the following and enter the required details:

• Scorecard View: This is the default option.

• Performance View
5. Click Run.

The system displays the requested output in a tabular format.

6. (Optional) To edit the output, click Edit.
Repeat Step 4 and Step 5.

7. (Optional) To save the output, click Save as.

a. In the pop-up window, enter a name, category, and the export format option.

b. Click Submit.

The system displays the message that the scorecard is saved successfully. You can view
the scorecard in Saved Scorecards x.

Run Scorecard field descriptions
Scorecard View

Name Description
Run The option to run a saved scorecard template to add filters to the

scorecard.
Scorecard View The option to create a view for a scorecard for employee, role,

department, and site levels.
Period The time period that was selected while creating the scorecard.

Based on the period selected you can further select the time period from
the drop-down list. For example, if you choose period type as Weekly, the
options can be Current Week, Last Two Weeks, Last One Week +
Current and so on. Current week refers from the beginning of the ongoing
week to the day when the option is selected. For example, if you are
creating a metric view on Wednesday, the current week is from Monday
to Wednesday.

If you select the Custom Period option, then you can view the specific
date range for that scorecard.

Version The option to select a version each time you change the filters in a
scorecard.

Field The scorecard association that was selected while creating the
scorecard.

Value The option to enter a value depending on the Field that you select.
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Name Description
Group by The field to group scorecards output types. The options are:

• Site

• Department

• Role

• Employee

Performance View

Name Description
Run The option to run a saved scorecard template to add filters to the

scorecard.
Performance View The option to create a view for a scorecard for measuring relative

performance of employees.

Using this option, you can view the top or bottom performers for the
selected category and metric.

Category The option to group one or more metrics based on a category.
Metric The option to create scorecards at metric level. You can create a

performance view to rate the performance of employees.
Order The order for selecting the performance view of employees. The options

are:

• Top

• Bottom

For both the options, you can select one of the following numbers : 3,
5,10, or 15.

Only a supervisor can see the names of the employees for this selection.
If you are a contact center agent, then you can only see your ranking in
the list. For the other employees, the system displays options such as
Employee1 and Employee2 instead of the employee name.

Period The time period that was selected while creating the scorecard.

Based on the period selected you can further select the time period from
the drop-down list. For example, if you choose period type as Weekly, the
options can be Current Week, Last Two Weeks, Last One Week +
Current and so on. Current week refers from the beginning of the ongoing
week to the day when the option is selected. For example, if you are
creating a metric view on Wednesday, the current week is from Monday
to Wednesday.

If you select the Custom Period option, then you can view the specific
date range for that scorecard.

Version The version that was selected while defining the scorecard template.

Table continues…
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Name Description
Field The option to select employees based on the following options:

• Site

• Department

• Role

• Employee
Value The option to enter the value based on the field entered in the Field

option above. The default option is All.

For example: If you select Department, then you can enter the value as
Name of the department. If you select Employee, then you can retain the
default value All to indicate all employees, or type the names of the
employees.

Generating and saving a scorecard view
Procedure

1. Click Analyze > Scorecards.

2. Click Scorecard.

The Scorecard page displays a list of available scorecards.

3. Select the scorecard for which you want to generate the scorecard view, and click Run.

4. Select the Scorecard View option, enter the required details, and click Run.

The Scorecard page displays the template output in a tabular format.

5. (Optional) To edit the view, click Edit.
Repeat Step 4.

6. (Optional) To save the output, click Save as.

a. In the pop-up window, enter a name, category, and the export format option.

b. Click Submit.

The system displays the message that the scorecard is saved successfully. You can view
the scorecard in Saved Scorecards x.

7. (Optional) To view the card from the Save Scorecards section, click one of the following
depending on the type of scorecard:

• Save Scorecards > Custom: To view saved custom scorecards.

• Save Scorecards > System: To view saved system scorecards.

• Save Scorecards > category name: To view the saved scorecards in any other
category.
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Scorecard View field descriptions
Name Description
Period The time period that was selected while creating the scorecard template.

Based on the period selected you can further select the time period from
the drop-down list. For example, if you choose period type as Weekly, the
options can be Current Week, Last Two Weeks, Last One Week +
Current and so on. Current week refers from the beginning of the ongoing
week to the day when the option is selected. For example, if you are
creating a metric view on Wednesday, the current week is from Monday
to Wednesday.

If you select the Custom Period option, then you can view the specific
date range for that scorecard.

Field The option to select employees based on the following options:

• Site

• Department

• Role

• Employee
Group by The field to group scorecards based on the output type. The options are:

• Site

• Department

• Role

• Employee

Button Description
Run To generate the scorecard template.

Generating and saving a performance view
About this task
Use this procedure to create a scorecard template for a performance view. Using this scorecard,
you can view the performance of an organization at an employee level, for example, you can view
the top 3, 5, or 10 performers.

Procedure
1. Click Analyze > Scorecards.

2. Click Scorecard.
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3. From the available list of scorecards, select the scorecard for which you want to generate
the scorecard view, and then click Run.

4. Select the Performance View option and enter the required fields.

The system displays the template output in a tabular format.

5. (Optional) To edit the view, click Edit.
Repeat Step 4.

6. (Optional) To save the output, click Save as.

a. In the pop-up window, enter a name, category, and the export format option.

b. Click Submit.

The system displays the message that the scorecard is saved successfully. You can view
the scorecard in Saved Scorecards x.

7. (Optional) To view the card from the Save Scorecards section, click one of the following
depending on the type of scorecard:

• Save Scorecards > Custom: To view saved custom scorecards.

• Save Scorecards > System: To view saved system scorecards.

• Save Scorecards > category name: To view the saved scorecards in any other
category.

Performance View field descriptions
Name Description
Category The option to categorize performance scores.

The default option is All.
Metric The option to select a metric for generating the scorecard.

The default option is All.
Order The order in which the performance rating must display. The options are:

• Top

• Bottom
Version The option to provide a version number of the scorecard template.
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Name Description
Period The time period specified while creating the scorecard template. This is a

pre-populated field.

Based on the period selected you can further select the time period from
the drop-down list. For example, if you choose period type as Weekly, the
options can be Current Week, Last Two Weeks, Last one week + current
and so on. Current week refers from the beginning of the ongoing week to
the day when the option is selected. For example, if you are creating a
metric view on Wednesday, the current week is from Monday to
Wednesday.

If you select the Custom Period option, then you can view the specific
date range for that scorecard.

Field The option to select the organization unit. The options in this field were
specified while creating the scorecard template, except for the last option
where you must select Role, Department, or Site.

Value The option to enter the values depending on the selected Field.

The default option is All.

Save Performance View Scorecard

Name Description
Name The name of the scorecard view.
Category The option to categorize a scorecard. The options are:

• Admin

• Coach & Learn

• Custom

• Evaluate

• Interactions

• System

You can also add customized categories depending on your business
needs.

Export The option to export the view in one of the following formats:

• Excel

• CSV

Button Description
Run To run a saved scorecard template to add filters to the scorecard.
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Scorecard output drill-down options
You can group the scorecard outputs by using the Group by option. Scorecard outputs include the
scorecard view and the performance view. Groups can be classified based on site, department,
role, or employee. Each employee can view scorecard outputs of all the employees who are
directly below that employee in the organizational hierarchy.

Refer to the following example to understand the drill-down options available for each employee in
a scorecard output.

The following flowchart provides the access level for each designation. This is only a sample
organizational hierarchy. In a real life scenario, the flowchart displays the names of the employees
instead of the specific designations, and Site 1 and Site 2 is replaced by the names of the actual
geographical locations.

Note:

• Site 1: Gray color

• Site 2: Blue color

Evaluator 1 Evaluator 2

Manager 1
Quality

Evaluator 3 Evaluator 4

Manager 2
Quality

Senior Manager 1
Operations

Senior Manager 2
Operations

Vice President
Quality

Vice President
Operations

Manager 1
Operations

Manager 2
Operations

Agent 5 Agent 6 Agent 7 Team Lead 3

Agent 8 Agent 9

Agent 1 Agent 2

Team Lead 1

Agent 3 Agent 4

Team Lead 2

Senior
Vice President

The access level to the scorecard output for the designations are as follows:

Senior Vice President: 

If you are the Senior Vice President, generating the scorecard output, with the Group by option as
Site, you get a snap shot of both the sites, Site 1 and Site 2.
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If you click on Site 1, you can view the details of the employees within the Senior Vice President
hierarchy and the employees associated to that site as follows:

• Senior Manager 1, Operations: When you, as the Senior Vice President, click on the
employee who is the Senior Manager 1, Operations, you can drill down until the last node in
the hierarchy. The sample is as follows:

- Manager 1, Operations

• Team Lead 1

- Agent 1

- Agent 2

• Team Lead 2

- Agent 3

- Agent 4 – The output does not display this employee, who is the Agent 4, because
this employee belongs to a different geographical location, that is, Site 2 and not to
Site 1.

If you, as the Senior Vice President, click on Site 2, you can view the details of the employees
within the Senior Vice President hierarchy and the employees associated to that site as follows:

• Vice President, Operations — When you click on the employee who is Vice President,
Operations, you can drill down to the next level and view the direct reports and continue until
the last node in the hierarchy.

- Senior Manager 2, Operations

• Manager 2, Operations

- Agent 5

- Agent 6

- Agent 7

- Team Lead 3

• Agent 8

• Agent 9

- Agent 4

• Vice President, Quality

- Manager 1, Quality

• Evaluator 1

• Evaluator 2

- Manager 2, Quality

• Evaluator 3
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• Evaluator 4

Based on the hierarchy and the access privileges, all employees in the organization can perform
the drill downs for the employees within the respective hierarchy.
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Chapter 10: Analyze Speech

Speech overview
With the Speech module, you can perform precision search of recorded interactions. The third-
party engine transforms audio recordings into actionable assets by producing search-optimized
text output from single or multi-speaker audio file. You can search specific data from a large
number of recorded interactions and provide valuable insights into the operations of the call
center.

Using the Speech module you can take advantage of the following features:

• Phrase Sets: Create your library of words and phrases to track agent’s performance as a
supervisor.

• Search: Define your search criteria based on your business requirement.

• Business Criteria: Save the search as a business criteria to reuse or share the search criteria
with one or more users..

• Results: View and manage speech results.

Avaya Workforce Optimization Select transcribes recorded interactions and identifies words and
phrases defined as part of the search criteria, and highlights the words and phrases in the
transcript.

Note:

You can manage phrase sets, searches, business criteria, and speech results only if you have
the appropriate permissions. For more information about permissions and privileges, contact
your system administrator.

Phrase sets
Using phrase sets, you can:

• Create your library of words, and phrases.
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• Select the following logical conditions to define the search criteria for phrases within a phrase
set:

- Any of these (OR): Avaya Workforce Optimization Select searches for interactions that
have at least one of the phrases defined in the phrase set and highlights the phrase in the
result.

- All of these (AND): Avaya Workforce Optimization Select searches for interactions that
have all the phrases defined in the phrase set and highlights the phrase in the result.

- None of these (NOT): Avaya Workforce Optimization Select searches for interactions that
do not have any of the phrases defined in the phrase set and renders those interactions as
part of the result.

Viewing phrase sets
About this task
Use this procedure to view the list of available phrase sets.

Procedure
1. Click Speech > Phrase Sets.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To add a phrase set, click Add Phrase Set.
7. (Optional) To edit a phrase set, click on the phrase set that you want to edit.

8. (Optional) To delete a phrase set, click on the radio button next to the phrase set, and
click Delete.

Phrase Sets field descriptions
Name Description
Name The name of the phrase set.
Description The description of the phrase set.
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Name Description
Used in Business Criteria The number of business criteria that the phrase set is used in. You can

click on the number or hover your mouse to view the name of the
business criteria.

Created/Updated On The date and time when the phrase set was created or updated. The date
and time is in mm/dd/yyyy hh:mm:ss format.

Created/Updated By The name of the employee by whom the phrase set was created or
updated.

Status The status of the business criteria. The options are:

• Active: The default value. You can choose a phrase set while
performing searches only if the phrase set is active.

• Inactive: Inactive phrase sets are not available for selection when you
define a search or edit a business criteria.

Button Name Description
Add Phrase Set To add a phrase set.
Delete To delete a phrase set.

The deletion of a phrase set does not impact any prior searches
performed using the same phrase set.

Creating phrase sets
About this task
Use this procedure to create phrase sets by adding words or phrases and logical conditions to a
phrase set.

Procedure
1. Click Speech > Phrase Sets.

2. On the Phrase Sets page, click Add Phrase Set.
3. On the Add Phrase Set page, enter the appropriate details and click one of the following:

• Save & Add Another: To save the phrase set that you created and add another phrase
set.

• Save & Close: To save the phrase set that you created.

The Phrase Sets page displays the new phrase set that you created.
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Add Phrase Set field descriptions
Name Description
Phrase Set The name of the phrase set that you are creating.

You can enter up to 100 characters in this field.

This field is mandatory.
Description A brief description of the phrase set.

You can enter up to 500 characters in this field.
Active The option to select the phrase set as an active phrase set.

By default, Active is selected.

You can choose a phrase set while performing searches only if the
phrase set is active.

Word/Phrase The word or phrase that you want the speech engine to search for within
interactions.

You can enter up to 500 characters in this field.

This field is mandatory.
Conditions The logical conditions that define the search criteria for phrases within a

phrase set. The options are:

• Any of these (OR): Avaya Workforce Optimization Select searches for
interactions that have at least one of the phrases defined in the phrase
set and highlights the phrase in the result.

• All of these (AND): Avaya Workforce Optimization Select searches for
interactions that have all the phrases defined in the phrase set and
highlights the phrase in the result.

• None of these (NOT): Avaya Workforce Optimization Select searches
for interactions that do not have any of the phrases defined in the
phrase set and renders those interactions as part of the result.

Search
Using the Search feature, you can either transcribe or search for specific words and phrases in the
transcript. You can:

• Create searches based on existing phrase sets. You can add or remove words or phrases
within an existing phrase set.

• Refine your search criteria using filters based on numerous parameters.

• Save the search as a business criteria for reuse. Additionally, you can:

- Share the business criteria with selected employees or everyone.

Search
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- Add tags or select from a list of existing tags to the business criteria. Avaya Workforce
Optimization Select searches for interactions based on the tags you add.

Note:

You can run a search without saving it as a business criteria. Navigate to the Results page to
view the request status and cancel or delete a requrest. You can also play the interactions that
match your search criteria.

Create a search criteria
Selecting a phrase set

About this task
Use this procedure to select a phrase set for which you want to perform speech-based searches
on interactions.

Procedure
1. Click Speech > Search.

2. On the Search page, click the Phrase Set tab.

3. To transcribe all interactions that meet your search criteria, click the Transcribe only
checkbox.

4. To configure a phrase set, clear the Transcribe Only checkbox, and enter the appropriate
details.

5. Click Save.

Next steps
Define employee selection.

Defining the employee selection criteria
About this task
Use this procedure to select employees whose interactions must be picked as part of the ad hoc
search for speech analysis.

Procedure
1. Click the Employee Selection tab.

2. In the Employee Filter section, specify the search criteria to filter employees.

a. In Field, select the fields by which you want to filter employees to assign to the plan.
b. In Operator, select the operator for the filter.
c. In Value, enter the value that the records must match.
d.

(Optional) To add multiple filters, click the  icon.
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e. Click Apply Filter.

The Employee List section displays the list of employees that match the search
criteria.

Next steps
Define interaction selection.

Defining the interaction selection criteria
About this task
Use this procedure to define interactions that must be picked as part of the search criteria for
transcription.

Procedure
1. Click the Interaction Selection tab.

2. To specify the search criteria to filter interactions to be evaluated do the following:

a. In Field, select the fields by which you want to filter interactions to assign to the plan.

b. In Operator, select the operator for the filter.

c. In Value, enter the value that the records must match.

d.

To add multiple filters, click the  icon.

3. Click Run to run the search.

Note:

You can run a search without saving it as a business criteria. Navigate to the Results
page to view the request status and cancel or delete a requrest. You can also play the
interactions that match your search criteria.

Next steps
Save the search as a business criteria.

Saving the search
About this task
Use this procedure to save the search as a business criteria for reuse.

Procedure
1. In the Save Settings tab, in Business Criteria, enter the name by which you want to save

the search.

2. In Description, enter a description for the business criteria.

3. To activate the business criteria, select Active.
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4. From Share, select one of the following to share the search with other users.

• Me: To configure the security option for the business criteria.

• Selected Groups: To share the search with the groups that you have access to.
Employees belonging to the group can use the search.

• Everyone: To share the search with all available users.

5. To share the search with specific employees and groups, select Selected Groups.

The system displays the Group and Employee search and select options.

6. To remove groups from the Selected Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

7. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in
Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

8. To remove employees from the Selected Employees list; select one or more employees
and use the Remove Selected and Remove All buttons.

9. In Tag(s), do any on of the following:

a. Enter comma-separated multiple search tags.

b. Select from existing system or custom tags.

10. Click Save & Close to save and close the search.

The search is saved in the Business Criteria page.

11. Click Run to run the search.

12. Click Reset to reset the selection.

Search field descriptions
Phrase Set

Name Description
Transcribe Only The option to only transcribe all the interactions that meet the search

criteria.

Note:

Clear the Transcribe Only check box to configure a phrase set.
Phrase Set The option to select from a list of available phrase sets.

Table continues…
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Name Description
Word/Phrase The word or phrase that you want the speech engine to search for within

interactions.

You can add or remove a word or phrase within a phrase set.
Conditions The logical conditions that define the search criteria for phrases within a

phrase set. The options are:

• Any of these (OR): Avaya Workforce Optimization Select searches for
interactions that have at least one of the phrases defined in the phrase
set and highlights the phrase in the result.

• All of these (AND): Avaya Workforce Optimization Select searches for
interactions that have all the phrases defined in the phrase set and
highlights the phrase in the result.

• None of these (NOT): Avaya Workforce Optimization Select searches
for interactions that do not have any of the phrases defined in the
phrase set and renders those interactions as part of the result.

Employee Selection

Filter Description
Field The parameters used to filter the search results for employees. The

options are:

• DP OU

• Department

• Employee

• Groups

• Organization Unit

• Reporting To

• Role

• Site

• Tenure (Weeks)
Table continues…
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Filter Description
Operator The Operator relative to the field selected. The options are:

• Equals To

• Not Equal To

• Contains

• Does Not Contain

• Starts With

• Does Not Start With

• Ends With

• Does Not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between

The default value is Equals.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

Field

Name Description
Department To search for interactions of employees who belong to the specified

department.
DP OU To search for interactions of employees based on the partition of the

organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Employee To search for interactions based on the employees that you have access

to.
Groups To search for interactions of employees belonging to the specified group.
Organization Unit To search for interactions based on the name of the organizational unit.
Role To search for interactions of employees with the specified designation or

role.

Table continues…
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Name Description
Site To search for the interactions of employees belonging to the specified

site.
Reporting To To search for interactions based on the name of the supervisor.
Tenure (Weeks) To search for interactions based on the tenure of the employee in weeks.

Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Employee List

Name Description
Employee The name of the employee to whom the coaching assignment is

assigned.
Tenure (Weeks) The tenure in weeks of the employee in the organization.
Reporting to The reporting manager of the employee.
Department The department that the employee belongs to.
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Interaction Selection

Name Description
Field The parameters used to filter the search results. The options are:

• Agent ID

• Archived

• Called Party

• Calling Party

• Channel

• Commented

• Duration

• Evaluated

• Extension

• Flagged for QA

• Hold Duration

• Interaction Comments

• Interaction Ended By

• Interaction Tags

• Interaction Type

• Interaction ID

• No of Holds

• No of Transfers

• Queue

• Screen Captures

• Source Type

• Tagged

• Transfer Number

• Transfer Type

• Variables 1–10

• VDN

Table continues…
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Name Description
Operator The Operator relative to the field selected. The options are:

• Equals To

• Not Equal To

• Contains

• Does Not Contain

• Starts With

• Does Not Start With

• Ends With

• Does Not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between

The default value is Equals.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

Field

Name Description
Agent ID To search for interactions of employees with the specified agent or

network ID.
Archived To search for interactions that are archived.

The options to filter interactions based on archiving from the Value field
are:

• Yes: To filter the interactions that were archived.

• No: To filter the interactions that were not archived.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.
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Name Description
Channel The type of channel in which the interaction is recorded. The options are:

• Chat

• Email

• Voice
Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Duration To search for interactions by the duration specified in the hh:mm:ss

format.
Evaluated To search for evaluated interactions.
Flagged for QA To search for interactions that are flagged for QA.

The options to filter interactions based on flagging from the Value field
are:

• Yes: To filter the interactions that were flagged for QA.

• No: To filter the interactions that were not flagged for QA.
Extension To search for interactions by the extension number of the employee.
Hold Duration To search for interactions based on the hold duration.
Interaction Comments To search for interactions based on specific comments provided by

employees.
Interaction Date To search for interactions based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

You can also search for interactions for a specific date range.
Interaction Ended By To search for interactions based on who ended a interaction. The options

are:

• Agent

• Customer
Interaction ID To search for interactions based on the interaction ID.
Interaction Tags To search for interactions based on the specific tags used for association.
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Name Description
Interaction Type To search for interactions based on the type of interaction.
No of Holds To search for interactions with the specified number of holds.
No of Transfers To search for interactions with the specified number of transfers.
Queue To search for interactions by the queue that the interaction is associated

with.
Screen Captures To search for interactions with screens.
Source Type To search for interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Tagged To search for tagged interactions.

The options to filter interactions based on tags from the Value field are:

• Yes: To filter the interactions that were tagged.

• No: To filter the interactions that were not tagged.
Transfer Number To search for interaction based on the station or the extension number of

the party to whom the interaction is transferred.
Transfer Type To search for interactions based on how you transfer a call. The options

are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

Variables 1–10 To search for interactions based on custom variables defined for your
business.

VDN To search for interactions based on an extension number that is used to
enable calls to connect to a vector for processing.
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Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Save Settings

Name Description
Business Criteria To save the search as a business criteria.
Description To enter a description for the business criteria.
Active To activate the business criteria.
Tag(s) To select one or more interaction tags and associate the tags when the

search criteria fetches one or more interaction.
Share To share the business criteria. The options are:

• Me

• Selected Groups

• Everyone

Button Name Description
Reset To reset the selection.
Save & Close To save the search.
Run To run the search.
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Business criteria
Using the Business Criteria feature, you or the user with whom the business criteria is shared can
reuse the saved search criteria.

Viewing business criteria
About this task
Use this procedure to view the list of available business criteria.

Procedure
1. Click Speech > Business Criteria.

The page displays a list of all searches that you saved as business criteria.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To run the business criteria, click on the radio button next to the business
criteria, and click Run.

7. (Optional) To edit the business criteria, click on the radio button next to the business
criteria, and click Edit.

8. (Optional) To delete a business criteria, click on the radio button next to the business
criteria, and click Delete.

Business criteria field descriptions
Name Description
Name The name you provided while saving the search as a business criteria.
Description The description you provided while saving the search as a business

criteria.
Last Run On The date and time when the business criteria was last run. The date and

time is in mm/dd/yyyy hh:mm:ss format.

Table continues…

Business criteria

October 2019 Using Avaya Workforce Optimization Select 321
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Name Description
Last Run By The name of the employee by whom the business criteria was last run.
Created On The date and time when the business criteria was created. The date and

time is in mm/dd/yyyy hh:mm:ss format.
Created By The name of the employee by whom the business criteria was created.
Status The status of the business criteria. The options are:

• Active: The default value.

• Inactive: You cannot run a business criteria that is inactive.

Button Name Description
Run To run the business criteria. Navigate to the Results page to view and

play the interactions that match your business criteria.
Edit To edit the business criteria.
Delete To delete the business criteria.

Icon Name Description
Public The business criteria that is shared with all users in the selected group.

Editing business criteria
About this task
Use this procedure to edit a business criteria.

Procedure
1. Click Speech > Business Criteria.

The page displays a list of all searches that you saved as business criteria.

2. Click the radio button next to the business criteria and click Edit.
3. In the Search page, do the following:

a. Select a phrase set.

b. Define employee selection.

c. Define interaction selection.

d. Save the business criteria.

Selecting a phrase set
About this task
Use this procedure to select a phrase set for which you want to perform speech-based searches
on interactions.
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Procedure
1. Click Speech > Search.

2. On the Search page, click the Phrase Set tab.

3. To transcribe all interactions that meet your search criteria, click the Transcribe only
checkbox.

4. To configure a phrase set, clear the Transcribe Only checkbox, and enter the appropriate
details.

5. Click Save.

Next steps
Define employee selection.

Defining the employee selection criteria
About this task
Use this procedure to select employees whose interactions must be picked as part of the ad hoc
search for speech analysis.

Procedure
1. Click the Employee Selection tab.

2. In the Employee Filter section, specify the search criteria to filter employees.

a. In Field, select the fields by which you want to filter employees to assign to the plan.

b. In Operator, select the operator for the filter.

c. In Value, enter the value that the records must match.

d.
(Optional) To add multiple filters, click the  icon.

e. Click Apply Filter.

The Employee List section displays the list of employees that match the search
criteria.

Next steps
Define interaction selection.

Defining the interaction selection criteria
About this task
Use this procedure to define interactions that must be picked as part of the search criteria for
transcription.

Procedure
1. Click the Interaction Selection tab.
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2. To specify the search criteria to filter interactions to be evaluated do the following:

a. In Field, select the fields by which you want to filter interactions to assign to the plan.

b. In Operator, select the operator for the filter.

c. In Value, enter the value that the records must match.

d.

To add multiple filters, click the  icon.

3. Click Run to run the search.

Note:

You can run a search without saving it as a business criteria. Navigate to the Results
page to view the request status and cancel or delete a requrest. You can also play the
interactions that match your search criteria.

Next steps
Save the search as a business criteria.

Saving the search
About this task
Use this procedure to save the search as a business criteria for reuse.

Procedure
1. In the Save Settings tab, in Business Criteria, enter the name by which you want to save

the search.

2. In Description, enter a description for the business criteria.

3. To activate the business criteria, select Active.

4. From Share, select one of the following to share the search with other users.

• Me: To configure the security option for the business criteria.

• Selected Groups: To share the search with the groups that you have access to.
Employees belonging to the group can use the search.

• Everyone: To share the search with all available users.

5. To share the search with specific employees and groups, select Selected Groups.

The system displays the Group and Employee search and select options.

6. To remove groups from the Selected Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

7. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in
Search.

b. To move a single selection from the list, use the Move Selected button.
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c. To move multiple selections from lists, use the Move All button.

8. To remove employees from the Selected Employees list; select one or more employees
and use the Remove Selected and Remove All buttons.

9. In Tag(s), do any on of the following:

a. Enter comma-separated multiple search tags.

b. Select from existing system or custom tags.

10. Click Save & Close to save and close the search.

The search is saved in the Business Criteria page.

11. Click Run to run the search.

12. Click Reset to reset the selection.

Search field descriptions
Phrase Set

Name Description
Transcribe Only The option to only transcribe all the interactions that meet the search

criteria.

Note:

Clear the Transcribe Only check box to configure a phrase set.
Phrase Set The option to select from a list of available phrase sets.
Word/Phrase The word or phrase that you want the speech engine to search for within

interactions.

You can add or remove a word or phrase within a phrase set.
Conditions The logical conditions that define the search criteria for phrases within a

phrase set. The options are:

• Any of these (OR): Avaya Workforce Optimization Select searches for
interactions that have at least one of the phrases defined in the phrase
set and highlights the phrase in the result.

• All of these (AND): Avaya Workforce Optimization Select searches for
interactions that have all the phrases defined in the phrase set and
highlights the phrase in the result.

• None of these (NOT): Avaya Workforce Optimization Select searches
for interactions that do not have any of the phrases defined in the
phrase set and renders those interactions as part of the result.

Business criteria

October 2019 Using Avaya Workforce Optimization Select 325
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Employee Selection

Filter Description
Field The parameters used to filter the search results for employees. The

options are:

• DP OU

• Department

• Employee

• Groups

• Organization Unit

• Reporting To

• Role

• Site

• Tenure (Weeks)
Operator The Operator relative to the field selected. The options are:

• Equals To

• Not Equal To

• Contains

• Does Not Contain

• Starts With

• Does Not Start With

• Ends With

• Does Not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between

The default value is Equals.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.
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Field

Name Description
Department To search for interactions of employees who belong to the specified

department.
DP OU To search for interactions of employees based on the partition of the

organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Employee To search for interactions based on the employees that you have access

to.
Groups To search for interactions of employees belonging to the specified group.
Organization Unit To search for interactions based on the name of the organizational unit.
Role To search for interactions of employees with the specified designation or

role.
Site To search for the interactions of employees belonging to the specified

site.
Reporting To To search for interactions based on the name of the supervisor.
Tenure (Weeks) To search for interactions based on the tenure of the employee in weeks.

Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.
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Employee List

Name Description
Employee The name of the employee to whom the coaching assignment is

assigned.
Tenure (Weeks) The tenure in weeks of the employee in the organization.
Reporting to The reporting manager of the employee.
Department The department that the employee belongs to.
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Interaction Selection

Name Description
Field The parameters used to filter the search results. The options are:

• Agent ID

• Archived

• Called Party

• Calling Party

• Channel

• Commented

• Duration

• Evaluated

• Extension

• Flagged for QA

• Hold Duration

• Interaction Comments

• Interaction Ended By

• Interaction Tags

• Interaction Type

• Interaction ID

• No of Holds

• No of Transfers

• Queue

• Screen Captures

• Source Type

• Tagged

• Transfer Number

• Transfer Type

• Variables 1–10

• VDN
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Name Description
Operator The Operator relative to the field selected. The options are:

• Equals To

• Not Equal To

• Contains

• Does Not Contain

• Starts With

• Does Not Start With

• Ends With

• Does Not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between

The default value is Equals.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

Field

Name Description
Agent ID To search for interactions of employees with the specified agent or

network ID.
Archived To search for interactions that are archived.

The options to filter interactions based on archiving from the Value field
are:

• Yes: To filter the interactions that were archived.

• No: To filter the interactions that were not archived.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.
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Name Description
Channel The type of channel in which the interaction is recorded. The options are:

• Chat

• Email

• Voice
Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Duration To search for interactions by the duration specified in the hh:mm:ss

format.
Evaluated To search for evaluated interactions.
Flagged for QA To search for interactions that are flagged for QA.

The options to filter interactions based on flagging from the Value field
are:

• Yes: To filter the interactions that were flagged for QA.

• No: To filter the interactions that were not flagged for QA.
Extension To search for interactions by the extension number of the employee.
Hold Duration To search for interactions based on the hold duration.
Interaction Comments To search for interactions based on specific comments provided by

employees.
Interaction Date To search for interactions based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

You can also search for interactions for a specific date range.
Interaction Ended By To search for interactions based on who ended a interaction. The options

are:

• Agent

• Customer
Interaction ID To search for interactions based on the interaction ID.
Interaction Tags To search for interactions based on the specific tags used for association.
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Name Description
Interaction Type To search for interactions based on the type of interaction.
No of Holds To search for interactions with the specified number of holds.
No of Transfers To search for interactions with the specified number of transfers.
Queue To search for interactions by the queue that the interaction is associated

with.
Screen Captures To search for interactions with screens.
Source Type To search for interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Tagged To search for tagged interactions.

The options to filter interactions based on tags from the Value field are:

• Yes: To filter the interactions that were tagged.

• No: To filter the interactions that were not tagged.
Transfer Number To search for interaction based on the station or the extension number of

the party to whom the interaction is transferred.
Transfer Type To search for interactions based on how you transfer a call. The options

are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

Variables 1–10 To search for interactions based on custom variables defined for your
business.

VDN To search for interactions based on an extension number that is used to
enable calls to connect to a vector for processing.
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Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Save Settings

Name Description
Business Criteria To save the search as a business criteria.
Description To enter a description for the business criteria.
Active To activate the business criteria.
Tag(s) To select one or more interaction tags and associate the tags when the

search criteria fetches one or more interaction.
Share To share the business criteria. The options are:

• Me

• Selected Groups

• Everyone

Button Name Description
Reset To reset the selection.
Save & Close To save the search.
Run To run the search.

Business criteria
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Running a business criteria
About this task
Use this procedure to run a business criteria.

Procedure
1. Click Speech > Business Criteria.

The page displays a list of all searches that you saved as business criteria.

2. Click the business criteria that you want to run and click Run.

The system displays the results of the business criteria in the Results tab. The xRun
column displays the number of times a business criteria is run.

3. (Optional) To view the number of business criteria records, click on the xRun column of
the respective business criteria.

The system displays the business criteria, the date and time when the business criteria
was run, and the status of the business criteria.

4. (Optional) To view the corresponding interaction list of a business criteria, click the  icon.

Results
Once you run a search or a business criteria, Avaya Workforce Optimization Select displays the
search results in the Results page. You can view the search name, status, and the number of
interactions that match your search criteria. You can play an interaction and select a search
criteria to quickly navigate to those sections that list the words, phrases, or expressions defined in
your search criteria. You can edit, cancel, and delete a speech request from this page.

Viewing speech results
About this task
Use this procedure to view the results of running a search or a business criteria. You can view and
play the interactions that match your search criteria.

Procedure
1. Click Speech > Results.

2. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.
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3. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

4. (Optional) To clear the filters from all the columns, click the  icon.

5. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

6. (Optional) To refresh the change in the status of a speech request, click Refresh.

7. (Optional) To edit a speech request, click the radio button next to the speech request, and
click Edit.

8. (Optional) To delete a speech request, click the radio button next to the speech request,
and click Delete.

9. (Optional) To cancel a speech request, click on the radio button next to the business
criteria, and click Cancel.

You can cancel only those speech requests for which the status is New and In Progress.

10. (Optional) To view the number of business criteria records, click on the xRun column of
the respective business criteria.

The system displays the business criteria, the date and time when the business criteria
was run, and the status of the business criteria.

11. (Optional) To view the corresponding interaction list of a business criteria, click the  icon.

12. (Optional) To view the interaction transcripts or phrase hits, click the  icon or on the
Status column of the respective speech result.

a. To view the interactions for which no transcripts are available, click the No transcript
check box.

b. To view only those interactions for which transcripts are available, click the Transcript
check box.

c. To view only those interactions that have phrase hits, click the Phrase hits check box.

Results field descriptions
Name Description
Search Name The name of the speech request that was run as a search or a business

criteria.
Interactions Selected The number of interactions that were selected for a particular speech

request.

Table continues…
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Name Description
xRun The number of times a business criteria is run. Click to view the historical

data of the search or business criteria. You can view the transcripts or
phrase hits of interactions that are associated with the search or business
criteria.

Last Run By The name of the employee by whom the speech request was last run.
Last Run On The date and time when the speech request was last run. The date and

time is in mm/dd/yyyy hh:mm:ss format.
Status The status of the speech request. The options are:

• New: A new speech request for which processing has not started.

• Processing: A speech request for which the processing is in progress.

• Completed: A speech request for which the processing is completed.

• Cancelled: A speech request that is cancelled. You can cancel a
request that is in Processing and Completed status.

• Failed: A speech request for which the processing has failed due to
some reason.

Button Name Description
Refresh To refresh the Results page.
Edit Search To edit the speech request.
Delete To delete the speech request.
Cancel To cancel the speech request.

Icon Name Description
View results The option to view interaction transcripts or phrase hits.

View Results field descriptions
Name Description
Interaction ID The unique ID of the interaction.
Employee The name of the employee who attended to the interaction.
Reporting To The name of the supervisor or manager to whom the employee reports.
Interaction Date The date on which the interaction takes place.
Duration The duration of the interaction in the hh:mm:ss format.
Agent ID The ID of the agent logged in into the phone.
Extension To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Queue The queue that the interaction is associated with.

Table continues…
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Name Description
Site The name of the site that the employee belongs to.

The system administrator associates employees working in different
locations to the relevant sites. Supervisors and managers can monitor
interactions of employees based on the Site to which they belong to.

DP OU Type The partition of the organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Department The department that the employee belongs to.
Role The designation of the employee in the organization.
Tag(s) The speech tags associated with those interaction that have phrase hits.

Checkbox Name Description
No transcript To view the interactions for which no transcripts are available.

When you run a search criteria or a business criteria, Avaya Workforce
Optimization Select might fail to transcribe few interactions that meet the
criteria due to some reason. Therefore, you can select this option to view
those interactions that did not get transcribed.

Transcript To view only those interactions for which transcripts are available.

When you run a search criteria or a business criteria, Avaya Workforce
Optimization Select might fail to transcribe few interactions that meet the
criteria due to some reason. Therefore, you can select this option to view
those interactions that got transcribed.

Phrase hits To view only those interactions that have phrase hits.

Not all interactions that match the search or business criteria contain
phrases defined within the phrase set. You can select this option to view
only those interactions that contain the phrase hits.

Icon Name Description
Play The interaction that matches the search criteria or the business criteria

and is available to play.

• Green: The customer has ended the interaction.

• Red: The employee has ended the interaction.

Editing speech results
About this task
Use this procedure to edit a speech result.

Results

October 2019 Using Avaya Workforce Optimization Select 337
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Procedure
1. Click Speech > Results.

2. Click the radio button next to the speech request and click Edit.
3. In the Search page, do the following:

a. Select a phrase set.
b. Define employee selection.
c. Define interaction selection.
d. Save the business criteria.

Selecting a phrase set
About this task
Use this procedure to select a phrase set for which you want to perform speech-based searches
on interactions.

Procedure
1. Click Speech > Search.

2. On the Search page, click the Phrase Set tab.

3. To transcribe all interactions that meet your search criteria, click the Transcribe only
checkbox.

4. To configure a phrase set, clear the Transcribe Only checkbox, and enter the appropriate
details.

5. Click Save.

Next steps
Define employee selection.

Defining the employee selection criteria
About this task
Use this procedure to select employees whose interactions must be picked as part of the ad hoc
search for speech analysis.

Procedure
1. Click the Employee Selection tab.

2. In the Employee Filter section, specify the search criteria to filter employees.

a. In Field, select the fields by which you want to filter employees to assign to the plan.
b. In Operator, select the operator for the filter.
c. In Value, enter the value that the records must match.
d.

(Optional) To add multiple filters, click the  icon.
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e. Click Apply Filter.

The Employee List section displays the list of employees that match the search
criteria.

Next steps
Define interaction selection.

Defining the interaction selection criteria
About this task
Use this procedure to define interactions that must be picked as part of the search criteria for
transcription.

Procedure
1. Click the Interaction Selection tab.

2. To specify the search criteria to filter interactions to be evaluated do the following:

a. In Field, select the fields by which you want to filter interactions to assign to the plan.

b. In Operator, select the operator for the filter.

c. In Value, enter the value that the records must match.

d.

To add multiple filters, click the  icon.

3. Click Run to run the search.

Note:

You can run a search without saving it as a business criteria. Navigate to the Results
page to view the request status and cancel or delete a requrest. You can also play the
interactions that match your search criteria.

Next steps
Save the search as a business criteria.

Saving the search
About this task
Use this procedure to save the search as a business criteria for reuse.

Procedure
1. In the Save Settings tab, in Business Criteria, enter the name by which you want to save

the search.

2. In Description, enter a description for the business criteria.

3. To activate the business criteria, select Active.
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4. From Share, select one of the following to share the search with other users.

• Me: To configure the security option for the business criteria.

• Selected Groups: To share the search with the groups that you have access to.
Employees belonging to the group can use the search.

• Everyone: To share the search with all available users.

5. To share the search with specific employees and groups, select Selected Groups.

The system displays the Group and Employee search and select options.

6. To remove groups from the Selected Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.

7. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in
Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

8. To remove employees from the Selected Employees list; select one or more employees
and use the Remove Selected and Remove All buttons.

9. In Tag(s), do any on of the following:

a. Enter comma-separated multiple search tags.

b. Select from existing system or custom tags.

10. Click Save & Close to save and close the search.

The search is saved in the Business Criteria page.

11. Click Run to run the search.

12. Click Reset to reset the selection.

Search field descriptions
Phrase Set

Name Description
Transcribe Only The option to only transcribe all the interactions that meet the search

criteria.

Note:

Clear the Transcribe Only check box to configure a phrase set.
Phrase Set The option to select from a list of available phrase sets.

Table continues…
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Name Description
Word/Phrase The word or phrase that you want the speech engine to search for within

interactions.

You can add or remove a word or phrase within a phrase set.
Conditions The logical conditions that define the search criteria for phrases within a

phrase set. The options are:

• Any of these (OR): Avaya Workforce Optimization Select searches for
interactions that have at least one of the phrases defined in the phrase
set and highlights the phrase in the result.

• All of these (AND): Avaya Workforce Optimization Select searches for
interactions that have all the phrases defined in the phrase set and
highlights the phrase in the result.

• None of these (NOT): Avaya Workforce Optimization Select searches
for interactions that do not have any of the phrases defined in the
phrase set and renders those interactions as part of the result.

Employee Selection

Filter Description
Field The parameters used to filter the search results for employees. The

options are:

• DP OU

• Department

• Employee

• Groups

• Organization Unit

• Reporting To

• Role

• Site

• Tenure (Weeks)
Table continues…
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Filter Description
Operator The Operator relative to the field selected. The options are:

• Equals To

• Not Equal To

• Contains

• Does Not Contain

• Starts With

• Does Not Start With

• Ends With

• Does Not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between

The default value is Equals.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

Field

Name Description
Department To search for interactions of employees who belong to the specified

department.
DP OU To search for interactions of employees based on the partition of the

organizational unit that the employee belongs to.

For example, Business, Client, Customer, or Line of Business.

This field is available only if you are using a data partitioned environment.
Employee To search for interactions based on the employees that you have access

to.
Groups To search for interactions of employees belonging to the specified group.
Organization Unit To search for interactions based on the name of the organizational unit.
Role To search for interactions of employees with the specified designation or

role.

Table continues…
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Name Description
Site To search for the interactions of employees belonging to the specified

site.
Reporting To To search for interactions based on the name of the supervisor.
Tenure (Weeks) To search for interactions based on the tenure of the employee in weeks.

Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Employee List

Name Description
Employee The name of the employee to whom the coaching assignment is

assigned.
Tenure (Weeks) The tenure in weeks of the employee in the organization.
Reporting to The reporting manager of the employee.
Department The department that the employee belongs to.
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Interaction Selection

Name Description
Field The parameters used to filter the search results. The options are:

• Agent ID

• Archived

• Called Party

• Calling Party

• Channel

• Commented

• Duration

• Evaluated

• Extension

• Flagged for QA

• Hold Duration

• Interaction Comments

• Interaction Ended By

• Interaction Tags

• Interaction Type

• Interaction ID

• No of Holds

• No of Transfers

• Queue

• Screen Captures

• Source Type

• Tagged

• Transfer Number

• Transfer Type

• Variables 1–10

• VDN

Table continues…
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Name Description
Operator The Operator relative to the field selected. The options are:

• Equals To

• Not Equal To

• Contains

• Does Not Contain

• Starts With

• Does Not Start With

• Ends With

• Does Not End With

• Less Than

• Greater Than

• Less Than or Equal

• Greater Than or Equal

• Not Equal To

• Between

The default value is Equals.
Value The numerical value or value ranges selected for the Field and Operator

selected.

This field cannot exceed 500 characters.

Field

Name Description
Agent ID To search for interactions of employees with the specified agent or

network ID.
Archived To search for interactions that are archived.

The options to filter interactions based on archiving from the Value field
are:

• Yes: To filter the interactions that were archived.

• No: To filter the interactions that were not archived.
Called Party To search for interactions by the extension number or email ID of the

called party. You can use any alphanumeric characters or symbols to
search an interaction.

Calling Party To search for interactions by the extension number or email ID of the
calling party. You can use any alphanumeric characters or symbols to
search an interaction.

Table continues…
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Name Description
Channel The type of channel in which the interaction is recorded. The options are:

• Chat

• Email

• Voice
Commented To search for interactions that are commented.

The options to filter interactions based on comments from the Value field
are:

• Yes: To filter the interactions that were commented.

• No: To filter the interactions that were not commented.
Duration To search for interactions by the duration specified in the hh:mm:ss

format.
Evaluated To search for evaluated interactions.
Flagged for QA To search for interactions that are flagged for QA.

The options to filter interactions based on flagging from the Value field
are:

• Yes: To filter the interactions that were flagged for QA.

• No: To filter the interactions that were not flagged for QA.
Extension To search for interactions by the extension number of the employee.
Hold Duration To search for interactions based on the hold duration.
Interaction Comments To search for interactions based on specific comments provided by

employees.
Interaction Date To search for interactions based on the following options:

• Current Week

• Last Month

• Last Week

• This Month

• Today

• Yesterday

You can also search for interactions for a specific date range.
Interaction Ended By To search for interactions based on who ended a interaction. The options

are:

• Agent

• Customer
Interaction ID To search for interactions based on the interaction ID.
Interaction Tags To search for interactions based on the specific tags used for association.

Table continues…
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Name Description
Interaction Type To search for interactions based on the type of interaction.
No of Holds To search for interactions with the specified number of holds.
No of Transfers To search for interactions with the specified number of transfers.
Queue To search for interactions by the queue that the interaction is associated

with.
Screen Captures To search for interactions with screens.
Source Type To search for interactions based on the source.

The options are:

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

Tagged To search for tagged interactions.

The options to filter interactions based on tags from the Value field are:

• Yes: To filter the interactions that were tagged.

• No: To filter the interactions that were not tagged.
Transfer Number To search for interaction based on the station or the extension number of

the party to whom the interaction is transferred.
Transfer Type To search for interactions based on how you transfer a call. The options

are:

• Cold Transfer: An agent transfers the customer call to another user
without any prior notice to the user to whom the call is transferred. The
second user can be another agent or a supervisor.

• Conference: An agent adds another agent or supervisor to the call.

• Warm Transfer: An agent speaks to another agent or supervisor before
transferring a call. The first agent can provide background information
about the call to the other agent or supervisor without the caller hearing
the conversation.

• No Transfer: An agent answers the queries of the caller without
transferring the call to another agent or supervisor.

Variables 1–10 To search for interactions based on custom variables defined for your
business.

VDN To search for interactions based on an extension number that is used to
enable calls to connect to a vector for processing.
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Operator

Name Description
Equals To To search for interactions that exactly match the specified value.
Not Equal To To search for interactions that do not match the specified value.

This search operator is not available for the Transaction Date field.
Contains To search for interactions that have the string or text that match the

specified value.
Does not contain To search for interactions that do not have the specified value.
Starts with To search for interactions that start with the specified value.
Does not Start With To search for interactions that does not start with a specified value.
Less Than To search for interactions that have a value less than the specified value.
Greater Than To search for interactions that have a value that is greater than the

specified value.
Less Than or Equal To search for interactions that have a value less than or equal to the

specified value.
Greater Than or Equal To search for interactions that have a value greater than or equal to the

specified value.
Not Equal To To search for interactions that is not equal to a specified value.
Between To search for interactions that lie between the specified values.

Save Settings

Name Description
Business Criteria To save the search as a business criteria.
Description To enter a description for the business criteria.
Active To activate the business criteria.
Tag(s) To select one or more interaction tags and associate the tags when the

search criteria fetches one or more interaction.
Share To share the business criteria. The options are:

• Me

• Selected Groups

• Everyone

Button Name Description
Reset To reset the selection.
Save & Close To save the search.
Run To run the search.
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Chapter 11: Managing reports

Reports overview
With the Reports module, you can translate data to business intelligence. Contact centers need
efficient and powerful tools for executives to analyze the performance of the organization.
Supervisors and managers need statistics around individual or team performance. With this
module in Avaya Workforce Optimization Select, you can generate different types of report views
that are essential for the success of your business.

Using the Reports module, you can get:

• Predefined set of report templates for each module.

• Report output in various formats, such as PDF, Excel, HTML, and CSV.

Note:

Reports such as Evaluation Criteria Details, Evaluations Criteria Summary, Evaluations
Overview, and Evaluations Section Summary do not support the PDF output.

• Reports scheduled to run automatically at the specified time.

• Reports shared with selected employees or groups, or all employees.

• Intuitive titles in the report output.
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Report templates
Interactions

Name Description
Interactions Details Highlights the details about all recorded interactions for a site,

organization unit, group, and employee depending on the filter criteria
that you select.

Supervisors can:

• Get a snapshot of the hold count and hold duration of all interactions of
the employees that the supervisor has access to.

• View the report output grouped by Organization Units, Sites, Groups,
and Employees.

The report output displays the following details about the interaction:

• Start and end time of the interaction

• Name of the employee who attended the interaction

• Name of the employee who ended the interaction

• Name of the supervisor that the employee reports to

• Duration of the interaction in the hh:mm:ss format

• Number of holds and the hold duration of an interaction

• Called party, calling party, and call type of the interaction

• Interaction ID, queue, and queue type of the interaction
Interactions Summary Highlights a summary of all recorded interactions for a site, organization

unit, group, and employee depending on the filter criteria that you select.

Supervisors can:

• Get a snapshot of the average handle time, , hold count, transfers,
screens, and number of interactions that the employees made.

• View the report output grouped by Organization Units, Sites, Groups,
and Employees.

The report output displays the following details about the interaction:

• Names of the employees who attended the interaction

• Number of interactions handled by each employee

• Duration of the interaction in the hh:mm:ss format

• Average handle time of the interaction in seconds

• Number of holds, transfers, and screens for an interaction

Table continues…
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Name Description
Interactions Trend Displays the interactions recorded for employees in the contact center

over a specific period, such as quarterly, monthly, weekly, or daily. The
report output displays the interaction count and duration for the specified
time depending on the filter criteria that you select.

AHT Trend Displays the average handle time between the employee and customer
based on organization unit, group, and employees, over a specific period.
Supervisors or managers can choose to view the output in a graphical or
data format displaying the trend.

Evaluate

Name Description
Evaluation Criteria Detail Provides the details on every evaluation performed for employees using

selected forms to the criterion level. The report output depends on how
you group the data when you filter the report criteria.

Supervisors can:

• Get a summary of the total number of evaluations with average QA
scores, the maximum QA score, and average percentage.

• Get details on how an agent performed against one or more criteria in
the evaluations summary.

• View the score achieved at a criterion level, and the scoring condition
applicable to a criterion.

The report output displays the following details about the interaction:

• Evaluations Summary

• Evaluation Details

• General Comments

• Header Information

Table continues…
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Name Description
Evaluation Criteria
Summary

Provides the details depending on each criterion used in an evaluation
form.

Supervisors can:

• Get a summary of the criteria used in an evaluation form and break
down how many times a question is responded in a particular way.

• Get details on what an agent scored in numbers and percentage for
each way the agent responded to a question.

• Narrow down the results by date, date type, form name, form status,
agent, evaluator, and group.

The report output displays the following details about the interaction:

• Group by information

• Overall summary of each criterion

• Form name

• Total number of evaluations performed

• Average score

• Maximum score

• Average percentage
Evaluation Details Highlights the details about all evaluations for a site, organization unit,

group, and employee depending on the filter criteria that you select.

Supervisors can:

• Get a snapshot of evaluations on all the interactions of the employees
that you have access to.

• View the report output grouped by Organization Units, Sites, Groups,
and Employees.

The report output displays the following details about the interaction:

• Overall scores for evaluation

• Scores for the primary performance criteria

• Scores for the individual scoring criteria

• Overall average score of the selected employees
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Name Description
Evaluations Overview Summarizes the quality scores for a site, organization unit, group,

employee, queues, reviewers, and forms depending on the filter criteria
that you select.

Supervisors can:

• Get a snapshot view on total number of evaluations, sum total of scores
of all evaluations and percentage of evaluations for various Queues,
Organization Units, Sites, Groups Employees, Reviewers, and Forms.

• Filter the results by interaction date, evaluation date, and evaluation
modified date.

• View the report output grouped by Organization Units, Sites, Groups,
Employees, Forms, Reviewers, and Queues.

The report output displays the following details about the group by option
that you select:

• Total evaluations

• Score

• Max score

• Percentage
Evaluation Section
Summary

Summarizes the quality scores for the employees at a section level for
selected forms.

Supervisors can:

• Get a snapshot view of total number of evaluations, section level scores
of all evaluations and percentage of evaluations for various Queues,
Organization Units, Sites, Groups, and Employees.

• Filter the results by interaction date, evaluation date, and evaluation
modified date.

The report output displays the following details about the employee:

• Total evaluations

• Score

• Max score

• Percentage
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Name Description
Evaluations Summary Highlights the details about all evaluations for interactions for a site,

organization unit, group, and employee depending on the filter criteria
that you select.

Supervisors can:

• Get a snapshot view on total number of evaluations, average score of
all evaluations and percentage of evaluations for various Queues,
Organization Units, Groups and Employees.

• View the report output grouped by Organization Units, Sites, Groups,
and Employees.

The report output displays the following details about the evaluation:

• Total evaluations

• Total evaluations summary

• Average score

• Average score summary

• Average percentage

• Average percentage summary
Evaluations Trend Displays a trend view of how many evaluations are performed for specific

period and what are the average scores achieved, based on the options
you select.

Supervisors can:

• Get a snapshot of the number of evaluations, average score and the
total evaluations performed by an employee.

• View the report output grouped by Organization Units, Sites, Groups,
and Employees.

The report output displays the following details about the interaction:

• Number of evaluations

• Average score

• Total number of evaluations

• Total average score
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Coach

Name Description
Coaching Summary Highlights the details of the number of coaching sessions assigned to the

employees depending on the filter criteria that you select.

The report output displays the following details about the evaluation:

• Start and end time of the coaching sessions

• Name of the employee who attended the coaching sessions

• Purpose of assigning the coaching sessions

• Evaluation plan based on which the agent was evaluated

• Name of the employee assigned to coach the agents

Learn

Name Description
Course & Quiz Summary Highlights the details of the number of courses and quizzes assigned to

the employees depending on the filter criteria that you select. It also
displays the number quizzes an employee had taken, their status, and
corresponding scores.

The report output displays the following details:

• Start and end time of the learning assignments

• Name of the employee who attended the learn sessions

• Purpose of assigning the learning sessions

• Evaluation plan based on which the agent was evaluated

Administration

Name Description
Employee Recording
Configuration

The report provides information of all the recording configuration options
enabled for employees. The user who generates the report can view all
the recording configuration options enabled for employees that the user
has access to.

User Access The report displays the details of the users’ access and all the privileges
enabled for employees. The user who generates the report can view all
the privileges enabled for employees that the user has access to.

Web Usage Audit The report displays the details of the web application access and user
activity like modifications done on the current values, clicking on any
action buttons for example reset password and adding, editing, or
deleting any data.
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Create a new report

Selecting a report template
Procedure

1. Click Reports > Reports > Templates.

2. To select the template category, click one of the following:

• Interactions
• Evaluate
• Coach
• Learn
• Administration

3. To create a report of contact center use and agent performance, select a template from
Interactions.

4. To create a report on agent evaluations, select a template from Evaluate.

5. To create a report on agent coaching, select a template from Coach.

6. To create a report on agent learning and assessment, select a template from Learn.

7. To create an administrative report of user access and voice configuration settings, select a
template from Administration.

Next steps
Set up criteria for a new report.

Setting up criteria for a new report
About this task
The system displays the report template with the Filter tab selected.
The filter criteria on each report is predefined based on the nature of the report. Some common
parameters include the date range and export format options.

Procedure
1. In Filter, enter the parameters for the report from the available report criteria.

The parameters define the columns available in the report output.

2. To view the reports in data and chart or both formats for the Interactions Trend, AHT
Trend, Evaluations Summary, Evaluations Trend, Coaching Summary, Course and
Quiz Summary templates, click the options in the Display field.
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3. In Export, click the output format of the templates you want:

• HTML
• PDF
• CSV
• Excel

Next steps
Save report settings.

Report template - Interactions Details field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition created at the organization unit level that the user

generating the report has access to. The report output contains data
pertaining to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that the user generating the report has access to.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
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Name Description
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Group by The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Interactions Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.
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Name Description
Organization Units The organization units that are accessible to the user who generates the

report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Group by The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.
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Report template - Interactions Trend field descriptions
Name Description
Trend The trend of the report. The options are:

• Quarterly

• Monthly

• Weekly

• Daily

The trend period for interactions. The options are:

• Interaction Duration: Select the duration for which the trend must be
calculated.

• Base Date: Specify a date from when the interaction trend must be
calculated.

This field is mandatory.
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
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Name Description
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Display The format in which you want to display the report output. The options

are:

• Both

• Chart

• Data

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - AHT Trend field descriptions
Name Description
Trend The time period for which you want to generate the trend report. The

options are:

• Quarterly

• Monthly

• Weekly

• Daily

This field is mandatory.
Trend Period The duration within the particular trend period for which you want to

analyze the trend.

• Interaction Duration: Select the duration for which the trend must be
calculated.

• Base Date: Specify a date from when the trend must be calculated.
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Name Description
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Display The format in which you want to display the report output. The options

are:

• Both

• Chart

• Data

This field is mandatory.

Table continues…

Managing reports

October 2019 Using Avaya Workforce Optimization Select 362
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Name Description
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Evaluation Criteria Detail field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Yesterday

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.

The default option is All.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
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Name Description
Groups The groups that the user generating the report has access to.

You can select multiple groups depending on your business
requirements.

This field is mandatory.

The default option is All.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

You can also select individual employees based on business
requirements.

This field is mandatory.

The default option is All.
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

This field is mandatory.

The default option is Normal.
Forms The evaluation forms available for selection, which is based on the

organization unit and group that the user selects.

You can also select multiple forms based on your business requirements.

This field is mandatory.
Criteria The criteria used to evaluate an interaction for the selected forms.

You can also select a parent criteria that has a child criteria associated to
it.

This is an optional field.

The default option is Normal.
Reviewers The employees who have access to the interactions of the selected

agents and who possess evaluation permission.

This field is mandatory.
Interaction Direction The option to select the direction of the interaction. options are:

• Outbound

• Inbound

• Bi Direction
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Name Description
Interaction Type The type of channel on which the interaction is delivered. The options

are:

The options are:

• Voice

• Non Voice

• Email

• SMS

• Chat
Interaction Tags The tags applied to an interaction after evaluation.
Queue(s) The queue and queue type that the interaction is associated with.

The options are:

• Chat

• Email

• Inbound

• Outbound

• SMS

• All

• Custom: These are queues that the system administrator manually
creates to define an additional level of tracking.

Interaction Ended By The party who ended the interaction. The options are:

• Customer Ended

• Agent Ended
Group by The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

• Forms

• Reviewers

• Queues

This field is mandatory.
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Name Description
Export The report output format. The options are:

• HTML

• Excel

• CSV

This field is mandatory.

Button Description
Save & Close To save the evaluation report that you have created.
Run To run the report.

Evaluation Criteria Summary field descriptions
Name Description
Date Type The specific date on which a particular action is taken. The options are:

• Interaction Date

• Evaluation Date

• Modified Evaluation Date
Range The time range of a report. The options are:

• Today

• Yesterday

• Current Week

• Last Week

• Current Month

• Last Month

• Custom: You can select a custom period using this option.

This field is mandatory.
Source Type The source of the interaction for a report.

• System: The interactions recorded in the application

• Adhoc-External: The interactions imported from external sources in the
supported media formats.

• Adhoc-Composite: The interactions grouped together from system and
imported interactions. It can be a either a group of system interactions,
imported interactions or both.

• All: The total interactions available in the application.

Table continues…

Managing reports

October 2019 Using Avaya Workforce Optimization Select 366
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Name Description
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Departments The available departments in the organization.

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Evaluation Type This field is mandatory.
Form(s) The evaluation forms available for selection. The forms listed are based

on the DP OU type you select if the DP OU option is enabled. If the DP
OU option is not enabled, Avaya Workforce Optimization Select lists all
available forms.

You can also select multiple forms based on your business requirements.

This field is mandatory.
Criteria The criteria used to evaluate an interaction for the selected forms.
Response The option used to specify the responses to the evaluation criteria

defined in an evaluation form. The options are:

• All

• Yes

• No

• True

• False
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Name Description
Reviewers The users who have the privileges to evaluate an employee.

This field is mandatory.
Interaction Direction The direction of the interaction. The options are:

• Inbound

• Outbound

• Bi Direction
Interaction Type The channel used for interaction. The options are:

• Voice

• Chat

• Email

• SMS

• All
Interaction Tags The tag added to a specific interaction. One of more actions can be

added to a tag.

The options are:

• Flag for QA

• Record this interaction

• Stop recording

• Pause recording

• Resume recording

• Discard this recording

• Do not allow download

• Do not allow email

• Do not allow download & email
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Name Description
Queues The queue that the interaction is associated with.

The options:

• Chat

• Email

• Outbound

• Inbound

• SMS

• All

• Custom: These are queues that the system administrator manually
creates to define an additional level of tracking.

Interaction Ended By The party who ended the interaction. The options are:

• Agent

• Customer
Group by The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

• Forms: This is the default option.

• Reviewers

• Queues

This field is mandatory.
Export The report output format. The options are:

• HTML

• Excel

• CSV

This field is mandatory.

Button Description
Save & Close To save the evaluation report that you have created.
Run To run the report.
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Report template - Evaluation Details field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection. The forms listed are based

on the DP OU type you select if the DP OU option is enabled. If the DP
OU option is not enabled, Avaya Workforce Optimization Select lists all
available forms.

You can also select multiple forms based on your business requirements.

This field is mandatory.
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Name Description
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

The options are:

• All

• Adhoc

• Normal
Reviewers The users who have the privileges to evaluate an employee.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Evaluations Overview field descriptions
Name Description
Date Type The specific date when a particular action is taken. The options are:

• Interaction Date

• Evaluation Date

• Evaluation Modified Date
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Name Description
Range The time range of a report. The options are:

• Today

• Yesterday

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report.

For example, Business, Client, Customer, or Line of Business.

This field is mandatory.
Organization Units The organization units that are accessible to the user who generates the

report.

This field is available based on the DP OU Type you select in a data
partitioned environment.

This field is mandatory.

The default option is All.
Sites The available sites.

This field is mandatory.

The default option is All.
Groups The groups that the user generating the report has access to.

You can select multiple groups depending on your business
requirements.

This field is mandatory.

The default option is All.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

You can also select individual employees based on business
requirements.

This field is mandatory.

The default option is All.

Table continues…

Managing reports

October 2019 Using Avaya Workforce Optimization Select 372
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Name Description
Forms The evaluation forms available for selection. Forms are listed based on

the organization unit and group that you select.

You can also select multiple forms based on your business requirements.

This field is mandatory.
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

This field is mandatory.

The default option is All.
Reviewers The supervisors or managers who have the privileges to evaluate an

employee.
Queues The queue that the interaction is associated with.

The options:

• Chat

• Email

• Outbound

• Inbound

• SMS

• All

• Custom
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Export The report output format. The options are:

• HTML

• Excel

• CSV

This field is mandatory.
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Report template - Evaluations Section Summary field descriptions
Name Description
Date Type The specific date when a particular action is taken. The options are:

• Interaction Date

• Evaluation Date

• Evaluation Modified Date
Range The time range of a report. The options are:

• Today

• Yesterday

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.

The default option is All.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

You can select multiple groups depending on your business
requirements.

This field is mandatory.

The default option is All.
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Name Description
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

You can also select individual employees based on your business
requirements.

This field is mandatory.

The default option is All.
Forms The evaluation forms available for selection. Forms are listed based on

the DP OU type that you select if the DP OU option is enabled. If the DP
OU option is disabled, Avaya Workforce Optimization Select lists all
available forms.

You can also select multiple forms based on your business requirements.

This field is mandatory.
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

This field is mandatory.

The default option is All.
Reviewers The users who have the privileges to evaluate an employee.
Queues The queue that the interaction is associated with.

The options are:

• Chat

• Email

• Outbound

• Inbound

• SMS

• All

• Custom: These are queues that the system administrator manually
creates to define an additional level of tracking.

Export The report output format. The options are:

• HTML

• Excel

• CSV

This field is mandatory.
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Report template - Evaluations Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection. The forms listed are based

on the DP OU type you select if the DP OU option is enabled. If the DP
OU option is not enabled, Avaya Workforce Optimization Select lists all
available forms.

You can also select multiple forms based on your business requirements.

This field is mandatory.
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Name Description
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

The options are:

• All

• Adhoc

• Normal
Reviewers The users who have the privileges to evaluate an employee.
Status The status of the assigned coaching. The options are:

• All

• Completed

• New
Display The format in which you want to display the report output. The options

are:

• Both

• Chart

• Data

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.
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Report template - Evaluations Trend field descriptions
Name Description
Trend The trend of the report. The options are:

• Quarterly

• Monthly

• Weekly

• Daily

The trend period for evaluations. The options are:

• Interaction Duration: Select the call duration for last two, three, or four
quarters.

• Base Date: Specify a date from when the interaction trend must be
calculated.

DP OU Type The partition created at the organization unit level that is accessible to the
user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection. The forms listed are based

on the DP OU type you select if the DP OU option is enabled. If the DP
OU option is disabled, Avaya Workforce Optimization Select lists all
available forms.

You can also select multiple forms based on your business requirements.

This field is mandatory.
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Name Description
Evaluation Type The name of the evaluation type. Reviewers or evaluators select an

evaluation type while evaluating an interaction.

The options are:

• All

• Adhoc

• Normal
Reviewers The users who have the privileges to evaluate an employee.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Display The format in which you want to display the report output. The options

are:

• Both

• Chart

• Data

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.
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Report template - Coaching Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Forms The evaluation forms available for selection. The forms listed are based

on the DP OU type you select if the DP OU option is enabled. If the DP
OU option is not enabled, Avaya Workforce Optimization Select lists all
available forms.

You can also select multiple forms based on your business requirements.

This field is mandatory.
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Name Description
Reviewers The users who have the privileges to evaluate an employee.
Group By The order in which you want to group the report data. The options are:

• Organization Units

• Sites

• Groups

• Employees

This field is mandatory.
Display The format in which you want to display the report output. The options

are:

• Both

• Chart

• Data

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Course and Quiz Summary field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
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Name Description
DP OU Type The partition created at the organization unit level that is accessible to the

user who generates the report. The report output contains data pertaining
to the DP OU you select.

For example, Business, Client, Customer, or Line of Business.

Note:

Avaya Workforce Optimization Select displays this mandatory field
only if your system administrator enables the data partition option
during the application set up.

Organization Units The organization units that are accessible to the user who generates the
report.

This field is mandatory.
Sites The active sites available for selection.

This field is mandatory.

The default option is All
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Status The status of the course and quiz completion. The options are:

• All

• Completed
Display The format in which you want to display the report output. The options

are:

• Both

• Chart

• Data

This field is mandatory.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.
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Report template - User Access field descriptions
Name Description
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Modules The modules in the application.

This field is mandatory.
Sub modules The sub modules for each module.
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Employee Voice Configuration field descriptions
Name Description
Groups The groups that the user generating the report has access to.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.
Recordings The interaction recording options for employees. The options are:

• Yes: View the list of employees for whom the interaction recording
option is enabled

• No: View the list of employees for whom the interaction recording
option is disabled

Screen Capture The screen recording options for employees. The options are:

• Yes: View the list of employees for whom the screen recording option is
enabled

• No: View the list of employees for whom the screen recording option is
disabled

Recording Type The interaction recording rules.
Screen Capture Type The screen recording rules.
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Name Description
Export The report output format. The options are:

• HTML

• PDF

• Excel

• CSV

This field is mandatory.

Report template - Web Usage Audit field descriptions
Name Description
Range The time range of a report. The options are:

• Today

• Last Day

• Current Week

• Last Week

• Current Month

• Last Month

• Custom

This field is mandatory.
Groups The groups that the user generating the report has access to.

This field is mandatory.
Employees The employee list available for selection, which is based on the

organization unit and group that the user selects.

This field is mandatory.
Modules The modules in the application.
Sub modules The sub modules for each module.

Saving a report
About this task
You can modify an existing report template and save the template as a report with another name.
You can specify the required criteria that meets your business requirement and generate the
report. You can also share the report with other users. You can only add those reports or favorites
as Dashboard widgets if you select them while saving a report.
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Procedure
1. In the Save Settings tab, in Report Name, enter the name by which you want to save the

report.

2. (Optional) In Description, enter a description of the report.

3. (Optional) To select a report as favorite, select the Favorite check box.

4. (Optional) To enable the report to be added to Dashboard, select the Add to Dashboard
check box.

Next steps
Share report.

Saving reports field descriptions
Name Description
Report Name The name of the report.
Description The description of the report.

Sharing a report
About this task
Use this procedure to share a saved report with other employees of the group.
You can share a report with user groups that you can access or with everyone available in the
system.

Procedure
1. From Share, select one of the following to share the report with other users.

• Me: To set the report as private and restrict other users to view the report.

• Selected Groups: To share the report with the groups that you have access to.
Employees belonging to the group can use the report.

• Everyone: To share the report with all available users.

2. To share the report with specific employees and groups, select Selected Groups.

The system displays the Group and Employee search and select options.

3. Select one or more groups from the Available Groups list.

a. To search a group, type the first few characters of the group name in Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

4. To remove groups from the Selected Groups list, select one or more groups and use the
Remove Selected and Remove All buttons.
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5. Select one or more employees from the Available Employees list.

a. To search an employee, type the first few characters of the employee name in
Search.

b. To move a single selection from the list, use the Move Selected button.

c. To move multiple selections from lists, use the Move All button.

6. To remove employees from the Selected Employees list; select one or more employees
and use the Remove Selected and Remove All buttons.

Next steps
Schedule a report.

Scheduling a report
About this task
Use this procedure to schedule a report to run on a one-time basis, hourly, daily, weekly, or
monthly. You can email reports in PDF, Excel and CSV format to users in your organization.

Before you begin
Define the report criteria and save the report before scheduling.

Procedure
1. In Scheduler, select the options to schedule the report.

2. Select Enable Schedule.

3. Under Scheduler, select or enter the options to schedule the report on one-time, hourly,
daily, weekly, or monthly basis.

4. Click Save and Close to save and close the report

5. Click Run to run the report.

Scheduling reports field descriptions
Scheduler

Name Description
Once The option to generate the report once. For Once, you can specify the

following parameters:

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.
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Name Description
Hour The option to generate the report on an hourly basis. For Hour

recurrence, you can specify the following parameters:

• Run the Schedule Every X Hours: Specify the hourly interval at which
the report must be generated periodically.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.

Daily The option to generate the report at specified intervals each day. For
Daily recurrence, you can specify the following parameters:

• Every _ day(s): Specify the interval at which the report must be
generated periodically.

• Every Week day: Specify to run the scheduled report on all week days
excluding weekend.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.

Weekly The option to generate the report on the specified day of the week.

• On Day: Specify the day of the week to run the scheduled report.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.

Monthly The option to generate the report on the specified day of the month.

• Months: Specify the month to run the scheduled report.

• Enter Day(s): Specify the day(s) of the week to run the scheduled
report.

• Time: Specify the time of day to run the report in hh:mm format.

• Begin Schedule On: Specify the date when the generation of the
scheduled report must begin.

• End Schedule On: Specify the date when the generation of the
scheduled report must end.
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Email Option

Name Description
Name The name of the employee scheduling the report.
To The recipients of the report.
Subject The subject of the scheduled email.
Messages The message of the scheduled email.
Report Name The name of the scheduled report.
Output Type The output format in which the report is delivered.

Saving a report as a favorite
About this task
You can save a report as a favorite for future reference.

Procedure
1. Click Reports > Reports.

2. On the Reports page, click Templates.

3. Click one of the available templates.

4. Select the required fields and click Save Settings.

5. Type the name and description of the report , and select the Is Favorite check box.

6. (Optional) Select the users with whom you want to share the saved report.

7. Click Save & Close.

The system displays the report in the Saved Reports section of the Reports page.

Saving a report to add to Dashboard
About this task
Use this procedure to save a new report or an existing report to add to Dashboard in the future.

Procedure
1. Click Reports > Reports.

2. On the Reports page, click Templates.

3. Click one of the available templates.

4. Select the required fields and click Save Settings.

5. Type the name of the report and the description, and select the Add to Dashboard check
box.
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6. Click Save & Close.

View report results

Viewing report results
About this task
Use this procedure to view the results of the published reports indicated by type, report name,
module, report generation details, and report status.
You can view a report with the Completed status in any chosen format. You can also view the
different versions of a published report.

Procedure
1. Click Reports > Results.

2. Go to the row of the required report and click the status link of the report.

The status options are:

• New
• Assigned
• In Progress
• Completed
• Failed

The Results page displays the report in one of the following formats depending on what
you selected at the time of publishing the report:

• HTML
• PDF
• Excel
• CSV

3. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

4. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

5. (Optional) To clear the filters from all the columns, click the  icon.
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6. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

7. (Optional) To reset the sorting, click the  icon.

Results field descriptions
Name Description
Report Name The name of the report.
Module The category of the report that is generated.
Last Run The date on which the report was last run.
xRun The number of times the report was generated.
Status The status of the report generation. The options are:

• New: A report generation request that is new.

• Assigned: A report request that is accepted, and awaiting to be
processed.

• In Progress: A report that is in progress.

• Completed: A report that is complete and published successfully.

• Failed: A report that has failed due to some reason.

Icon Name Description
Schedule The report that runs at a scheduled interval.

Public The report that is shared with all users in the selected group.

Downloading a report
About this task
Supervisors or managers can download published reports.

Procedure
1. Click Reports > Results.

2. From the list of published reports, click the Status link of the report that you want to view.

Avaya Workforce Optimization Select downloads the report in the specified format on the
Results page.

3. Click the  icon.
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Printing a report
About this task
Supervisors or managers can print published reports.

Procedure
1. Click Reports > Results.

2. From the list of published reports, click the Status link of the report that you want to view.

Avaya Workforce Optimization Select downloads the report in the specified format on the
Results page.

3. To print a report, click Print
4. To print reports that are in PDF output, click the  icon.

Editing a report
About this task
Users can edit saved reports by modifying the criteria, settings information, and scheduler details.

Procedure
1. Click Reports > Reports > Saved Reports.

The Saved Reports (x) page displays the list of saved reports, where (x) denotes the
number of saved reports.

2. Select the report that you want to modify and click the  icon.

3. Modify the appropriate fields in the following tabs:

• Filters : Lists the report trend options.

• Save Settings : Lists the report name, description, and report sharing options.

• Scheduler : Lists the frequency and email delivery options of a report.

4. In the Criteria or Save Settings tabs, click one of the following:

• Cancel : To discard the modification and close the report.

• Run : To generate the report.

• Save and Close.

5. In the Scheduler tab, click one of the following:

• Cancel : To discard the modification and close the report.

• Reset : To discard the scheduled details.
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• Schedule : To set the frequency and email delivery options of a report.

Managing adhoc reports

Adhoc Reports overview
Every adhoc report that is generated in the Avaya Workforce Optimization Select modules get
listed as canned reports in the Adhoc Reports tab in the Reports module. You can delete,
schedule, email, or run the reports depending on the permissions assigned to you. All the reports
already generated are saved in the Results tab of the Reports module.

The Adhoc Reports tab in the Reports module also lists scorecards and metric views from the
Analyze module. You can schedule, email, and run the scorecards and metric views. The
scorecards and the metric views already generated are saved in the Results tab of the Reports
module.

Running an adhoc report from the Adhoc Reports tab
About this task
Use this procedure to run an adhoc report, a scorecard, or a metric view from the Adhoc Reports
tab in the Reports module. You can also run a an adhoc report, a scorecard, or a metric view from
the Results tab in the Reports module

Before you begin
Save the report, scorecard, or metric view.

Procedure
1. Click Reports > Reports > Adhoc Reports (x), where x is the number of reports saved in

the Reports module.

2. Click the report, scorecard, or the metric view that you want to run, and click the Run
button.

The system displays the report, scorecard, or the metric view in the Results tab. The xRun
column displays the number of times a report is run.

3. (Optional) To view the number of times an adhoc report, scorecard, or metric view is run,
click on the xRun column of the respective report.

The system displays the reports and the respective dates on which the report was run.
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Running an adhoc report from the Results tab
About this task
Use this procedure to run an adhoc report, a scorecard, or a metric view from the Results tab in
the Reports module. You can also run an adhoc report, a scorecard, or a metric view from the
Adhoc Reports tab in the Reports module.

Before you begin
Save the report, scorecard, or metric view.

Procedure
1. Click Reports > Reports > Results.

2. Click the report, scorecard, or the metric view that you want to run, and click the Run
button.

The system displays the report, scorecard, or the metric view that was run last in the
Results tab. The xRun column displays the number of times a report is run.

3. (Optional) To view the number of times an adhoc report, scorecard, or metric view is run,
click on the xRun column of the respective report.

The system displays the reports and the respective dates on which the report was run.

Scheduling adhoc reports
About this task
Use this procedure to schedule an adhoc report, a scorecard, or a metric view to run on a one-
time basis, hourly, daily, weekly, or monthly basis. You can email reports in the PDF, Excel, and
CSV format to users in your organization.

Before you begin
Save the report, scorecard, or metric view before scheduling it.

Procedure
1. Click Reports > Results.

2. In the status column, click Completed for the scorecard, metric view, or the report that you
want to create a schedule for.

The system downloads the report, scorecard, or metric view output in the saved format.
You can make changes to the output based on your requirements.

3. Click Edit.
4. Click the Scheduler tab.

5. Select the Enable Schedule check box.
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The system enables the fields in the Scheduler section.

6. In the Scheduler section, do the following:

a. Select or enter the options to schedule the report on a one-time, hourly, daily, weekly,
or monthly basis.

b. Enter the time details, and select the time from when you want the schedule to begin
and end.

7. Click Save.

Emailing adhoc reports
Before you begin
Save the report, scorecard, or metric view before scheduling it.

Procedure
1. Click Reports > Results.

2. In the status column, click Completed for the scorecard, metric view, or the report that you
want to create a schedule for.

The system downloads the report, scorecard, or metric view output in the saved format.
You can make changes to the output based on your requirements.

3. Click Edit.
4. Click the Scheduler tab.

5. Select the Enable Email check box.

6. Enter the required details and click Save.
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Chapter 12: Managing notifications

Notifications overview
With the Notifications feature, you can receive real-time alerts and notices for predefined contact
center conditions, both mission-critical and informational. Based on the Avaya Workforce
Optimization Select modules purchased, you can subscribe to alerts to manage and control
contact center activities. You can also specify whether you want these alerts and notices to appear
in the notification inbox or sent yo you through email. The notifications inform you about issues or
situations that require immediate attention or notify you about general information on interactions.
The types of notifications are:

• Alerts: System-generated, real-time notifications that trigger when users cross the defined
threshold value. For example, you can configure alerts that inform you about the exceeded
number of holds, hold duration, and AHT by your team. The alerts that you can subscribe to
depend on the threshold values set by the administrator.

Note:

Avaya Workforce Optimization Select displays only the latest system-generated alert.
• Notifications: Custom messages that can be sent to users that you have access to.

Notifications provide more information including general information and feedback.
Supervisors can use notifications to:

• Assess and measure employee performance to improve customer satisfaction.
• Send custom notices to employees that supervisors have access to, apart from system-

generated alerts.
• Broadcast messages to users through email or have messages delivered to the notification

inbox. Supervisors can broadcast messages as an alert or a notice and also send a custom
message to members in the team.

• Send notifications during live monitoring of interactions to provide instant email feedback to
the employee.

Viewing notifications
About this task
Use this procedure to view notifications that you receive as alerts or notices in your notifications
inbox. When the user exceeds the threshold value of defined rule, the system triggers an alert
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through email or directly to the notifications inbox. Users can also receive notices about general
feedback or information during live interactions.

Procedure
1. On the Avaya Workforce Optimization Select Home page, click Notifications, or the 

icon.

2. On the View Notification page, click the appropriate option in the Show drop-down list to
display alerts, notices, or all messages.

3. Click the appropriate option in the Actions drop-down menu to specify an action for the
notifications you receive.

4. (Optional) On the pagination controls, choose the number of records that you want to view
on each page.

5. (Optional) To filter the columns, click the  icon in the column header of the column which
you want to filter.

You can apply filters on multiple columns.

6. (Optional) To clear the filters from all the columns, click the  icon.

7. (Optional) To sort the columns, click the Sort icon in the column by which you want to sort.

The upward arrow ( ) indicates sorting in the ascending order. The downward arrow
(  ) indicates sorting in the descending order. The third click removes the sorting.

8. (Optional) To reset the sorting, click the  icon.

Notifications field descriptions
General

Name Description
Type The type of notification. The options are:

• Alerts: System-generated messages for AHT, hold count, hold duration,
notifications from the Appeals, Coach, Learn, and Evaluate modules.
There is no subscription for supervisor or agent to receive these
notifications.

• Notifications: Custom messages that users can send to provide
feedback or any other general information that the receiver needs to
know.

Date The date and time of the notification.

You can sort the notifications by date or use the search criteria to filter
your search results.

Table continues…
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Name Description
Count The number of times that the notification alert is triggered.
Message The message of the notification.

Icon Name Description
Notifications The option to view the notifications.

Type The type of notification. The options are:

• Alerts: System-generated messages for AHT, hold count, hold duration,
notifications from the Appeals, Coach, Learn, and Evaluate modules.
There is no subscription for supervisor or agent to receive these
notifications.

• Notifications: Custom messages that users can send to provide
feedback or any other general information that the receiver needs to
know.

Actions

Name Description
Mark as Read To mark the selected notifications as read.
Mark as Unread To mark the selected notifications as unread.
Mark as Helpful To mark the selected notifications as helpful notifications.
Mark as Not-Helpful To mark the selected notifications as not helpful.
Delete To delete the selected notifications.

Show

Name Description
All To select all notifications.
Alerts To select only alerts.
Notices To select only notices.

Managing notifications
About this task
Use Manage Notifications to manage the type of notifications that you want to receive through
email or to your notifications inbox.

Procedure
1. Click Notifications > Manage Notifications.

Managing notifications
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2. In the Email column, click the appropriate option.

3. In the Inbox column, click the appropriate option.

4. Click Save.

Managing notifications
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Managing notifications field descriptions
Name Description
Message The message of the notification that is triggered when the threshold value

is exceeded.

Users can subscribe to the following alerts:

• My AHT exceeded by Queue

• Number of holds exceeded by me in Queue

• My hold duration exceeded in Queue

Supervisors can subscribe to the following alerts:

• AHT exceeded by my team in Queue

• Number of holds exceeded by my team in Queue

• Hold duration exceeded by my team in Queue

Users can subscribe to the following notifications:

• Number of coaching assignments assigned to me

• Number of courses assigned to me

• Number of Courses/Quizzes assigned to me

Evaluators, reviewers, or moderators can subscribe to the following
notifications:

• Number of evaluation tasks assigned to me

• Number of calibration tasks assigned to me

• Number of appeals to be processed

• Number of calibration tasks assigned by me

Supervisors can subscribe to the following notifications:

• Number of evaluation tasks completed by my team

• Number of interactions evaluated for my team

• Number of coaching assignments completed by my team

• Number of pending coaching assignments for my team

• Number of Courses/Quizzes assigned to my team

• Number of coaching assignments to be created for your team as
part of a coaching plan

• Number of coaching assignments completed by my team

Coach or the coaching assignment owner can subscribe for the following
notifications:

• Number of coaching assignments to be followed-up
Table continues…
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Name Description
• Number of coaching assignments to be delivered by me

• Number of coaching assignments to be created as part of a
coaching plan

• Number of Courses/Quizzes assigned by me
Email The option to select the notifications that you want to receive through

email.
Inbox The option to select the notifications that you want to receive directly to

your inbox.

Messages
Messages Description
Alerts from the Administration module
My AHT exceeded by Queue The alert is triggered when the user exceeds the

Average Handle Time (AHT) specifying by how
many minutes the user has exceeded the AHT
levels.

The recipient of this alert is any user who belongs to
the specified Queue.

Number of holds exceeded by me in Queue The alert is triggered when the user exceeds the
number of holds placed during the interaction.

The recipient of this alert is any user who belongs to
the specified Queue.

My hold duration exceeded in Queue The alert is triggered when the user exceeds the
hold duration during the interaction.

The recipient of this alert is any user who belongs to
the specified Queue.

AHT exceeded by my team in Queue The alert is triggered when the members in the
supervisor’s team exceed the AHT.

The recipient of this alert is the supervisor who
manages users who belong to the specified queue.

Number of holds exceeded by my team in
Queue

The alert is triggered when members in the
supervisor’s team exceed the number of holds
placed during the interaction.

The recipient of this alert is the supervisor who
manages users who belong to the specified queue.

Hold duration exceeded by my team in Queue The alert is triggered members in the supervisor’s
team exceed the hold duration during the
interaction.

The recipient of this alert is the supervisor who
manages users who belong to the specified queue.

Table continues…
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Messages Description
Notifications from the Evaluate module
Number of evaluation tasks assigned to me The notification is triggered when the evaluation

tasks are assigned to an evaluator, reviewer, or
moderator.

The recipients of this notification are evaluators,
reviewers, or moderators.

Number of calibration tasks assigned to me The notification is triggered when the calibration
tasks are assigned to an evaluator, reviewer, or
moderator.

The recipients of this notification are evaluators,
reviewers, or moderators.

Number of calibration tasks assigned by me The notification is triggered when the system
assigns an evaluation to a set of reviewers to
calibrate the effectiveness of the reviewers.

The recipient of this notification are evaluators and
reviewers.

Number of interactions evaluated for my team The notification is triggered when the interactions
are evaluated for the members in the supervisor’s
team.

The recipient for this notification are supervisors or
anyone who manages a team.

Number of evaluation tasks completed by my
team

The notification is triggered when a reviewer
completes an evaluation task.

The recipient for this notification are quality
managers.

Number of appeals to be processed The notification is triggered when the appeals to be
processed are assigned to the employee who has
the rights to act on an appeal. This notification is
sent 48 hours before due date, 24 hours before
due- date, and on the last due day.

The recipient for this notification are reviewers who
can review an appeal.

When an appeal is processed an update is also
sent to the individual who raised the appeal with the
status with the change in scores, if any.

Number of Courses assigned to me The notification is triggered when a course is
assigned to a user for performance improvement.
This course can be assigned through the library, or
the Evaluate, or the Coach module.

The recipient of this notification are users who
subscribe to receive it.

Table continues…

Managing notifications field descriptions

October 2019 Using Avaya Workforce Optimization Select 401
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using   Avaya Workforce Optimization Select 


Messages Description
Number of Course(s)/Quizz(es) assigned to me The notification is triggered when a course or a quiz

is assigned to a user. This course can be assigned
through the library, or the Evaluate, or the Coach
module.

The recipient of this notification are users who
subscribe to receive it.

Number of Quizz(es) assigned to me The notification is triggered when a quiz associated
to the course is assigned to a user. This course can
be assigned through the library, or the Evaluate, or
the Coach module.

The recipient of this notification are users who
subscribe to receive it.

Notifications from the Coach module
Number of coaching assignments to be
followed-up

The notification is triggered when the coach or the
employee who assigned a coaching assignment is
notified to follow-up an assignment. The
notifications are sent 48 hours and 24 hours before
the follow up date to the coach, reporting manager
and the employee(s).

The recipient for this notification are coaches or
users who has the right to assign coaching
assignments.

Number of coaching assignments to be
delivered by me

The notification is triggered when the coach
receives a notification for a coaching assignment
that must be completed by the employee. The
notification specifies the number of coaching
assignments that are pending for a logged user’s
team members.

The recipient for this notification are coaches.
Number of coaching assignments to be created
as part of a coaching plan

The notification is triggered when the reporting
manager or the creator of a coaching plan receives
a notification that the targeted number of
assignments are not assigned to the employee(s)
as per the plan.

The recipient for this notification are the reporting
manager or the creator of a coaching plan.

Number of coaching assignments to be created
for your team as part of a coaching plan

The notification is triggered when the reporting
manager or the creator of a coaching plan receives
a notification to create coaching plans for a
particular team.

The recipient for this notification are the reporting
manager or the creator of a coaching plan.

Table continues…
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Messages Description
Number of Course(s)/Quizz(es) assigned by me The notification is triggered when the reporting

manager receives notifications for courses or
quizzes assigned by him or her to his or her team
members.

The recipient for this notification are reporting
managers of the respective team.

Number of coaching assignments assigned to
me

The notification is triggered when the user receives
notifications for coaching assignments that are
assigned for a particular period.

The recipient for this notification are users who is
assigned a coaching assignment.

Number of Courses assigned to me The notification is triggered when the user receives
notification that a course is assigned by the
reporting manager or the coach. This course can be
assigned through the library, or the Evaluate, or the
Coach module.

The recipient of this notification are users who
subscribe to receive it.

Number of Course(s)/Quizz(es) assigned to me The notification is triggered when the user receives
a notification that a course or a quiz that is
associated to the course is assigned by the
reporting manager or the coach. This course can be
assigned through the library, or the Evaluate, or the
Coach module.

The recipient of this notification are users who
subscribe to receive it.

Number of Quizz(es) assigned to me The notification is triggered when the user receives
a notification that a quiz that is associated to the
course is assigned by the reporting manager or the
coach. This course can be assigned through the
library, or the Evaluate, or the Coach module.

The recipient of this notification are users who
subscribe to receive it.

Notifications from the Learn module
Number of Courses assigned to me The notification is triggered when the user receives

notification that a course is assigned by the
reporting manager or the coach. This course can be
assigned through the library, or the Evaluate, or the
Coach module.

The recipient of this notification are users who
subscribe to receive it.
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Messages Description
Number of Course(s)/Quizz(es) assigned to me The notification is triggered when the user receives

a notification that a course or a quiz that is
associated to the course is assigned by the
reporting manager or the coach. This course can be
assigned through the library, or the Evaluate, or the
Coach module.

The recipient of this notification are users who
subscribe to receive it.

Number of Quizz(es) assigned to me The notification is triggered when the user receives
a notification that a quiz that is associated to the
course is assigned by the reporting manager or the
coach. This course can be assigned through the
library, the Evaluate, or the Coach module.

The recipient of this notification are users who
subscribe to receive it.

Number of Course(s)/Quizz(es) assigned to my
team

The notification is triggered when the reporting
manager receives a notification for the courses or
quizzes assigned to the members of his/her
respective team.

The recipient of this notification are reporting
managers.

Number of coaching assignments completed by
my team

The notification is triggered when the reporting
manager receives a notification for the coaching
assignments that are completed by the members of
his/her respective team.

The recipient of this notification are reporting
managers.

Number of coaching assignments assigned for
my team

The notification is triggered when the reporting
manager receives a notification for the courses or
quizzes assigned to the members of his/her
respective team.

The recipient of this notification are reporting
managers.

Icon Name Description
Type

Alert System-generated messages for
AHT, hold count, hold duration,
notifications from the Appeals,
Coach, Learn, and Evaluate
modules. The alerts are not
based on subscription.
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Icon Name Description
Notification Custom messages that users can

send to provide feedback or any
other general information that the
receiver needs to know.

Message
Edit Message The option to add a message to

an existing notification.

The system displays the content
as an extension to the existing
message.
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Chapter 13: Customization

Updating profile settings
About this task
Use this procedure to view your profile information such as name, reporting hierarchy, hire date,
and other details. You can also change the time zone and language preferences on the profile
page.

Procedure
1. In the top-right corner of the Home page, click  > My Profile.

You profile page displays the basic profile information linked to your Avaya Workforce
Optimization Select account.

2. In Time Zone, click your preferred time zone preference, and click Set.
3. In Language, click your preferred language, and click Set.
4. In Landing Page, click your preferred landing page, and click Set.

Profile field descriptions
Name Description
Employee Code The code of the employee who is logged in.
First Name The name of the employee who is logged in.
User Name The user name of the employee who is logged in.
Hire Date The date when the employee joined the organization in the dd:mm:yy

format.
Department The name of the department that the employee belongs to.
Time Zone The default time zone setting.
Language The preferred default language setting.
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Name Description
Landing Page The preferred default landing page setting.

Note:

This is an permission driven option. The user can see this option
only if the administrator has given access to this option.

Reporting To The name of the manager to whom the employee reports.
Group Belongs to The group that the employee belongs to.
Groups Access to The groups that the employee has access to.
Organization Units The organization units that the employee has access to.

Modifying password
About this task
Use this procedure to modify your password and set additional security on your account with
secret question settings.

Procedure
1. In the top-right corner of the Home page, click  > Settings.

2. On the Settings page, do the following:

a. In the Password section, type the current and new passwords.

b. Reenter the new password to confirm and click Save.

c. In the Secret Questions section, click the question of your choice and click Save.

You can choose two secret questions. Ensure that the answers are private and easy
to remember.

Modifying password field descriptions
Password

Name Description
Current Password The current password used to log on to the application.
New Password The new password. The new password must adhere to the password

policy.
Confirm New Password The new password. Retype your new password to confirm.

Modifying password
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Security Questions

Name Description
Secret Question 1 The first secret question.
Answer The answer to the selected first secret question.

The answer is not case sensitive.
Secret Question 2 The second secret question.
Answer The answer to the selected second secret question.

The answer is not case sensitive.

Broadcasting messages
About this task
Use the Broadcast feature to send messages to multiple employees through email or as a
notification pop-up message. Supervisors or managers can send alerts to communicate critical
information or notices to provide value add information to employees.

Procedure
1. In the top-right corner of the Home page, click  > Broadcast.
2. On the Broadcast Message page, do the following:

a. Select the recipients of the message.

You can send the message to multiple recipients at the same time.

b. Select the option to send the message through email or to the notification inbox of
recipients.

c. In Message Type, select whether you want to send alert or notice.

d. Type the message that you want to broadcast.

3. Click Send.
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Broadcast Message field descriptions
Name Description
Broadcast To The recipients who receive the broadcast message.

You can send broadcast messages to multiple employees using the
following options:

• Site

• Organization Units

• Departments

• Groups

• Employees

For example, to select a specific employee in a Department, select the
Department from the drop-down list and the employee from the
Employees drop-down list.

Broadcast On The delivery mode of the broadcast message. The options are:

• Email: To send the message to users through an email.

• Notification Inbox: To send the message to users in their notification
inbox.

Note:

To broadcast messages through email:

• Ensure you configure the mail server.

• Ensure you use a valid email address of the recipients.
Message Type The type of the broadcast message. The options are:

• Alert: To alert users on critical information. For example, as a
supervisor you can send alert messages to the team about adhering to
rules such as greeting the customer or waiting for the customer to end
the interaction

• Notice: To communicate or convey general information. For example,
as a supervisor you can send a notice to the team about a new policy or
process in the department.

Message The content of the message you want to broadcast.
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Watching training videos
About this task
Use this procedure to watch training videos from Avaya Learning specific to your requirements.
The training videos for the supervisor and the agent are available to any user logged in to the
application. However, the training video for admin is available only to the administrator.

Important:

Use Google Chrome to play the training videos.

Procedure
1. In the top-right corner of the Home page, click the  icon.

2. Click one of the following:

• Training Videos - Admin: To watch the basics of administering Avaya Workforce
Optimization Select. This training is intended for business partners and customers with
an administrator role.

• Training Videos - Agent: To watch the basics of using Avaya Workforce Optimization
Select features with an agent role.

• Training Videos - Supervisor: To watch the basics of using Avaya Workforce
Optimization Select features with a supervisor role.

Customization
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Chapter 14: Troubleshooting

Reports generation fails
Condition
When a user tries to generate a report, the system displays the following message: Failed/
Schedule is not working. This message might get displayed frequently or when a particular
criteria is selected.

Cause
Your browser might still be using earlier files which can cause display or access problems.

Solution
Clear the browser cache and log in into the application again.

Call or mail interaction details do not download
Condition
When a user tries to download an interaction mail or interaction details, the system displays an
alert that prevents the action.

Cause
The interaction is tagged as Do not download or Do not email by another user.

Solution
1. Check to see if the interaction is tagged as do not download or do not email.
2. Send a request to the user who has tagged the interaction to remove the tag.

Records do not display in Interactions or View Evaluations
Condition
This issue occurs when a user who is logged in cannot view records in Interactions or View
Evaluations.
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Cause
The default view settings are not set properly.

Solution
1. Verify that the default view for Interactions displays Today’s Interactions.

2. Verify that the default view for View Evaluations displays Current Week Evaluations.

3. Check the filters and values used within the view that is selected by the logged in user by
creating a view with filters one by one and verify if the data imports correctly.
If the problem still persists, contact the system administrator.

Interaction playback fails
Condition
Interaction playback fails and the system displays the following error message: You cannot
play this interaction as the audio could not be loaded either because of
unsupported file formant or server/network failure.
Cause
The browser does not support HTML5.

Solution
1. Install one of the following supported browser versions:

• Internet Explorer 11 and later
• Google Chrome 43.x and later
• Mozilla Firefox 33.x and later

2. (Optional) If the problem persists, contact your system administrator.

Unable to evaluate imported WAV file interactions
Condition
When an evaluator tries to evaluate an interaction that is imported in WAV format on Internet
Explorer (IE), the application displays the following message: You cannot evaluate this
interaction because the audio could not be loaded. It could either be
because of unsupported file format or server/network failure.
Cause
IE does not support WAV file format.
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Solution
Use the following browsers to evaluate an interaction imported in WAV format:
• Google Chrome
• Mozilla Firefox
• Microsoft Edge

Permission denied to access training videos
Condition
When a user clicks the options to watch a training video in Avaya Workforce Optimization Select,
the application displays the error message: APIWrapper_scorm_12.js :: findAPI() ::
ERROR HANDLED Permission denied to access property "API" on cross-origin
object .

Cause
Unknown issue from the host provider.

Solution
1. In the top-right corner of the Home page, click the  icon.
2. Click one of the following:

• Training Videos - Admin: To watch the basics of administering Avaya Workforce
Optimization Select. This training is intended for business partners and customers with
an administrator role.

• Training Videos - Agent: To watch the basics of using Avaya Workforce Optimization
Select features with an agent role.

• Training Videos - Supervisor: To watch the basics of using Avaya Workforce
Optimization Select features with a supervisor role.

Avaya Workforce Optimization Select displays the following error message:
APIWrapper_scorm_12.js :: findAPI() :: ERROR HANDLED Permission
denied to access property "API" on cross-origin object

3. Ignore the error message and click OK and close the message window.

The selected training videos begin to play without any break.

Permission denied to access training videos
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Chapter 15: Resources

Documentation
See the following related documents at http://support.avaya.com:

Document
number

Title Use this document to: Audience

Table continues…
Overview

Avaya Workforce Optimization
Select Overview and
Specification

Provide a high-level
functional description of the
capabilities of the Avaya
Workforce Optimization
Select application.

All

Implementing
Deploying Avaya Workforce
Optimization Select with
Avaya Aura® Communication
Manager and Avaya Aura®

Call Center Elite

Provides checklist and
procedures for the
installation, configuration,
initial administration, and
basic maintenance of Avaya
Workforce Optimization
Select with Avaya Aura®

Communication Manager
and Avaya Aura® Call Center
Elite.

Deployment engineers and
support personnel

Deploying Avaya Workforce
Optimization Select with IP
Office and IP Office Contact
Center

Provides checklist and
procedures for the
installation, configuration,
initial administration, and
basic maintenance of Avaya
Workforce Optimization
Select with IP Office and IP
Office Contact Center.

Deployment engineers and
support personnel
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Document
number

Title Use this document to: Audience

Deploying Avaya Workforce
Optimization Select with IP
Office and Avaya Contact
Center Select

Provides checklist and
procedures for the
installation, configuration,
initial administration, and
basic maintenance of Avaya
Workforce Optimization
Select with IP Office and
Avaya Contact Center
Select.

Deployment engineers and
support personnel

Deploying Avaya Workforce
Optimization Select with
Avaya Aura® Communication
Manager and Avaya Oceana®

Solution

Provides checklist and
procedures for the
installation, configuration,
initial administration, and
basic maintenance of Avaya
Workforce Optimization
Select with Avaya Aura®

Communication Manager
and Avaya Oceana®

Solution.

Deployment engineers and
support personnel

Deploying Avaya Workforce
Optimization Select with
Avaya Communication Server
1000 and Avaya Aura®

Contact Center

Provides checklist and
procedures for the
installation, configuration,
initial administration, and
basic maintenance of Avaya
Workforce Optimization
Select with Avaya
Communication Server 1000
and Avaya Aura® Contact
Center.

Deployment engineers and
support personnel

Deploying Avaya Workforce
Optimization Select with
Avaya Aura® Communication
Manager and Avaya Aura®

Contact Center

Provides checklist and
procedures for the
installation, configuration,
initial administration, and
basic maintenance of Avaya
Workforce Optimization
Select with Avaya Aura®

Communication Manager
and Avaya Aura® Contact
Center.

Deployment engineers and
support personnel

Administering
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Document
number

Title Use this document to: Audience

Administering Avaya
Workforce Optimization Select

Explain how to use Avaya
Workforce Optimization
Select to configure your
system, employee data,
settings, and recording rules
and perform routine
maintenance tasks.

The content is available in
two formats: HTML and PDF.

Administrators

Administering SysAdmin Provides information on how
to perform administration
tasks in the SysAdmin
application including how to
manage tenants, assets,
component configuration,
and diagnostics.

System administrators

Avaya Workforce Optimization
Select Quick Reference Guide
for Administrators

Understand the most
common user tasks that an
Administrator performs.

Administrators

Using
Avaya Workforce Optimization
Select Quick Reference Guide
for Supervisors

Understand the most
common user tasks that a
Supervisor performs.

Users

Avaya Workforce Optimization
Select Quick Reference Guide
for Call Center Agents

Understand the most
common user tasks that an
Agent performs.

Users

Avaya Workforce Optimization
Select Quick Reference Guide
for QA Analyst

Understand the most
common user tasks that a
QA Analyst performs.

Users

Using Desktop Monitor Explain how to use Desktop
Monitor. Supervisors can
use this document to create
and assign projects to
employees in a contact
center environment.
Employees can use the
document to monitor the
projects assigned to each
employee.

Users

Resources
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Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of

the following:

- In Search, type Avaya Mentor Videos, click Clear All and select Video in the Content
Type.

- In Search, type the product name. On the Search Results page, click Clear All and select
Video in the Content Type.

The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do
one of the following:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click a topic name to see the list of videos available for the topic.
For example, Contact Centers.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.
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